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About lon Reporter” Software

™

Ion Reporter™ Software comprises a suite of bioinformatics tools that streamline and
simplify the data analysis, annotation, and reporting of Ion Torrent™ semiconductor
sequencing data. Designed for both exploratory and research production use in
performing sequencing assays, Ion Reporter™ Software helps you overcome the
bioinformatics barriers to interpret DNA variants faster and more consistently. For
researchers needing a simple, reproducible bioinformatics tool that helps ensure

™

consistency in their results, lon Reporter™ Software is an ideal solution.

Integrate your variants with comprehensive public and curated annotations, along
with your own lab-specific content. Ion Reporter™ Software is designed to reduce the
time-to-results. Configurable analysis modules and parameters allow customization
of workflows to fit your research needs.

All the steps, from data import to annotating variants, are automated in the Ion
Reporter™ Software workflow. Key features include the following;:

* Detection of SNPs, indels, and CNVs in one easy to use workflow

* Automated analysis workflows for 1, 2, or 3 samples

* Hosted and local deployment options to suit your laboratory's needs

¢ Simple interface that users can learn and use intuitively

* Role-based logins and the ability to fully audit user activity so that you can
determine what was done, when it was done and by whom

* Extensive annotations to guide understanding of your sample's variants

¢ Flexible batch export for integration into laboratory systems and APIs in support
of third-party tools for external analysis

lon Reporter  Software on Thermo Fisher Cloud

™

Ion Reporter™ Software on Thermo Fisher Cloud is available at https://
ionreporter.thermofisher.com.

Access to the Thermo Fisher Cloud version of the software is controlled by your
thermofisher.com user name and password. Samples, data, and results in the
software are controlled through "organizations". Members of an organization share

lon Reporter™ Software 5.6 Help 11
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About lon Reporter™ Software
lon Reporter™ Software on Thermo Fisher Cloud

data and results in the Cloud software in the same way that users of a particular Ion
Reporter™ Server organization share data and results.

To use the Cloud version of the software, you must first create a thermofisher.com
account with a user name and password, and then either create a new organization on
the Cloud or be invited to join an existing organization. Each Ion Reporter™ Software
user can only belong to one organization at a time. You can leave an organization at
any time to join or create a different organization, but you lose access to the data and
results of the organization you left.

Create a new lon You can create a new Ion Reporter ~ Software organization on Thermo Fisher Cloud.

Reporte r Creating a new organization adds you as the first adminstrator-level user of that

Software organization. You can then begin entering or importing data into the software and
. invite other Cloud users to your organization to share data and results. (To join an

organ Izatl_on on existing organization, see “Join an existing Ion ReporterTM Software organization on

Thermo Fisher Thermo Fisher Cloud” on page 13.)

Cloud

Note: You can only belong to one organization at a time. If you are already a member
of an Ton Reporter  Software organization on the Cloud, you will not be able to create
a new organization until you are removed as a user from your current organization.

1. If you have not already done so, create a new account on thermofisher.com. Your
user name and password are also used to sign in to Ion Reporter™ Software on
Thermo Fisher Cloud. Your user name is your email address.

2. Go to https://ionreporter.thermofisher.com/. Or, from the Thermo Fisher Cloud
dashboard, under All Apps, click on Ion Reporter.

3. On software sign-in screen, click Sign In. If you are not already signed in to
thermofisher.com, you will be prompted to enter your user name and password.

™

4. When you sign in to Ion Reporter™ Software for the first time, you will be
prompted to create a new organization. Click Yes and enter an organization
name.

Note: Enter a name that describes your organization to other users whom you
will invite to share data and results.

The User Manager screen for the Cloud opens, and you are listed as an
administrator-level user.

5. To return to the software, click on the Thermo Fisher Cloud Home (&) button,
then click Ion Reporter under My Apps.

6. Accept the license agreement to begin using the software.

Invite a user to an An administrator-level user of Ion Reporter Software can invite other users on
organization on Thermo Fisher Cloud to join their software organization.

Thermo Fisher 1. InIon Reporter™ Software on the Cloud, click the Admin tab. In the Users screen,
Cloud follow the link to User management.

2. Above the list of users, click Action » Invite User.

12 lon Reporter™ Software 5.6 Help
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lon Reporter™ Software on Thermo Fisher Cloud

Enter the email of the user you want to invite into the Invite User screen, then
enable one or more roles for the user:

¢ Import
* Analyze
e Report

e Admin

Click Invite.

The user receives an email inviting them to join the organization. See “Join an
existing Ion Reporter™ Software organization on Thermo Fisher Cloud” on
page 13.

You can join an existing Ion Reporter  Software organization on Thermo Fisher Cloud
by invitation from a software administrator in that organization (see “Invite a user to
an organization on Thermo Fisher Cloud” on page 12).

Joining an organization allows you to share data and results with other users in that
organization. (To create a new organization, see “Create a new Ion Reporter
Software organization on Thermo Fisher Cloud” on page 12.)

Note: You can only belong to one organization at a time. If you are already a member
of an Ton Reporter  Software organization on the Cloud, you will not be able to accept
an invitation from another organization until you are removed as a user from your
current organization.

1.

If you have not already done so, create a new account on thermofisher.com. Your
user name and password are also used to sign in to Ion Reporter™ Software on
Thermo Fisher Cloud. Your user name is your email address.

When an Ion Reporter™ Software administrator for the organization adds you as
a new user, an invitation is sent to your email address. Click on the link in the
email to accept.

Your browser opens to a page prompting you to accept the invitation for the
organization. Select the organization name to accept.

If you do not already have an account on thermofisher.com with the email
address that the invitation was sent to, you are prompted to create one.

Note: The email address of your account must match the address that the
invitation was sent to.

™

Accept the license agreement to begin using Ion Reporter™ Software.

13
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lon Reporter™ Server

Signintolon
Reporter™
Software on
Thermo Fisher
Cloud

Software

You must have an account on thermofisher.com to sign in to Ion Reporter ~ Software
on Thermo Fisher Cloud. Your user name and password for the website are also used
to log in to the software.

You must also be a member of an organization to use Ion Reporter ~ Software on the
Cloud. See “Create a new Ion Reporter” Software organization on Thermo Fisher
Cloud” on page 12 or “Join an existing Ion Reporter = Software organization on
Thermo Fisher Cloud” on page 13.

To log in to the software:

1. Go to https://ionreporter.thermofisher.com. You can also click on Ion Reporter
on the Thermo Fisher Cloud dashboard. Then click Sign In.

2. Enter your user name and password, then click Sign In.

lon Reporter Server

Signin to lon
Reporter™
Software on lon
Reporter™ Server

Create users on
lon Reporter
Server

14

Always access Ion Reporter™ Server through HTTPS (not HTTP).

The URL depends on your server configuration, and is named https://ion-
reporter-server-ip-address, where ion-reporter-server-ip-address is
the IP address or hostname of your Ion Reporter™ Server.

. . ™ ™
Before you can sign in to lon Reporter Software on Ion Reporter  Server, you must
have a user account on the server. An administrator-level user on the server can create
an account for you. To sign in to the software on the server:

1. In a browser on the same network as the Ion ReporterTM Server, enter the server
URL: https://ion-reporter-server-ip-address, where ion-reporter-
server-ip-address is the IP address or host name of the server.

2. Enter your user name and password, then click Sign In.

If you are an administrator-level user of Ion Reporter = Software, you can add new
user accounts on Ion Reporter ~ Server. You can add individual users manually or add
users with a batch upload through a spreadsheet that you create.

Note: Use a minimum of two letters for first and last names in user accounts.

¢ Create a single new user account.

™

a. Sign into Ion Reporter™ Software as an administrative user, then click the

Admin tab.
b. Click Create User » Manual.

c. Enter the user information, then assign one or more roles to the user account.
For details about the roles, see “User roles and permissions” on page 16.

d. (Optional) Select Requires private folder if you want to give the user the
authority to restrict all visibility to their data. For details, see “Enable or

disable private folders” on page 313.

e. Click Save.

lon Reporter™ Software 5.6 Help
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lon Reporter™ Server

The new user will receive an email with a link to activate the account and reset
the password.

¢ Create multiple new user accounts as a batch.

lon Reporter™ Software 5.6 Help

Admin tab.

Users page.

browser.

Note: You will upload this file to create new Ion Reporter

following columns of the spreadsheet:

a. Signin to Ion Reporter™ Software as an administrative user, then click the

. Click Create User » Batch, then click download examples on the Import

. Open the UserDefinitionTemplate.csv that is downloaded through the

™

Software users.

. Enter information for each new user that you want to create into the

Table 1
Column name Description
First Name First name of the account user
Last Name Last name of the account user
Emailld Email address of the account user. The
email address will be used as the user
ID when the user signs in. For
example, user(dinstitute.com.
Import Role Enter 1 to assign the Import role
Analyze Role Enter 1 to assign the Analyze role
Report Role Enter 1 to assign the Report role
Administrator Enter 1 to assign the Administrator
role

that you can get back to.

. Save the spreadsheet to a file directory on your hard drive or in a location

The new users will receive an email with a link to activate the user ID and reset
the password.

15



About lon Reporter™ Software
Jon Reporter™ Server

User roles and Ion Reporter™ Software grants access to specific functions based on roles that are
permissions assigned to users. The roles and functions are as follows:

Action Import User Analyze User Report User Admin User

Upload data Yes

Define samples |Yes Yes

Create / modify Yes
workflows

Launch analysis |Yes Yes

Review / filter Yes
results

Select / classify Yes
variants

Generate report Yes

Create / modify Yes
users

Update software Yes
(lon Reporter™
Server System
only)

16 lon Reporter™ Software 5.6 Help



About lon Reporter™ Software
lon Reporter™ Software navigation

lon Reporter  Software navigation

Use the quick links in the Ton Reporter  Software dashboard to open the page you
want.

Important notices are displayed in the right pane in the What's new in Ion Reporter™
5.6 section.

These links take you to the Samples, Workflows, and Analyses pages.
Click &) to return to the Thermo Fisher Cloud home screen.

lon Reporter™ Software 5.6 Help 17
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About lon Reporter™ Software
lon Reporter™ Software navigation

Each role within Ton Reporter  Software has access to different areas of the software.
The dashboard, links, and tabs for the various roles are shown here:

* Import Role:

- View samples

- Define a sample

- View analyses list (but not review results)
- Launch an analysis

- Access to the Samples and Analyses tabs

lon Reporter™ Software 5.6 Help
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Jon Reporter™ Software navigation

¢ Analyze Role:

- View samples

- Define a sample

- View workflows

- Create a workflow

- View analyses list (and review results)

- Launch an analysis

- Access to the Samples, Analyses, and Workflows tabs

* Report Role:

- View analyses list (and view and classify results)
- Access to the Analyses tab
- Generate reports

lon Reporter™ Software 5.6 Help
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About lon Reporter™ Software
lon Reporter™ Software navigation

e Admin Role:

- View samples

- View workflows

- View analyses list (but not view results)

- Access to the Samples, Analyses, Workflows, and Admin tabs

Documentation

See help pages for more information

lon Reporter™ Software 5.6 Help



About lon Reporter™ Software
Set IRGV or IGV as default viewer

Set IRGV or IGV as default viewer

You can set a preference for your account that determines whether Ion Reporter
Genomic Viewer (IRGV) or Integrative Genomics Viewer (IGV) opens by default
when you visualize analyses. Ion Reporter  Genomic Viewer is the faster loading
genomics viewer that is built into Ton Reporter Software. IGV is the Integrative
Genomics Viewer made by the Broad Institute.

You can also change these preferences for any Ion Reporter = Software screen that has
a table grid to list reports, results and so on. Account preferences must be changed for
each screen that contains a table grid. For details, see “Set default number of rows
shown in tables” on page 24.

1. Click Actions (£f)Account Preferences.

2. In the Account Preferences dialog, under IGV launch preference, select IGV or
IGV.
The choice determines which application opens when you click Locus for any of
the results in the Analysis Visualization screen:

e If you select IRGV, Ion Reporter™ Genomic Viewer launches in a separate
browser window when you click Locus in the Analysis Visualization
screen. Alternatlively, you can open Ion Reporter™ Genomic Viewer, Ion
Reporter™ Genomic Viewer in the same browser window, If you click the Ion
Reporter™ Genomic Viewertab to launch the application.

¢ If you select IGV, a JNLP file is downloaded when you click Locus in the
Analysis Visualization screen. Double-click on the file to enable IGV to be
launched as a standalone application on your computer.

3. (Optional) Set number of rows that you want to include in the list of results in the
screen.

The default setting is 20 rows for Ion Reporter™ Genomic Viewer and IGV.
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Table preferences
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You can configure and save the columns that are displayed in the tables under the
Samples and Analyses tabs in Ion Reporter Software.

Table 2 Table Preference options

Option

Description

Table Preferences

Save Table Preferences

Save Table Preferences As

Select Columns

Delete Table Preferences

Restore Defaults

Select from a list of saved table
preferences.

Save the selected column display under the
current selected table preference name.

Save the selected column display under a
new user-defined table preferences name.

Select from a list of available columns to
display, including any user-defined
attributes.

Delete the user-defined table preference
from the list of available columns to display.

Restore the default table display.
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Table preferences
Set table You can set Table Preferences in Ion Reporter Software to show or hide the columns
preferences in any table that lists samples or analyses, or summarizes other sample or analysis

information, such as Analysis Results. If you save a setting, it applies to all tables. If
you save a setting and name it, the preference is added a list of Table Preferences and
you can apply that setting at any time to any table. You can delete unused Table
Preferences.

In the Samples tab or Analyses tab, click Overview, then select a Analysis or an
Analysis.

e To save a Table Preference:

a. Click Preferences » Select Columns.

b. Select and deselect columns that in the Select Columns to add to Summary
dialog that you want to add or remove from the table. Click Apply.

¢ To create a custom table preference:

a. Click Preferences » Save Table Preference As.

b. Enter a name for the table preference and click Save.

c. Click another analysis.

d. Click Preferences » Table Preferences, then select the new Table Preference.
The analysis columns are modified as determined by the applied Table
Preference.

* To delete an unused Table Preference:

a. Click Preferences » Table Preferences, then select the Table Preference that
you want to delete.

The Table Preference is applied.
b. Click Preferences » Delete Table Preference.

c. When you are prompted to delete the Table Preference, ensure that the dialog
refers to the preference that you want to delete, then click Yes.

The Table Preference is removed from the table.
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Table preferences
Set default You can set a preference for your account to set the number of rows that are shown by
number of rows default when you open any list that appears in a table.
shown in tables Note: You can also set a preference to run Ion Reporter  Genomic Viewer or

Integrative Genomics Viewer (IGV) by default when you view analyses. For details,
see “Set IRGV or IGV as default viewer” on page 21.

1. Click Settings (£)Account Preferences in any of the following screens:

Tab Screen

Home Notifications

Samples Overview

Presets

Analyses Overview

Launch

My Variants

Workflows Overview

Presets

Admin Users

System Services

Software Versions

Plugins

a. In the Account Preferences dialog, select the number of rows that you want
to include in the list for the screen that is open.

The default settings are 20 rows for all screens.

b. Select the viewer that you will use to launch Ion Reporter™ Genomic Viewer
or IGV when you click Locus for any result in the Analysis Visualization
screen.

If you click Locus to launch a visualization application, IGV opens as a
standalone application or Ion Reporter™ Genomic Viewer launches in a
separate browser window, depending on the account preferences. If you
click the tab to launch one of the visualization applications, Ion Reporter™

Genomic Viewer opens in a new tab in the same browser window.

Note: If you use IGV , you might have to save a JNLP file that is
downloaded to your browser before you can open the application.

2. Click Save.
3. (Optional) Look for the message at the top of the screen to show that your

preferences were saved. You can then refresh the screen to show the updated
number of rows.
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View notifications

From the notifications screen, you can monitor all downloads and collaborations.

@_

@ Subtabs for the Notifications window
@ Notifications subtab
® Envelope icon

?

Subtabs for Notifications window Description
All Shows all downloads and collaboration
notifications.
Downloads Shows all available files for download.

Collaborations

Shows messages from research
collaborators and lists files that have been
shared.

To view the Notifications screen, select one of the following actions.

¢ In the Home tab, select the Notifications subtab.

e Inany tab, click J¥ in the Ion Reporter screen menu bar.

Status alert emails

Ion Reporter™ Software sends email status alerts for the following scenarios:

® account creation.

* password reset.

* account deletion.

¢ sharing of an analysis.

¢ unsharing of an analysis.

* storage warning.

lon Reporter™ Software 5.6 Help
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Status alert emails

* creation of a new organization.

* report generation request.

Example of a storage warning message

Example of a message that is generated when an analysis is complete and a report is generated
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GRCh38 human reference

GRCh38 human
reference can be
used in custom
analyses and
workflows

You can use the Ton GRCh38 human reference in custom workflows Ion Reporter
Software. The Ion GRCh38 Reference Genome is based on the latest GRC human
reference assembly and is the first major update since 2009. Highlights include:
changes to chromosome coordinates, fixed errors in the former sequence, addition of
Mitochondria, and multiple loci for some highly variable genes. In Ton Reporter -
Software, custom workflows can be created using this reference genome.

Note: When editing older version workflows that use the hg19 reference genome,
you cannot change the reference genome to Ion GRCh38.

AmpliSeq™ Designer currently offers one custom AmpliSeq™ panel and related target
and hotspot regions files for GRCh38 experiments. Optionally, you can also convert
existing coordinates to GRCh38 by using a publicly available lift-over tool, such as
CrossMap.

To use the GRCh38 human reference, you must create custom workflows. Use the
same approach as with hg19, but select GRCh38 on the Reference screen in the

workflow creation wizard. You will also need to upload the AmpliSeq™ GRCh38
Target Regions and Hotspot Regions files or create your own.

See the following topics for custom workflow creation:
e Download the Ion GRCh38 reference from Ion Updates in Torrent Suite™.
e “Create a custom workflow with the Ion Reporter™ wizard” on page 86
* “Create a Copy Number baseline” on page 120

* “Launch an analysis” on page 130
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Requirements for If you are creating your own BED file for a custom analysis on the GRCh38 reference,
GRCh38 custom here are some aspects to consider:

BED file Public standard:
¢ See the BED file specification as described by UCSC.

e Annotation files contain three types of lines: browser lines, track lines and data
lines.

¢ Empty lines and those starting with '#' are ignored.

* A track line begins with the word 'track’, followed by one or more key=value
pairs.

* There are currently 16 key=value pairs recognized by UCSC, but other key=value
pairs are allowed.

* The key db=<UCSC_assembly_name> specifies the reference, but must be a valid
UCSC assembly ID (e.g. hg19).

Example:

track name="CHP2_designed" description="Amplicon_Insert_CGP2" visibility=2
db=hg19

track name="CHP2_designed" description="Amplicon_Insert_ CGP2" visibility=2
db=hg38

Recommendation:
Include the key=value pair db=<UCSC_assembly_name> as shown in the example.

Define an additional key=value pair in the format reference=hg19 or
reference=GRCh38.p2 and include it on the track line.

For hg19, including the key=value pair reference=hg19 is optional.

If a URI is desired, define an additional key=value pair in the format
referenceURI=http://www.thermofisher.com/GRCh38.p2.fasta .

Troubleshoot sign ins and provide feedback for lon Reporter
Software

This section addresses questions that are related to how to troubleshoot sign-ins,
provide feedback and get support for the Ion Reporter™ Software.
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What can | do if | * If you are a server user and have been locked out of your account (system locks
am locked out of you out after five attempts to login in with the incorrect password), you will need
to contact your administrator to reset your password. For details on password

my account? . ; .
y reset, see the Administration Guide.

¢ If you are a cloud user, click the Forgot your password? link on the sign in form.

How can | provide Feedback on your experience or any recommendations is always welcomed.
feedback? Providing feedback in Ion Reporter = Software is very easy:

1. Navigate to the page you would like to provide feedback on. In the bottom-right
corner of the page you see a Send Feedback button.

2. Click on the Send Feedback button and then select whether you have general
feedback on the page or if your feedback is specific to a certain component.
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How do | contact
support if | have
additional
questions?

How can | conduct
searches?

30

If you select to provide feedback on a specific part of the page, you then are
prompted to select that part.

Then just enter your feedback and your email address.
After you enter your feedback and email, simply click the Send Feedback button.

There are three ways that you can get help with Ion Reporter  Software:

Send feedback by following the steps outlined above.
Send an email to ionreporter@lifetech.com

For ordering and commerce issues, please contact your local website support at
http://www.lifetechnologies.com/us/en/home/technical-resources/
order-support.html.

At least three characters are required for a search. The search field also appears in
red with a bold outline if fewer characters are entered.

Searches are not case-sensitive.

If you enter an invalid search character, the search field appears in red with a
bold outline.

Search field behavior is different for the variant table search on the Analysis
Results page, than for other searches.
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* For most searches (except on the variant table on the Analysis Results page):
— An asterisk (*) is not allowed in a search field.
— Searches match your search string in any location in the target list. For

example, a search on "demo" in workflow names matches workflows with
"demo" anywhere in their name (equivalent to *demo* with wildcard

searches).
Overview

@ Analyses
Filter Analyses v Search S Refresh

O v 4 anasis Stage & Created On Status

o Ezt:ge”“miﬂg Moek Gommunity_noPrimer DE1EB16 oo Dec 03 2013 0445 P Suscessul
O Dema Metagenamics Mack Communiy_1 388103785220 Variant Review Dec 032013 12:50 PM Suscessiul
o test_tec03 [DEmajumplisen Exome VO _c10_1 386109349453 Variant Review Dec 032013 01232 P Successiul
O Demo AmpliSeq COP ONY case_c748_1 386260657085 Variant Review Do 05 2013 0548 AW Suscessiul
O Demo AmpliSed IDP Father_c759_1386250657085 Wariant Review Dec 052013 05:49 AWM Successful
O Diema Matagenomiss Mok Communiy_s763_1 386260657085 ariant Review Dies 05 2013 0649 A Suscessiul
O Demo ansuploidy_763_[Dem] Variant Review Dec 05 2013 0548 AW Suscessiul
o Dema Amplien IDP Mother_c773 1 385760657055 Variant Review Dec 05 2013 0549 Al Successiul
O Demo AmpliSeq Exoma CNY cass_c783_1 386260857085 Variant Review Do 05 2013 05:48 AW Suscessiul

* Only for searches on the variant table on the Analysis Results page:

— An asterisk (*) is required for some searches here, but is not allowed for other
searches. The differences are due to how the different types of information
are stored.

— The asterisk is a search wildcard. Without the asterisk, searches only match
the exact string entered.

— On "exome" in workflow names matches workflows with "exome" anywhere
in their name (equivalent to *exome* with wildcard searches).

fralyses

Overview

@ Analyses
Filter Analyses - Search & Reitesh

O « & Anaysis Stage « Created On Status
O [Eemelistaaenomics Mock Community_noPrimer_DE1_cB3_138 Dot 03 2013 0815 P S
6116121272

O Demao Metagenomics Mock Community_1 3881037856220 Wariant Review Dec03 2013 12:50 Pht Successful

O test_dec03 [Demofmpliseq Exome VCF_c108_1395109949453  Variant Review Dec 03 2013 02:32 PM Successful

O Demo AmpliSer GCP CNY case_r749_1386250657085 wariant Review Dec 05 2013 05:49 AW Successful

O Demo AmpliSeq IDP Father_c758_1386260667085 Wariant Review Dec 05 2013 06:43 AW Successful

O Demo Metagenomics Mock Cormmunity_c763_ 1386250657085 Wariant Review Dec 052013 05:49 AWM Successful

O DemnAneup\mdy_c?BB Wariant Review Dec 05 2013 05:45 AM Successful

O Demo AmpliSeq IDP Mother_c773 1386250857085 Wariant Review Dec 05 2013 05:49 AM Successful

O Demo AmpliSeq Exome CHV case_c733_1388250657085 Wariant Review Dec 05 2013 05:45 AM Successful
Are there any * Most names (for instance, for analyses, samples, workflows, and users) require at
naming least three characters. The name field appears in red with a bold outline if fewer

restrictions? characters are entered.

e In this release, lon Reporter  Software does not support either a first name or last
name of only two characters. As a workaround, append an underscore (_) or
number to a name that is less than 3 characters.
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What special * Most names (for instance, for analyses, samples, workflows, and users) and other
characters are text fields in Ion Reporter ~ Software allow these characters:

allowed in names? — Alphanumeric characters: A-Z a-z 0-9
— Underscore: _
- Space: "'
- Dash: -
— Period: .

e If unsupported characters are entered, the field appears in red with a bold
outline.

Purchasing and ecommerce

M

You can use your Thermo Fisher account credentials to manage your Ion Reporter”
Software and related third-party applications.

Note: You do not have to change your lifetechnologies.com user name and password
to access . All your legacy account options remain intact.

Create a Thermo Each Ion Reporter  Software organization needs at least one user with a full Thermo
Fisher account Fisher account account. To sign up for an account:
account 1. Go to http://www.thermofisher.com.

2. Click Sign In » Register.
3. Fill out the requested information, then click Create account.

You will receive a confirmation email after you create the account.
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lon ReportermI To use Ion Reportern1 Sreftware on Thermo Fisher Cloud, subscriptions are not

Software storage required. Ion Reporter customers are given 100GB of storage free on Thermo Fisher
Cloud. To obtain larger amounts of space, see the Thermo Fisher Cloud Help for
subscription infomation.
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This section describes three primary methods to transfer data into Ion Reporter’
Software:

e The Ion Reporter™ Software Uploader plugin

e Import a VCF file into Ion Reporter™ Software

e The Ion Reporter™ Software Command-line Uploader
And tools to manage your samples:

* Define a sample manually

* Define a sample via CSV upload
¢ Edit a sample

* Lock a sample

* Delete a sample

¢ Create sample presets (attributes)

Import a VCF file into lon Reporter  Software

34

This section describes how to import a VCF file from a local Ion Reporter = Software
Server and define it as a sample so that its variants can be annotated with Ion
Reporter  Software using an annotation-only workflow. This section does not apply
to importing a VCF file as a hotspot file.

Note: A sample can only contain one VCF file, not multiple VCF files.

You can use the IonReporterUploader plugin or Ion Reporter  Command-line
Uploader to upload your VCEF files to lon Reporter  Software, and you can also
upload VCF files from your local machine. For details, see “IonReporterUploader
plugin” on page 41.

These instructions both import the raw VCF file from your local machine and also
define an Ton Reporter  Software sample from the VCF file.
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When you import a VCF file:

¢ Annotation-only workflows accept VCF files that conform to the 4.1 VCF
standard only.

e on Reporter " Software also accepts a compressed VCF file in .gz format as input
for annotation-only workflows. Ion Reporter’ Software unzips the .gz file and
works with the resulting VCF file.

e Ion Reporter  Software can analyze VCF data generated from any platform as
long as it conforms to the 4.1 VCF standard.

e Avoid the use of "CHR" instead of "CHROM" as a header column name. See IGV
parse header error.

Note: To use an imported VCF with the GRCh38 annotation workflow in Ion
Reporter  Software, the imported VCF file must include the following text in the
header line: ##reference=GRCh38

1. Login to the Ion Reporter™ Software application. In the Home page, click Define
sample.
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2. Click Upload VCEF.

3. In the Upload VCF Sample File dialog, click Select File.

Upload VCF Sample File

Select file

Supporied types: v, bef, vef gz, bef.gz

4. Browse to the VCF file on your local machine and click Open or Choose
(depending on your browser).
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5. Confirm that your file name appears in the Upload VCF Sample File screen
(merged.vcf in this example). If so, click Upload VCF.

6. Wait while your VCF file is verified.
When verification is complete, click the Close button.

Your file appears in the samples table.

lon Reporter™ Software 5.6 Help
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Your new file also appears in the left panel as a time-stamp under VCF_Uploads.

7. Inthe samples table, enable the checkbox to the left of your VCF file name. This
highlights the row and also enables the Add to Sample tab in the right panel.

8. Enter a descriptive (and unique) name for the sample in the Sample Name field,
then click Add Samples.
Your VCF file now appears in the Files Included list and the number of data files
is shown in the field with dotted lines. In this example, the sample number is 1.
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10.

11.

12.
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Click Add to Samples List.

A new box appears below the Add to Sample LisT. This box contains the data file
and sample name part of your sample definition.

Click Next.
The Attribute chevron opens.

If you do not need to set attributes, click Next.

To set an attribute, click the area under an attribute heading to set the attribute
value.
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Import a VCF file into lon Reporter™ Software

(In this example, Lab is a user-defined attribute. Click the expansion arrow to
open the attribute menu and make your selection.

When you have set the attributes, click Next.

13. In the summary chevron, hover over the sample name to see the raw data file. If
the sample name and the raw data file are correct, click Save.

The Samples Overview tab opens, with your new sample in the sample table.
Your new sample is ready to be analyzed.
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lonReporterUploader plugin

Transfer
limitations

Analysis files that are generated in the Torrent Suite™ Software can be directly
transferred to an organization in Ion Reporter™ Software with the
IonReporterUploader plugin.

™ ™

Ion Reporter™ Software uses the Torrent Suite™ Software output BAM file for analysis.
The Ion Reporter™ Software annotation-only workflow also accepts the VCF output
file of the variantCaller plugin. Use the IonReporterUploader plugin to transfer these

™

BAM and VCF output files to Ion Reporter™ Software.

There are two ways to run the IonReporterUploader plugin:

¢ Configure the IonReporterUploader plugin to run by default after every
sequencing run. Torrent Suite™ Software results files are transferred to Ion
Reporter™ Software and are defined as samples in Ion Reporter™ Software when

the plugin is run manually.

* Run the plugin manually. Results files are also defined as samples in Ion
Reporter™ Software when the IonReporterUploader plugin is run as part of a
Planned Run or Run template. In addition, the workflow of your choice Ion

Reporter™ Software is automatically launched on your newly transferred samples
Ion Reporter™ Software.

T™

The Ion Reporter™ Software is not included with Torrent Suite™ Software and is
available under separate license. Before you run the IonReporterUploader plugin, you
must add a valid Ion Reporter™ Software account. For complete details about the
IonReporterUploader plugin, see the Torrent Suite™ Software Help. If you do not have
access to Torrent Suite™ Software, you can use IonReporterUploader command-line
utility. For details, see“Ion Reporter™ Uploader command-line utility” on page 42.

™

Note: When the IonReporterUploader plugin defines samples in Torrent Suite
Software for your newly transferred files, the plugin also defines sample relationships
for paired and trio samples and defines sample attributes. For details, see

The IonReporterUploader plugin transfers results files for a completed run plan that
executed on the Torrent Server where the plugin is configured. The following
limitations apply to the IonReporterUploader plugin:

* You cannot add supplemental files to the results files of a run, to have the plugin
transfer those files.

e For barcoded runs:

— For sequencing runs that use barcoded data, the IonReporterUploader plugin
only transfers samples if the barcode kit selection is correct. If you correct or
add the barcode kit selection on the sequencing instrument, the
IonReporterUploader plugin still uses the original run plan information and
the results file transfer fails.

— For manual launches of the IonReporterUploader plugin on barcoded data,
the IonReporterUploader plugin uses the barcode kit that you select on the
sequencing instrument.
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lon Reporter™
Uploader
command-line
utility

42

You can use IRU command-line utility to transfer files from a local machine (that is
not an Ion Reporter™ Software server) to the Ion Reporter™ Software server. This
utility can be used if you do not have access to Torrent Suite™ Software, and you have
files on your local machine that you want to transfer. For example, if you have a BAM
or VCF file on your local machine that you want to upload and then analyze the file in

Ion Reporter™ Software.

You can also use IRU command-line utility if you have problems using the plugins in
Torrent Suite™ Software.

The IonReporterUploader command-line utility is a stand-alone utility that is not part

of either Ion Reporter™ Software or the Torrent Browser. This procedure is
recommended only for users who are familiar with the command-line utilities.
The Command-line Uploader can be run on any of these systems:

* Your Torrent Server

e A standard Linux™ machine

* A standard Windows™ (XP or later) machine

* A standard Macintosh™ machine
Note: IonReporterUploader command-line utility supports the upload of combined
Ion Reporter™ Software analysis results that are output by the Combine Alignments

option in the Torrent Suite™ Software Projects tab. The IonReporterUploader plugin
does not support uploading these files.

Download lon Reporter Uploader command-line utility

This procedure explains how to download and install the Ion Reporter Uploader
command-line utility from Ton Reporter  Software.

Ideally, download the Ion Reporter Uploader command-line utility onto the machine
where you run it. At a minimum, use a machine with the same operating system.

1. Sign in to Ion Reporter™ Software, then click Settings (&#) » Download Ion
Reporter Uploader.

2. Click the filename IonReporterUploader-cli.zip, then download the file to your
target machine.

3. On your target machine, extract the downloaded IonReporterUploader-cli.zip
file, then copy the IonReporterUploader-cli directory to a convenient location.

Run lon Reporter Uploader command-Lline utility

The Ion Reporter Uploader command-line utility (irucli) is ready to run after you
extract it. Run the Ion Reporter Uploader command-line utility from the
IonReporterUploader-cli bin directory (with the irucli.bat or irucli.sh script).
Instructions for using the command-line uploader are downloaded with the utility
and with Ion Reporter documentation.
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Manage samples

Samples are listed under the Samples tab in the Overview screen, in a table format.
The Overview screen has a number of tools for managing samples.

T

o o o I T

AR

(D Samples tab

(2) Overview screen

@ Search field, to search for specific samples in the table

@ Built-in Analyzed filter, to filter samples by whether they have been analyzed
(8 More Filters list, to select additional filters

@ Refresh button, to refresh the list of samples

(7 Preferences button, to configure the columns displayed in the table

Define Samples button, to add or import samples

@ Additional filter buttons, added using the More Filters list

Table columns, as defined by Preferences

Set table You can configure and save the columns displayed in the tables under the Samples
preferences and Analyses tabs.

Under the Samples or Analyses tab, in the Overview screen, click Preferences and
select from the following options:

Select... To...

Table Preferences Select from a list of saved table preferences.

Save Table Save the selected column display under the current selected table
Preference preference name.

Save Table Save the selected column display under a new user-defined table
Preference As... preferences name.

Select Columns... Select from a list of available columns to display, including any

user-defined attributes.

Restore Defaults Restore the default table display.
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Filter the sample Tools for filtering samples based on sample attributes are located under the Samples
table tab in the Overview screen.

* The Analyzed filter is available by default. Click Analyzed above the sample
table to filter the list by whether a sample has been analyzed (select Yes from the
dropdown list) or not (select No).

* Click More Filters to select additional filters from a dropdown list.

e Use the Find Filters field to search for filters in the list.

* Select the filter you want from the list. A button for that filter is added above
the table, and the filter is listed with a check mark in the More Filters list.

¢ To remove a filter button, click it again in the More Filters list to deselect it.
* Each filter button you add to the table has different options to filter by, based on

the attributes of the samples in the table. For example, the Library Kit Name filter
has a list of the library kit names that are associated with the samples in the list.
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* C(lick each filter button you add to display a dropdown list of options.
* Select an option in the list to filter by that selection. The table will reconfigure
to list only the samples that meet the filter criteria.
¢ Click a selected option again to deselect it and no longer filter by that option.
* Click Select All to select all the options for that filter.

e (lick Clear to clear the selections.

¢ (lick Clear All above the table to clear all selected filters.

Gender Some workflows require that a sample includes a sample attribute for gender
information information. The trio workflows require accurate sample gender information. You
requirements enter gender information when you define your sample manually, import samples, or

edit a sample.

Upload a .bam file You can upload a .bam file as a single sample.

as asample 1. In the Jon Reporter™ Software, click the Samples tab, then click Define

Samples » Manual.

2. In the Define Samples screen, click Upload BAM.

3. In the Upload file dialog, click Select File, browse and select the .bam file, then
click Upload BAM.
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You can define a new sample manually from raw data files for certain protocols. For
example, use the procedure if you want to analyze data from multiple combined runs.

Note: If you used the Ion Reporter  Uploader plugin or the Ion Reporter -
Command-line Uploader to upload data, the sample definition is done automatically
and you do not need to use this procedure.

Before you use this procedure, load raw data files into Ion Reporter Software or use
the demo data files available in Ion Reporter = Software .

IMPORTANT! Multiple BAM files can be combined into a sample. Multiple VCF files
are not supported and mixed file types are not supported.

Note: To import a VCEF file as a sample (not as a hotspot file) that contains a set of
variants from your local machine, see Import a VCF file into Ion Reporter  Software

1. Log in to the Ion Reporter™ Software, then do one of the following:

¢ C(lick the Home tab, and then select Define sample:

e Or, click the Samples tab, select Overview and then click Define Samples
» Manual .
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The name of your organization is shown on the left of the screen, and sample
files for your organization are listed in the table. In this example, "IR_Org" is the
organization name.

2. Click BAM or VCF above the list to filter for either .bam or .vcf files. VCF is
selected in this example.

lon Reporter™ Software 5.6 Help 47



48

Import and manage samples
Manage samples

3. To view the files in either your upload directory or the demodata directory,
expand the menu on the left that matches your organization name, then expand
the data file directory that contains data files of interest.

When a data file directory is selected, it is highlighted in blue and the contents of
the file list change to reflect the files from the directory that you select.

Note: Files transferred by IonReporterUploader appear under
data/IRU_Uploads, in time stamp folders. Demo data files appear under the
demodata folder.

4. Enable the checkbox for each data file that you want to add to your sample, and
then click Add to Sample. To select all samples in the list, click the checkbox in
the header.
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Note: The Add to Sample tab on the right is active after you enable at least one
data file in the table.

The Files included: area lists the files for this sample, and the count of data file is
displayed. A new sample box appears and Next is enabled.

5. Enter a descriptive name for your new sample in the field at the top of the
sample list. When the sample box contains the correct data files and the sample
name for your sample, click Add to Sample List.

6. (Optional) Do one of the following;:

* Add more data files to the newly defined sample; Enable the checkbox for
each data file that you want to add to your sample, and then click Add to
Sample.

* Repeat this procedure to define multiple new samples, each in a separate
sample box.
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7. Click Next.

¢ If you have any additional attribute information to associate with the sample,
click Add Attributes. A new column opens for your attribute.

¢ To set an attribute, click the area under an attribute heading to set the
attribute value. Gender is selected in this example.

Note: The range for the cellularity attribute is 0 to 100.

8. Review the sample files that are listed in the Review chevron.

¢ If the sample name and the raw data files are correct, click Save.

¢ To change the sample, click Previous.

9. In the Review chevron, hover over the sample name to see the raw data file (or
files).
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10. The Samples Overview tab opens, with your new sample in the sample table.

Your new sample is ready to be analyzed.

Notes about manual sample definition

Keep the following in mind when defining samples:

e The table lists either BAM or VCF files (not both at the same time). Click BAM or

VCEF to change the list. The file type that is not selected is filtered out and those
files do not appear in the table.
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* The data file browser on the left provides a cumulative list of all files at and
below the folder that is highlighted in blue. When you click a folder in the data
file browser, the list in the table changes to reflect the contents of the selected
folder. The selected folder name also appears at the top of the table listing.

¢ C(lick the checkbox in the header to select all samples in the selected directory.
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* Files that are transferred by IonReporterUploader appear under
data/IRU_Uploads, in folders that include time stamps.

* Demo data files appear under the demodata folder.

* Multiple BAM files can be combined into a sample. Multiple VCF files are not
supported and mixed file types are not supported.

¢ The range for the cellularity attribute is 0 to 100.

Define a sample Follow these steps to upload a CSV file and manually define a sample or samples:

via CSV upload 1. Log in to the Ion Reporter™ Software and click the Samples tab.

2. Click Define Samples » Batch
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3. Click Select File and browse to the CSV file you want to upload.

4. Confirm the displayed filename and click Upload.

Wait while your file is verified.
5. Click Next. In the sample list, verify that your sample information is correct.

6. (Optional) If you have any additional attribute information to associate with the
sample, click Add Attributes. A new column opens for your attribute.
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7. When your sample information is complete, click Next.

8. In the "Samples ready to import" screen, check your sample names and number
of samples. If the sample information is correct, click Save.

9. You are brought back to the sample list where you can see your new sample(s).
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Define samples as No-template control (NTC) samples can be defined in Torrent Suite " Software or Ion
no-template Reporter Software.

controls If samples are defined as NTCs in Torrent Suite " Software, the sample definition
attributes transfer to Ion Reporter = Software automatically.

Note: If you define NTCs with an incorrect sample type, Oncomine DNA and
Fusions analyses and Oncomine  DNA analyses do not complete successfully in Ion
Reporter  Software due to lack of sufficient reads.

To define a sample as an NTC in Ton Reporter = Software, perform the following steps.

1. Under the Samples tab, in the Overview screen, click the sample name that you
want to designate as an NTC.

2. In the Define Samples workflow bar, click Attributes. If the Sample Type
attribute is not displayed, click Add Attribute to add it.

3. Under the Sample Type column, click the button to select DNA NTC or RNA
NTC.

4. If you define the sample as DNA NTC, you must also add the Percentage
Cellularity attribute, then set the cellularity to 100%.

Note: Cellularity is not required for RNA samples.
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Edit a sample When you edit an existing Ion Reporter  Software sample, you can add raw data files
to the sample, remove raw data files from the sample, or edit the sample attributes.

Note: You cannot edit demo data samples that are provided with Ton Reporter
Software. These samples do not include the Edit option when you click £ Actions in
the sample Details.

Follow these steps to edit an existing Ion Reporter = Software sample:

1. Log in to the Ion Reporter™ Software application and click the Samples tab.

2. Select the sample that you want to edit from the table, and then click Edit in the
sample Details.

3. Add the raw data files from the table to your sample.
4. Click the Next to move to Attributes in the workflow bar. You can now edit the
attributes associated with your sample. For example, to change the gender

attribute of your sample, click on the gender value ("Unknown" in the example"),
then in the menu select the correct gender ("Female" in this example).

5. To add an additional attribute to your sample, click Add Attribute. (The attribute
must already be defined as a Sample Preset. For details, see Create sample
presets.

6. After you have made your changes, click Next.

7. In the Review chevron, click Save .
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Lock a sample IMPORTANT! After you lock a sample, you are no longer be able to edit the file or
attributes associated with it. To edit a sample that has been locked, you must first

define a new sample.

Follow these steps to lock a sample:

1. Log in to the Ion Reporter™ Software application and click the Samples tab.

2. Select the sample in the table, then click Actions £ » Lock from the in the
sample details section.

3. Click Yes to confirm that you want to lock the sample.

4. You are brought back to the samples page. Your sample is locked and is marked
with the locked icon g
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Add sample When you assign custom sample attributes in a Torrent Suite  Software run plan, you
p Yy & p plan, 'y
attributes to lon can access these attributes to access them in Ion Reporter = Software
™
Reporter Note: Do not create a custom sample attribute that has the same name as a factory-
P y
Software shipped sample attribute.

1. Click Samples » Overview and select the imported samples that have custom
attributes.

2. Click Actions £¥ » Select Columns.

3. Select the column types that you want to add your custom attributes to, such as
Biopsy Days or Couple ID.

The sample attributes are now added as columns in the Samples table.
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Delete a sample IMPORTANT! When you delete a sample, this action also erases the raw data

associated with the sample. If the raw data is being used with other samples, this
action only deletes the data uniquely assigned to the sample that you delete.

1. Log in to the Ion Reporter™ Software and click on the Samples tab.

2. With the left column checkboxes, select the sample (or samples), and then select
Delete in the £} Actions menu in the sample details section.

Edit -I:]-A::tiuna -

T

Edit
Lock
Audit Log

3. Review the Confirm Delete message, then click Yes to delete the sample.

Your sample is deleted and you are brought back to the Samples Overview page.
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Archive samples If you have a local Ion ReporterTM server, you can archive samples to your TS Storage
(local server only) device to free up disk space.

1. On the Samples page, select samples you wish to archive.

2. Click Actions » Archive.

The sample now has an archive (dicon in its row.

3. You can also select multiple samples and archive them.

4. Click Yes to confirm batch archive.

Archive icons now appear in the sample rows.
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5. To undo archival, select the archived samples and click Actions » Restore.
A restore icon appears in the sample rows.

Archival location must be specified

New users and users upgrading from a previous version must specify a storage
location for archiving samples and analyses in Ion Reporter™ Software 5.4. Change
archivalMountPath=/tmp/ to archivalMountPath=/storage IP address/ in the
ionreportermanager/server/server.properties file, then restart the Tomcat server.

To check the data that you archived, go to the storage location of the archived data,
which is set up in /share/apps/IR/ionreportermanager/server/server.properties file as
archivalMountPath.

You can create custom attributes, which are known as sample presets, to describe
samples that are used in your research.

Note: Do not create a custom sample attribute that has the same name as a factory-
shipped sample attribute.

Ton Reporter " Software supports the following types of attributes:
* Boolean -- Creates a list of these two choices: True, False
¢ Text -- Accepted values: general text
* Integer -- Accepted values: integer numbers (0, 9, -44, and so forth)
* Float -- Accepted values: decimal numbers (0.1, 9.0, -44.3, and so forth)
e Controlled Vocabulary -- Creates a list of these choices that you define with the
preset terms.

Note: Ton Reporter  Software gives you the option to encrypt the internal storage for
a sample attribute. In the preset form, click the Encrypted checkbox.

This example shows a text sample preset:

1. Log in to the Ion Reporter™ Software application. Click the Samples tab, then
select Presets.
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2. Click Create Presets, then select the type of preset you want to create.

Boolean

Integer !

Float
Contralled “aocabulary

3. Fill out the preset form with the attribute name and your description of the
meaning of the attribute. The name that you enter is used for the attribute during
sample definition.

4. (Optional) If you want the internal storage for the attribute to be encrypted, click
the Encrypted checkbox.

5. Click the Save button. Your new preset is now available in the Add Attribute
menu during sample definition:

6. To see how the attribute is entered during sample definition, click the image:
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Example boolean preset

This is a completed Boolean preset form:

It appears during sample definition.
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Example Controlled Vocabulary preset

With a Controlled Vocabulary preset, you create a pull-down menu for an attribute.

This type of preset gives you control over your sample metadata by preventing
misspellings or alternate wordings for common entries.

Click these images to see a Controlled Vocabulary example:
* A completed Controlled Vocabulary preset form:

* How the attribute appears during sample definition:
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* How the attribute appears in the Samples Presets tab (with the menu options
shown in the details Values area):

Create a Controlled Vocabulary preset

1. Log in to the Ion Reporter™ Software application. Click on the Samples tab and
then on the Presets sub-tab.

2. Click the Create Presets button and select Controlled Vocabulary.

Boolean
Text
Integer

Float

Contralled %ocabulary

3. In the Controled Vocabulary Preset form, enter the name and description of the
new sample attribute. In the Terms field, enter the first entry for the attribute's
pull-down menu.
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4. Click the Add button for an additional Terms field. In the new field, enter the
second entry for the attribute's pull-down menu.

5. Again click the Add button for an additional Terms field. In the new field, enter
the third entry for the attribute's pull-down menu.

6. Click the Save button.

7. Your new preset is appears in the Sample Presets table. In the Details area, the
Values section lists the menu selections available to the user.

8. During sample definition, to define this attribute, the user selects an entry from
the pull-down menu.
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You can copy VCF analysis results from successful analyses to Thermo Fisher Cloud
for storage and to share analyses with other users.

Note: If the analysis has an associated filter chain, the exported VCF file in the
Thermo Fisher Cloud is the filtered set.

1. Go to the Analyses tab, then select a successful analysis by clicking the checkbox.

2. In the Details pane, click Actions » Copy to DataConnect.

3. In the Export to Data Manager, click Confirm.
A message confirming that the files have been copied to the cloud appears.

4. To view the files, go to Thermo Fisher Cloud. The samples are named the same as
the analysis name that was copied.

Note: Analyses that are run on Ion Proton™ instrument automatically receive
1 TB of storage space. When copied to Thermo Fisher Cloud, VCF files from

analyses that are run on Ion Proton™ instruments automatically receive a one-
time increment of 1 TB of storage space.
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Import samples from Torrent Server running Assay Development
Software

Ton Reporter  local servers can now import samples from an Ion PGM Torrent
Server running Assay Development Software 5.0, or later.

1. Inthe Samples » Overview page, click Define Samples.

2. Select Import from PGM™ Dx TS™ Sw.

3. On the Servers screen, click Add Server.

4. Enter name, IP address, username and password. Click Save, then click Next.

lon Reporter™ Software 5.6 Help

69



70

Import and manage samples
Import samples from Torrent Server running Assay Development Software

5. Select the samples you want to import and click Next.

6. In the Review screen, click Import.

The samples now appear in the Samples list on the Ion Reporter™ local server.
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Transfer sample to users in another organization

You can now transfer samples to other users in different organizations. All custom
sample attributes are also transferred with the sample. This feature particularly
benefits core labs when they complete analysis work for clients.

1. Inthe Sample » Overview page, highlight the sample you want to transfer and
click the Actions drop-down menu and select Transfer.

2. In the Transfer Sample dialog, enter the address of the intended recipient(s) and
click Transfer.

A status appears that your sample transfer has been initiated.
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Batch transfer samples to user in another organization

You can also transfer multiple samples to user in another organization.

1. In the Samples » Overview page, select multiple samples and then click
Actions » Transfer.

2. In the Batch Transfer dialog, enter the email address of the intended recipient
and click Transfer.

A status appears stating your samples transfer has been initiated.

Accept (or reject) a sample from a user from another Org

You can now accept samples transferred from a user in another organization.

1. Inthe Home » Notifications page, locate the new sample and click the click the
download icon to initiate the transfer.

2. Go to the Samples tab to locate the transferred sample.

3. To reject the sample, go to Actions » Delete.
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Delete transferred sample after transfer

After you have transferred a sample to a user in a different organization and the
recipient has accepted the sample, you can delete it to free up storage space.

1. From the Home » Notifications page, view transferred samples in the
Transferred column.

2. Delete any transferred samples you no longer need.
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Each workflow is a set of instructions that tell the Ion Reporter™ Software what data
to expect, what to do with the data, and what to provide as output.

You can use predefined workflows that are ready to use or can create custom
workflows. All of your workflows can be found under the Workflows tab.

View workflow details in lon Reporter  Software

When you select a single workflow that is in the Workflows tab in Ton Reporter
Software.

1. Sign into the Ion Reporter™ Software and click the Workflows tab.
2. In the Workflows list, select a workflow.

Details about the workflow open in the Details section.

Note: If you select more than one workflow in the list, workflow details are not
available.

Pre-installed workflows in the lon Reporter” Software

Tumor-Normal
pair workflows

74

These workflows provide more than a calculation of the intersection of variants in the
two samples.

These workflows do analysis reads of a tumor sample and reads of the related normal
sample. However, these workflows are optimized to find somatic variants, which
appear in the tumor sample and do not appear in the normal sample. These workflows
perform a statistical evaluation of the likelihood that the tumor allele is not present in
the normal sample and calculates a P-value representing the statistical confidence of
that call.
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At each position with a variant in the tumor sample, the evidence for that allele in the
normal sample is examined. If the tumor allele is seen in the reads of the normal
sample above the error rate, we cannot say that this is a tumor-specific (somatic)
variant and the variant is rejected (not called).

Tumor variants in which the same position in the normal sample has no coverage or
low coverage are designated as non-confident. Non-confident variants are not
assigned a P-value, and are instead flagged with NC-LC (non-confident because of
low-coverage) in the adjacent field in the output VCF file.

Some non-confident variants receive the NC-LF (non-confident because of low-
frequency) flag instead of a P-value. Note that these variants are not assigned a P-
value. This happens to variants for which both of these conditions are true:

¢ The variant's allele frequencies are less than 10% in both the tumor and normal
sample.

* The variant has a non-zero allele frequency in the normal sample.

A Non-Confident variant call means that we are not confident that the variant appears
only in the tumor sample, i.e. the variant is also in the normal sample. This could be a
germline variant or a systematic error present in both samples.

In the VCF file, "./." means no-call in the normal and "0/0" means homozygous
reference call.

The TumorNormal workflow template is designed to be run on a pair of research
samples from the same individual. Ideally both research samples are sequenced on
the same chip. (With large panels such as the Ion AmpliSeq™ Comprehensive Cancer
Panel, this might require an Ion Proton™ instrument.)

Note: When creating a custom workflow for AmpliSeq Exome tumor-normal pair
analysis, in order to have the correct parameters that are applied, it is advised to
either:

1. Make a copy of the factory AmpliSeq Exome tumor-normal pair workflows and
edit any desired parameters.

2. Use the factory-shipped BED file to create a new custom workflow.

Using the Import from AmpliSeq feature or manually uploading the AmpliSeq
Exome panel BED file is not recommended.

FAO calculation

Key for formula below

AF: Allele frequency

AQ: Alternate allele depth at position

RO: Reference allele depth at position

DP: Total depth at position

FAO: Flow space alternate allele depth at position

FRO: Flow space reference allele depth at position
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lon AmpliSeq”
RNA Lung Fusion
workflow
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FDP: Flow total depth at position

1. FAO is usually equal to AO; however, due to complex alleles and/or
downsampling*, FAO may differ from AO.

2. AF=FAO/(FAO+FRO) and not FAO/FDP. This is because FDP may include reads
that don't fit the flow space profile of any hypothesis; in such cases, FDP>=FAO
+FRO and this is not used in allele frequency calculation.

Exception: When flow correction is not performed and there are no F tags in the VCF
file, then DP=AO+RO and AF=AO/DP.

*FAO along with all the F tags are subject to downsampling but
AO/DP/RO/SAF/SAR/SRF/SRR are not. So when total coverage is higher than the
downsampling cutoff, FAO tends to be smaller than AO.

The Ion AmpliSeq™ RNA Lung Fusion workflow detects gene fusions that are
targeted by the Ion AmpliSeq™ RNA Fusion Lung Cancer Research Panel.

Reference file

The reference file for this workflow is constructed of all the fusion isoforms in the Ion
AmpliSeq " RNA Fusion Lung Cancer Research Panel. The workflow uses a related
BED file that describes the breakpoints between the two genes that are associated with
each fusion. (Both the reference file and the BED file are included in Ton Reporter
Software.)

(We loosely refer to this as a reference file. More properly, it is a panel-specific gene
fusion mapping file.)

Sensitivity settings

The deployed workflow uses the MEDIUM optimized parameters settings, which we
recommend for most use. If you want to use higher or lower sensitivity settings in

your analyses, create a custom workflow. In the Parameters chevron, click the Fusions
link in the left panel and select either LOW or HIGH sensitivity.

Setting LOW MEDIUM HIGH
Min Overlap Percent |80 70 60
Fusions

Min Overlap Percent |70 50 50
Non-Fusions

Min Exact Match 75 66.7 50
Percent

Min Count For 30 20 10
Fusions Call

Min Count For Novel |125 100 100
Fusions Call

Min Count For 20 15 10
Expression Control

Genes

Note: You cannot change an individual parameter setting. You can select either the
LOW, MEDIUM, or HIGH group of settings.
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CNV and The Aneuploidy workflow supports chromosome and sub-chromosome-level
aneuploidy aneuploidy detection down to multi-megabase resolution. The CNV detection that is
research used in the single-sample and two-sample Ion AmpliSeq™ workflows calls copy

number results down to the gene and sub-gene-level ploidy variants.

In the Aneuploidy workflow and the single- and two-sample Ion AmpliSeq™
workflows, which contain a CNV detection module, read coverage is corrected for GC
bias. Corrected coverage is compared to a baseline coverage from control samples of
regions with known correct ploidy (ploidy of 2). A statistical model of the likelihood
that a genomic region belongs to an alternate ploidy state is developed.

™

Note: The aneuploidy baseline that is used in Ion Reporter™ Software 5.0 or later is
different from the Ion Reporter™ Software 4.4 aneuploidy baseline because new
exclusion regions are used. Do not use an Ion Reporter™ Software 5.0 or later
aneuploidy baseline with a version 4.4 workflow. Conversely, if you created an
aneuploidy baseline in Ion Reporter™ Software 4.4 and want to continue using the
baseline, then use it only with Ion Reporter™ Software 4.4 workflows.

The Aneuploidy workflow

The following apply to the Aneuploidy workflow (and to workflows that you create
from the Aneuploidy workflow template):

¢ The input data is only a test research sample. A control research sample is not
necessary, since a pre-computed Informatics Baseline Control is used as a copy
number reference.

e The input sample is from a whole genome amplified library.
* The volume of the sample can be small.
¢ The average coverage can be small, in the order of 0.01x.

* This workflow identifies regions of the genome that are duplicated or deleted.
The variant length detectable is typically from ~10 Mb up to a whole
chromosome.

¢ This workflow overcomes the variations in coverage that are typical with
amplified data.

e With this workflow, the coverage is typically too low to call SNPs or indels.

Mosaicism

Mosaicism detection is enabled by allowing decimal-level Copy Number Gain or Loss
calls. This workflow setting allows non-integer ploidy calls. For each tile, the
algorithm fits the data to all ploidy with a step of 0.05. This parameter can be turned
on or off in aneuploidy workflows that are copied, edited or newly created.
Mosaicism is turned on by default in the workflow "ReproSeq Mosaic PGS w1.1", and
turned off in other Ion factory-shipped aneuploidy workflows.

Smoothing

Improved visualization of aneuploidy detection is enabled by the default smoothing
of the discrete data points in all Ion Reporter™ Software 5.4 aneuploidy workflows.
The smoothing shown in the display is based on overlapping neighbor-averaging
which smooths the coverage values of the tiles. The copy number calls made by the
detection algorithm are not changed if the smoothing parameter is turned on or off.
You can control whether or not to smooth the data with an aneuploidy workflow-

specific Smoothing parameter.

lon Reporter™ Software 5.6 Help 77



Workflows in lon Reporter™Software
Pre-installed workflows in the lon Reporter™ Software

No Gender

You can disable the recording of the called gender of samples with the Hide Gender
setting that is available for samples analyzed in aneuploidy workflows. In aneuploidy
workflows with Hide Gender set to true, sex chromosome data is not shown in the
graphical plots or recorded in results files, and the sex chromosomes are given a call
of either "SxChrNrml"(if the sample is "normal" XX or XY) or "SxChrAbrml"(if the
sample has any ploidy differences from XX or XY). "No Gender" results are turned on
by default in the workflow "ReproSeq No Gender PGS w1.1", and turned off in other
Ion factory-shipped aneuploidy workflows.

See “Gender calling in the aneuploidy workflow” on page 78 and “Copy and edit a
workflow” on page 79 for further details.

Gender calling in the aneuploidy workflow

When you want to combine Mosaicism, Smoothing, and NoGender settings in a
custom workflow, you can combine the Advanced CNV-finding Aneuploidy
parameters in an Aneuploidy workflow that is copied or edited. Because NoGender
workflows are not able to be edited to be gender-calling workflows, and vice versa, it
is important that you copy the correct type of workflow that you want to customize:
either NoGender, or one of the gender-calling workflows. The correct workflow type
must be selected if you are to access the desired combination of settings.

Aneuploidy samples with very low total read counts may have analysis results where
the gender could not be called. While such samples may have other issues to
investigate, samples with low read numbers that are not getting gender calls can be
run through a custom Aneuploidy workflow with a lowered value for the parameter
CNV Gender Min Autosomes Count. The default value is 25000. You can change
ths setting under on the Advanced tab of the CNV Finding settings, Gender calling
section. See “Copy and edit a workflow” on page 79 for an example of how to

change this setting.

Copy Number detection in the lon AmpliSeq™ single- and two-sample
workflows

The following apply to copy number detection in the single- and two-sample Ion
AmpliSeq™ workflows (and in workflows that you create from single- and two-
sample Ion AmpliSeq™ workflow templates):

¢ For input data, both a test sample and a control sample are required for the two-
sample workflows. Single-sample workflow CNV detection uses a pre-computed
Informatics Baseline Control.

¢ These workflows detect regions of the genome that are different in the test
sample that is compared to the control sample (or from the Informatics Baseline
Control).

* Sensitivity is determined by the number of amplicons that cover the variant
region. Approximately 200 amplicons is the smallest panel size tested that has
shown robust copy number detection.

* Both research samples in the two-sample workflows can, but are not required, to
be sequenced on the same chip. (With large panels such as the Ion AmpliSeq™
Comprehensive Cancer Panel, this might require a Ion Proton™ instrument.)
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Visualization of CNV coverage data in the IGV genomic browser

You can visualize multiple files that are generated by the CNV detection module in
the IGV browser. These files can also be downloaded from the IGV browser using the
"Save As" menu option.

Three browser tracks are of particular interest for looking at and downloading tile
coverage values:

* The "DNA Coverage" track shows the average per-base coverage that is
normalized by the median of all tiles (the mode).

e The "DNA Coverage Ratio" track expresses the difference in test and control
coverages in a ploidy-centric Y-axis space using the following formula: difference
= (test coverage that is divided by the control coverage) x (expected normal
ploidy). This tile data is shown in the context of a golden called ploidy line in the
Browser. Mosaic Copy number gains can be viewed in this track as contiguous
data points consistently slightly above or slightly below, respectively "the gold
expected normal ploidy line".

¢ There is no control coverage track in single sample workflows such as the
Aneuploidy workflow and other CNV-detecting single sample workflows, since
there is no control sample. The control for single sample CNV-detecting
workflows is the informatics baseline that was selected. However, the "Control
Coverage" track is present in a Paired sample workflow. This track shows the
average per-base coverage that is normalized by the median of all tiles (the
mode).

Note: For larger files like AmpliSeq Exome, coverage file loading is disabled.

Copy and edit a workflow

You can create a new workflow from an existing Ion Reporter  aneuploidy workflow
by copying and editing it. For example, after copying the ReproSeq No Gender PGS
w1.1 workflow, you can enable mosaicism detection (which reports a CNV event as a
decimal ploidy value instead of an integer value), change the CNV sensitivity, or
disable smoothing, by modifying appropriate workflow settings in the Parameters
tab, and saving the changes. The following steps describe how to copy and edit an
existing workflow to create a new Ion Reporter  workflow.

1. On the Ion Reporter™ home page, click View workflows, select Reproductive
from the Research Category dropdown list, then select Aneuploidy from the
Research Application list. Select the workflow of interest, then click Copy from
the Actions dropdown list.
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2. Click Next -> on each page, making any necessary changes, to proceed to
Parameters.

3. Click Cnv Finding, then change the CNV Sensitivity setting.

Note: Low sensitivity results in fewer false positives, but more false negative
calls. High sensitivity results in fewer false negatives, but more false positive
calls. High sensitivity is required to make segmental aneuploidy calls of

~20 Mbp. Custom sensitivity allows you to make changes to the CNV
Transitional Probability that more precisely call the true start and stop of
subchromosomal segments.
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4, Click the Advanced tab to access more analysis parameter settings.

lon Reporter™ Software 5.6 Help

* You can change the CNV Transitional Probability setting if the Custom
sensitivity option is selected.

(applies to all CNV finding algorithm types except VCIB CNV algorithm)
CNV Transitional Probability

Transitional Probability dictates the likelihood that the algorithm will call 2 different ploidy state between two adjacent data points. Lower {more
negative) values will make it less likely that the algorithm will call adjacent data points as ploidy states that are different from each other. The
Transition Penalty parameter edited hare will only take effect when using the CUSTOM CNV Sensitivity setting. When CNV MOSAICISM
parameter is not enabled, the maximum value supported for Transitional Probability is -1.05. When CNV MOSAICISM parameter is enabled,
the maximum value supported for Transitional Probability is -2.31.

-1000000 <= -8 <=-1.05
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5. Scroll down to the Analysis (applies only to Aneuploidy workflows) section,
and make desired changes. In this example, select True under Enable Mosacism

Detection to make this change.

Analysis (applies only to Aneuploidy workflows)
Remove Duplicates
Removes duplicate reads
@ True © False
Enable Mosaicism Detection

Enable Mosaicism Detection

@ True | False

Enable Smoothing
Enable Smoothing

@ True © False
Hide called gender

Hide gender called by CMV gender calling

@ True @ False

¢ To enable mosaicism detection and/or smoothing to a No Gender workflow,
copy and edit the Reproseq No Gender w1.1 workflow as described. You
cannot enable gender hiding in the other ReproSeq workflows because the
Hide called gender setting is locked as False (gender is called), and cannot be

set to True.

¢ To always show Y chromosome data for every sample, whether it is female,
male or unknown, set Plot Y chromosome for Female or Unknown Gender

to True.
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The default value for this setting is False, which will show Y chromosome
data only if the sample is male.

Analysis
Plot ¥ chromosome for Female or Unknown Gender?

Flating ¥ chromosome for Female or Unknown Gender.

= True False

6. There are additional workflow parameters if you click the Annotation, Bamstats,
and Read Mapping links at the left of the page. When you have completed your
edits, click Next -> at the bottom of the page to proceed to Confirm.

Note: Do not change parameters from the default settings unless you
understand how the change can affect your analysis.

7. Rename the workflow, then click Save Workflow.

The workflow appears in the list of available Ion Reporter™ workflows.

A Copy Number Variation baseline, called the Variability Correction Informatics

™

Baseline (VCIB), is available for some Oncomine™ Assays.

When creating a new or augmenting an existing workflow that includes CNV
detection, you have three choices:

* Create anew VCIB CNV baseline.
* Use an existing VCIB CNV baseline as is.
¢ Augment an existing VCIB CNV baseline.

VCIB background
Copy number estimates are made using a proprietary algorithm.

The VCIB algorithm uses an informatics baseline created using at least 48 diverse
samples, to allow assessment of corrected log2ratios of amplicons of identified CNV
regions (usually genes) in input sample data. This is followed by a correction for the
percent tumor cellularity recorded for the sample to give Copy Number and
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Understanding
CNV Somatic
Confidence Range
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Confidence Interval data for the identified CNV regions. The algorithms used to
compute the corrected log?2 ratios as well as the correction for tumor fraction are
proprietary.

Known sources of variability include pool imbalance (when the assay has more than
one pool of amplicons), total number of reads and per amplicon attributes of GC
proportion and length of the amplicon insert. In practice, we observe other variability
that does not associate with known attributes yet is systematic. The procedure we use
trains on a large number of diverse samples, captures systematic effects, and encodes
these into a file (the "baseline").

When augmenting a baseline, new samples are run, the size of each systematic effect
encoded in the baseline is estimated, and a correction is applied to remove the effect.
These added samples need not be normal and should be diverse so as to capture likely
systematic variation.

Note: Logs for both successful and failed analyses include the "BaselineCreation.log"
file that has the BAM files named that were rejected due to similarity to other files in
the baseline, as well as the "map.TmapMergeActor-00.err" file that has the BAM files
named that were rejected due to QC failure.

The somatic CNV algorithms in Ion Reporter™ Software deliver not only a ploidy
estimate call, but also a pair of 90% confidence values. The 5% lower confidence
bound value is the ploidy estimate where there is a 5% chance the true ploidy is below
that value. The 95% upper confidence bound is the ploidy estimate where it is 95%
certain that the true ploidy is below that value. For calling focal amplification the
lower bound is important and not the upper bound.

Default filtering for the Ion AmpliSeq™ Immune Repertoire Assay Plus—TCRp looks
for Gains whose 5% Confidence interval (5% CI) is at least a ploidy of 2 extra copies
over the expected normal ploidy value (expected ploidy is 2 for autosomes, and X in
females and 1 in X in males). The filter will look for Oncomine™ Annotated variants,
and for Oncomine™ Annotated CNVs, in most cases gains of 2 + 2 (gain + expected
normal)= 4. Currently the Oncomine™ Variant Annotator plugin annotates somatic
CNVs on all chromosomes for the known copy gain genes in the Ion AmpliSeq™

Immune Repertoire Assay Plus—TCRf results whose 5% Cl is >4.
How do I look for other gains than the default?

To create a custom somatic CNV filter, choose "CNV Somatic Confidence Range"
filter, which has OR selected, and uncheck the "Enabled" checkbox for the "Minimum
Ploidy Loss (95% CI) user expected" filter. Double check that the "Minimum Ploidy
Gain (5% CI) over expected" Enabled checkbox is selected. The new value should be
the ploidy of gain (over expected normal) you wish to threshold on when looking at
the 5% CI value. So if looking for gains whose 5% CI value is anything over expected
normal of autosomes (2), leave the value set at 0.0.

The default of 0.0 will find all gains whose 5% CI value is of ploidy 2 or greater.
Setting the value to 1.0 will cause the filter look for all gains whose 5% CI value is of
ploidy 3 or greater, for example.

Note: The OVAT annotation will be added to known copy gain genes on each assay's
CNVs by looking at the 5%CI value of >4.

How do I set the filter to look for gains and for losses?
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This is relevant especially for the Ion AmpliSeq™ Immune Repertoire Assay Plus—
TCRp CNVs where Tumor Suppressor genes are involved and deletion may have a
biological impact.

To set a custom filter to look for gains and losses using the CI values, choose the filter

"CNYV Somatic Confidence Range", then Enable both the "Minimum Ploidy Gain (5%
CI) over expected" and the "Minimum Ploidy Loss (95% CI) under expected" filter.

We are now asking the 5% CI value and filter to threshold for Gains, and the 95% CI
value and filter to threshold Losses.

If we set the "Minimum Ploidy Gain (5% CI) over expected greater_than" to 2.0, (2+2=4
ploidy for gains, so anything 4 and above will be filtered in as a gain), and the
"Minimum Ploidy Loss (95% CI) under expected to be greater_than" value to 0.0
(2-0=2 ploidy for losses, so nothing exceeding expected normal of 2 will be filtered in
as a loss), we can expect the following example CNV call CI data to cause the CNV
data to be filtered in or out of the results:

¢ A gene with suspected gain with 5% CI=4.1 and 95% CI =10.3 will be filtered in
* A gene with suspected loss with 5% CI =0 and 95% CI = 1.0 will be filtered in

* A gene with suspected gain with 5% CI =2.2 and 95% CI = 3.6 will be filtered out
(2.2 is less than 4)

* A gene with suspected gain with 5% CI =2.1 And 95% CI = 5.2 Will be filtered out
(2.1 is less than 4)

* A gene with 5% CI = 0.8 and 95% CI = 2.1 will be filtered out (0.8 is less than 4 and
2.1 is greater than 2)
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Custom workflows

There are two ways to create custom workflows for Ion Reporter™ Software.

* You can copy an existing workflow, then edit its settings. See “Copy and edit a
workflow” on page 108.

® You can also use the wizard to create a new workflow. See “Create a custom
workflow with the Ion Reporter™ wizard” on page 86.

Create a custom Ion ReporterTM Software provides a wizard to guide you through workflow creation.
workflow witTrn} the  Note:

lon Reporter - To create a custom workflow that analyzes your Ion AmpliSeq custom panel, in
wizard the Reference tab, import your custom panel as a target regions file. The wizard

provides details when you are asked to set up the Reference step. Details are
provided in the Reference step (see the table immediately preceding. (Import a
design from AmpliSeq.com).

- Copying and editing from a factory-shipped workflow will always start with the
same optimized set of parameters as the original workflow (until edited).

+ Creating a custom workflow can have different default parameters based on the
workflow and template, and may not contain the most-optimized set of parameters.

+ Our recommendation for custom-panel workflows is to copy and edit a factory-
shipped workflow most similar to the panel and algorithmic processing you desire,
instead of creating a new workflow. If you are creating a new workflow, compare
its parameters with those of an existing factory-shipped workflow to optimize
performance.

+ There may be some types of algorithmic calculation modules that cannot be
included in custom workflows created with the Ion Reporter  Software wizard.
Those algorithmic calculation modules also may not be available if the workflow
cannot be copied and edited.

1. Login to the Ion Reporter™ Software, then click the Workflows tab.
2. Click the Create Workflow button.
3. The workflow wizard opens to guide you through the process of creating a

workflow. Follow the instructions that are presented by the wizard. The
following sections describe each step in more detail.
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Application

Description

Aneuploidy

Detect human chromosomal large
structural abnormalities in low-pass whole-
genome sequencing samples

Annotate Variants

Annotate the variants from a VCF file

DNA

Detect and annotate variants in human DNA
research samples

DNA and Fusions

Detect and annotate variants in human DNA
and Fusions samples

Metagenomics

Determine population diversity in
polymicrobial samples using detection of
16S gene variable regions

Oncology-Liquid Biopsy

Detect and annotate variants in human
samples

Fusions

Detect and annotate gene fusions in human
DNA research samples

The available sample group types are:
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Sample group

Descriptio
n

Application(s)

Paired

Analyze
and
compare
two
samples

DNA

Tumor—Normal

Identify
somatic
mutations
using
advanced
statistical
approache
s

DNA

Single

Analyze a
single
sample

Aneuploidy, Annotate
Variants, DNA, Fusions,
DNA and Fusions,
Metagenomics,
Oncology-Liquid Biopsy

Trio

Analyze a
trioof a
mother,
father, and
proband.

DNA

Single Fusions

Analyze a
single
Fusions
sample

Fusions

Single/Multi

Determine
the
microbial
diversity of
a 16S
sample in
one or
more
samples

Metagenomics
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Select the application type and sample group type for your new workflow.
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The Next button appears after you select your sample group type.

2. Click the Next button.

Select a Reference
For Aneuploidy, Annotate Variants, DNA and DNA and Fusions workflows

Ion Reporter™ Software offers hg19 and GRch38 references for human-scale DNA
workflows. For DNA applications, you also select files for the target regions and
hotspot regions for use in the analysis. For DNA and Fusions workflows, you select a
fusions file.

1. Select the files that you wish to use for the regions / hotspot files using the drop-
downs.

The names of the files you select or upload are added to the Summary.

2. For single sample DNA workflows, select either Somatic or Germline variant
detection type.

3. Click the Next button. (The Next button appears after you make your Variant
Type Detection selection, either Somatic or Germline.)
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Target regions and hotspot files

If your regions or hotspot file does not appear in the drop-down list, you can upload a
new one as follows:

1. Click Upload.

2. Select the type of file you are uploading and click Select file.

3. Navigate to the folder containing your BED file, select it, and click Select or
Choose.
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4. Confirm that the correct filename appears in the display field. Click Upload.

5. Your BED file is uploaded and verified. When verification is complete, click
Close.

6. Your BED file is added to the list of files selectable in the drop-down for Target
Regions or Hotspot Regions, depending on which type of file or files that you
uploaded.

Import a design from AmpliSeq.com

Use this process to import a target regions file that matches your custom design on
AmpliSeq.com. You can also import a target regions file for a fixed panel, but target
regions files for fixed panels typically are supplied with Ion Reporter  Software.

To import a design from AmpliSeq.com, follow these steps:

1. Click the AmpliSeq Import button.
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2. Select an import type, either: Custom Panel or Fixed Panel.

For a fixed panel:

¢ Select the panel that you want to import from the Fixed Panels list and then click
Import .

* Your BED file is added to the list of files selectable in the drop-down.
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For a custom panel:
* Enter your user name and password and then clickList My AmpliSeq Panels.

* Select the panel that you want to import from the drop-down box and then click
Import .

* Your BED file is added to the list of files selectable in the drop-down.

Import panel for lon 540™ Chip analysis

To analyze data from an Ion 540" Chip that was prepared using the ITon AmpliSeq
Exome RDY S5 Kit, you must import the latest version of the ExomePanel_Hi-Q panel
into Ton Reporter  Software. You can download and import this panel from
ampliseq.com as part of creating a workflow in the software.

IMPORTANT! If your Ion Reporter  Softwarehas an older version of the
ExomePanel_Hi-Q target regions BED file, you must delete it and any workflows that
use it before importing the new version. Older versions do not support Ion 540" Chip
analysis.
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To import the ExomePanel_Hi-Q panel:

1. Inlon Reporter™ Software, go to Workflows » Create.

2. In the Application tab, click DNA, click Single, then click Next.

3. In the Reference tab, click AmpliSeq Import below the Target Regions
dropdown list.

4. In the Import from AmpliSeq dialog, select the Fixed Panel tab, then select
ExomePanel_Hi-Q from the list. Click Import.

Note: The import takes several seconds.
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5. When the import is complete, the panel is listed in the Target Regions field. To
proceed with workflow creation for Ion 540™ Chip analysis, select 540 for the
Sequencing Platform, then select the remaining workflow settings.

After import, the ExomePanel_Hi-Q panel will be available in the Target Regions
dropdown list when you create subsequent workflows. The parameters
associated with this panel will be listed in the Parameters tab, Variant Finding
subtab.

Select references for metagenomics workflows

The metagenomics workflow provides access to two reference databases for mapping:
the curated MicroSEQ™ ID database and curated GreenGenes database. If both
databases are selected, data are first mapped against the curated MicroSEQ™
database. Next, reads that were not mapped against the curated MicroSEQ™ database
are mapped against the curated /GreenGenes database.

1. Select one or more reference databases to map the data against.

2. Click the Next button.

Select Primers for Metagenomics workflows

Note: In this release, the UI allows you to create a workflow that does not contain
any primer information. However, we recommend that you always add primer
information to your metagenomics workflow. When the primer information is
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missing, no trimming is performed on your reads. A warning message appears during
analysis review when primer information is missing.

@ Analyses

Warning: Mo primers submitted. All reads will be treated as valid reads and checked for length

The Primers tab is only used for the metagenomics workflow. Here you either upload
or paste in a set of primer sequences that were used to prepare your samples. If
provided, these sequences are trimmed from the reads before mapping. The names of
forward primers must end in "_f*" and reverse primer names must end in "_r*".
Primers in a pair must otherwise have identical names so that the software can match
them up during the analysis. An example of a FASTA formatted file is provided
below:

>MyFavoriteV5 forward ACTCGGTCCARACTGAGACT

>MyFavoriteV5:Rev TTACCGRGGCGTATGCGG
>MyFavoriteV8 Fwd CCARAACTCGGTCTGSGACT
>MyFavoriteV8 r RGGCGTATGCSTACCGGG

To upload your FASTA file containing your primer sequences:

1. Click the Select file button.

m m workﬂows

Ove e Create Presels

ﬁfr? Create Workflow

fplicetion feference

Primer designs for 165 metagenomics may require optimization for optimal results.

Input the primers used in your library preparation. Learn more...

Upload FASTA File:

Select file

Paste FASTA Sequences:
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2. Navigate to the folder containing your FASTA file, select it, and click the Choose,
Open, or Save button.

3. The Select button is replaced by Change, Remove, and Upload buttons. Ensure
that the correct filename appears in the Upload FASTA File field, then click the
Upload button.

ﬁfr? Create Workflow

Applcation peference “

Frirmer designs for 165 metagenomics may require optimization for optimal results.

Input the primers used in your library preparation. Learm more...

Upload FASTA File:
E Change  Remave Upload

FPaste FASTA Sequences:
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4. Your primer sequences are uploaded and you can edit them if needed in the text
window. Alternatively you can just paste in your primer sequences directly into
the text box.

-:;"’1'7[3 Create Workflow

Arplication reference “

Primer designs for 165 metagenormics may require optimization for optirmal results

Input the primers used in your library preparation. Learn more. .

Upload FASTA File:
Select file

Paste FASTA SeqUENCES:

=htyFavoritey's_forward
ACTCOGTCCARACT GAGACT
=hiyFavaoritev's_Rew
TTACCCRGGCGTATGCGS
=hyF avaritey's_Fwid
CCARAMCTCGGTCTGSGACT
=hyFavoritevs_r
RGGCGTATGCSTACCGGE

Please see the primers section of the help guide for reguired format information

Cancal

5. Click the Next button.

Select an Annotation set

Annotation sets are the group of annotation sources that you want to attach to
variants identified in your analysis. To select an annotation set:

1. Select the annotation set you wish to use from the drop-down box.

2. The annotation sources contained in the annotation set are shown.
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3. To create a new annotation set, click the New icon.

4. Click the Next button.

Select a Filter Chain

Filter chains are a set of filters that you want to apply to variants identified in your
analysis. To select a filter chain:

1. Select the filter chain of your choice from the Filter Chains list.

2. The filters contained in the filter chain are shown.

3. To create a new filter chain click the New icon.
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4. Click the Next button.

You can change or modify the filter chain applied to your analysis from the variant
review screen.

Select a Copy Number baseline

The Copy Number chevron is only present in the aneuploidy and single sample DNA
workflows. This is where you can select a copy number baseline to use when
detecting CNVs. You are only shown baselines that were created using the same
regions file selected in the Reference chevron of the workflow creation process. The
selection Do not call CNVs causes the CNV calling step of the workflow to be
skipped during analyses. To select a baseline:

1. Select the baseline you wish to use from the drop-down box.

2. The settings for this baseline are displayed.

3. Click the Next button.

See CNV baselines in the workflow presets section for information on how to create
your own CNYV baseline.
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Allele-specific (Proper) view of variants

When you set workflow parameters, you can select variants per position, Classic, or
variants per allele, Proper.

The default variant output in Ion Reporter™ Software is a Classic view (locus-centric),
with each line of the VCF file corresponding to one line of Ion Reporter™ Software
variant output. In Classic view, there can be multiple alternate alleles for a given
locus. Ion Reporter™ Software also offers a Proper view output feature which is "allele-
centric" with each allele displayed as a single line of record in the output (Per-allele
view). The VCF file that is generated by Classic view is called "Classic VCF". The VCF

file that is generated by the Per allele view is called "proper VCF".

The FDP (Flow Evaluator read depth at the locus) and DP (Total read depth at the
locus) are subfields inside the INFO field of the VCEF file. The values of these two
fields remain the same for both the "classic VCF file" and the "proper VCF file". These
two fields, FDP and DD, are based on the TOTAL SUM of ALL the FAO (Flow
Evaluator Alternate allele observations) and AO (Alternate allele observations) fields,
which are based on the following formulas:

"FDP=SUM(FAO)+FRO or DP=SUM(AQO)+RO"

Note: In Ion Reporter™ Software 5.6, the proper VCF file includes values of the FDP
and DP fields that remain the same, although each allele is displayed as a single line
of record in the proper VCF file. In a future version of Ion Reporter™ Software, since
these fields do not really apply to per-allele view, the values of these two fields might

be replaced with missing values "." in the proper VCEF file.

1. When creating or modifying a workflow, in the Parameters screen, select Variant
Finding » Advanced.

2. Under Variant View, select Proper.
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Add plugins to a workflow

Plugins provide additional functionality and content to the workflow. In the Plugins
step of the workflow bar, you can optionally select an in-analysis plugin to include in
your workflow.

Note: Functionality for the Oncomine Variant Annotator plugin is highly dependent
upon the panel used for the assay, so only data from supported panels should be run
through workflows that contain this plugin.

1. To select an in-analysis plugin to include in your workflow, click anywhere on its
logo, title, or text. The plugin box is highlighted and marked with a checkmark.

Note: The Oncomine Variant Annotator plugin is selected by default for some
Oncomine workflows.

§frg Edit Workflow

copy of Oncomine Focus w2.3 - DNA - Single

Research Application Reference Annotation Filters Copy Humber m

Pluging provide access to additional content and functionality. Select which pluging you wish to include in your workflow. Learn
In-Analysis Plugins

Oncomine Yariant Annotator «2.3

The Oncomine® annotation plugin enables rapid identification of driver gain-of-functioniloss-of-function

variants in any cancer research sample by integrating data from maore than 5,300 turmar-narmal
ex0mes across 48 types of cancer,

2. Click Next.
You can also add in-analysis plugins when you launch an analysis and post-analysis
plugins on the variant review page.
Final Report

For the annotate, aneuploidy, and DNA workflows, the final report provides a
mechanism to summarize the data for a set of variants selected by the user. The report
contains a number of sections, which are described in this table.

Section Description

Header Contains date and time information and can
be customized with a logo.

Background Contains summary text describing the
purpose of the report generated by the
workflow.

Analysis information Provides summary information about the

analysis that was run, including the lon
Reporterm Software version, the user who
imported the data, the user who analyzed
the data, and more.
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Section

Description

Sample information

Provides detailed information about each
sample: the chip type, file path, bar code,
sample name, library preparation, gender,
chip ID, device ID, sequencing run type,
sample ID, and relationship.

Reported variants

Lists the variants that were reported and
their classification, gene, and locus
information.

Variant details

Provides detailed information about each
variant along with annotation and comment
information.

Comments

Provides a mechanism for the user to give
analysis specific comments to include in
the final report

Sign-off

Provides signature lines for a configurable
set of persons identified by their name and
title.

Disclaimer

Provides a customizable legal disclaimer
that is placed at the end of the report.

You can view an example final report. To select a report template:

1. Select the report template you wish to use from the report template drop-down

menu.

m m torkdlows

Create

i‘i‘?ra Create Workflow

Application Reference

Filters Copy Number Plugins Final Report

Wariant report termplates specify content that is provided when reporting variants. Learn more

Final Report Template

| Default Final Report Tem. - |

Default Final Report Template |ure in Warkflow Presets

Header

This =secfinn can ha cistimized with nranization name. aranization addrass. and Inon

2. The settings for the report template are displayed under the Sections area.

104

lon Reporter™ Software 5.6 Help



Workflows in lon Reporter™Software
Custom workflows

3. To create a new report template click the New icon.
4. Click the Next button (at the bottom of the page).

Accept default or change Parameters

The Parameters chevron is where you can modify any of the run time parameters. It is
always recommended to use the default settings unless you know what you are
doing.

The modules that you can customize vary by workflow. Example:

Follow these steps to change any settings:

1. Select the parameter section on the left and modify the parameters as needed.

2. Click the Next button.
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QC report metrics and thresholds

QC report settings can be customized in the Bamstats module. Bamstats parameters
are described in the Create Workflow wizard Parameters chevron. Click Bamstats in
the module list on the left.

There are also QC metrics not present in the QC report: MAPD for Copy Number and
Total Mapped Fusion Panel Reads for fusions.

Confirm and create workflow

The Confirm chevron is the last step in the workflow creation process. To confirm and
create your workflow:

1. Provide a descriptive name for your workflow.
2. Optionally provide a description for your workflow.
3. Click the Save Workflow button.

4. Your workflow is saved and is listed in the workflows table.
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Import custom TVC parameters

If you would like to use custom Torrent Variant Caller variant finding parameters in
Ton Reporter  software, export the parameters JSON file from Torrent Suite™
software. Then, import this file from the Parameters screen when creating a workflow.

1. Export the TVC parameters from Torrent Suite™ software and store the JSON file
on your computer or network.

2. Begin building your workflow in Ion Reporter™ software and on the Parameters
tab, select Variant Finding.

3. Click Select File and browse to your TVC parameters JSON file and click Import.

The TVC parameters replace the default settings. Error messages will appear if
any of the imported parameters are out-of-range or if a JSON file with an
incompatible format was imported.
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Confirm and create workflow

The Confirm chevron is the last step in the workflow creation process. To confirm and
create your workflow:

1. Provide a descriptive name for your workflow.
2. Optionally provide a description for your workflow.

3. Click the Save Workflow button.

Your workflow is saved and is listed in the workflows table.

Copy and edit a To save time, you can copy workflows for reuse.

workflow 1. Go to Workflows » Overview

2. Search for the workflow you want to copy.
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3. Select workflow and click Actions » Copy. This launches you into the editing
mode for the selected workflow.

4. Click Next button to advance through Reference, Annotations, Filters, Plugins,
Final Report, and Parameters chevrons to accept default settings.

5. On the Confirm page, name the workflow and click Save Workflow.

Note: For metagenomics workflows, you cannot view the proprietary primer details
of an Ion default metagenomics workflow when you copy the workflow.
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Edit custom workflows

You can edit a workflow to change the settings or parameters associated with the
workflow.

Note:

* You cannot edit preinstalled workflows and locked workflows. Once a workflow is
locked, that action can not be undone.

+ To edit a workflow created in a version of Ion Reporter ~ Software earlier than
version 5.2, you must select a MyVariants database in the Annotation chevron to
proceed.

1. In the Workflows tab, select the workflow that you want to edit in the Workflows
list, then click Edit in the Details section.

2. Proceed the workflow wizard as described in “Create a custom workflow with
the Ton Reporter™ wizard” on page 86.

Workflow presets

Workflow presets are the components that are used in creating a workflow. The
following list describes the types of workflow presets:

Preset type Description

BED files Files that are accessible for selection in the
Reference chevron of creating a workflow.
BED files are used as the following:

e Target regions files, which restrict
analysis to only regions specified in the
file

e Hotspot files, which cause the hotspot
positions to be listed in the variants
table, even if a variant is not called at
those positions

Annotation sets Set of annotation sources to apply to
variants for selection in the Annotation
chevron of creating a workflow.
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Preset type

Description

Filter chains

CNV baselines

Report templates

Set of filters to apply to variants for
selection in the Filter chevron of creating a
workflow.

Set of control samples that are used to
create a baseline for detecting CNVs. The
baselines are accessible in the Copy
Number chevron when you create a
workflow.

Final report templates that are accessible
for selection in the Final Report chevron of
creating a workflow.

Create a Target

. : IMPORTANT! Use only BED file names that do not contain spaces. If a file name
regions BED file includes spaces, the analysis fails.

workflow preset

1. In the Workflows tab, click Create.

2. In the Research Application column, click DNA. Click any type of sample

group.

3. In the Reference chevron, in the Target Regions section, click Upload.

4. Inthe Upload Target Regions File dialog:

a. Select your library type or technology.
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b. Click the Select File button, then browse to your BED file.

Upload Target Regions File

O lon Ampligeg™

@ lon AmpliSeq™ Exame

O lon TargetSeg™

O Other Amplicon technalogy

(O Other Amplicon Exome technology
O Other Hybridization technology

Select file

Supported types: vef, bef, velgz, bef.gz

c. Ensure that the correct BED file name appears in the display field and click
Upload.

Upload Target Regions File

O lon Ampliseg™

® lon AmpliSeq™ Exome

O lon TargetSeq™

© Other Amplicon technology

© Other Amplicon Exome technology
O Other Hybridization technaology

B Change  Remuove Upload

Supponed types: vef, bef, vef.gz, befaz

Ion Reporter™ Software uploads and verifies your BED file. When
verification is complete, the progress bar changes to green and you see the
"available for use" message.

d. Click Close .
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The new BED file preset appears in the Target Regions section of the References

chevron.

You can now upload additional BED files, continue to create a workflow, or
cancel the workflow creation.

If you go to the Workflows tab, then click Presets, then select Annotation
Sets » Target Regions Files you see your new BED file that is listed in the
Workflow Presets table.

(Optional)When your preset works as you intend, then is ready for use in
production, select the preset in the Workflow Presets table, then click
Actions » Lockto lock the workflow. You cannot undo a lock action.
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Cre_ate a HOtSPOt IMPORTANT! Use only BED file names that do not contain spaces. If a file names
regions BED file include spaces, the analysis will fail.
preset

1. In the Workflows tab, click Create.

2. In the Research Application column, click on DNA. Click on any type of sample
group.

3. In the Reference chevron, in the Hotspot Regions section, click Upload.
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In the Upload Hotspot File dialog:
a. Click Select File and browse to your BED file.

Upload Hotspot File

Select file

Supported types: vef, bef, vef.gz, befgz

Cancel

b. Confirm that the correct BED file name appears in the display field and click
Upload.

Upload Hotspot File

[ 5 Change  Remove Upload

Supported types: vef, bef, vel.gz, befgz

Cancel

Ion Reporter™ Software uploads and verifies your BED file. When
verification is complete, the progress bar changes to green and you see the
"available for use" message.

c. Click Close.

The new BED file preset appears in the Hotspot Regions section of the
References chevron.
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5. You can now upload additional BED files, continue to create a workflow, or
cancel the workflow creation.

If you go to the Workflows tab, then click Presets, then select Annotation
Sets » Hotspot Regions Files you see the new BED file listed in the Workflow
Presets table.

6. (Optional)When your preset works as you intend and is ready for use in

production, select the preset in the Workflow Presets table and click
Actions » Lockto lock the workflow. You cannot undo a lock action.

Create annotation 1. In the Workflows tab, click Presets.
set workflow
presets

2. Click Create Preset » Annotation Set.

3. In the Create Annotation Set screen:

6 I

—®

a. Enter a descriptive name.
b. (Optional) Enter a description of the annotation set.
c. Select the annotation source that you want to add to the preset from the list.

d. Click Use next to the annotation source that you want to use.
The source is added to the list of Selected Sources in your annotation set.
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e. Repeat this process for each annotation source you want to add to your
annotation set until your list of Selected Sources is complete.

™

Note: Ion Reporter™ Software includes two gene models: RefGene and
Ensembl. When you select annotation sources, to use a factory-shipped
canonical transcript set, you must use the compatible gene model. For
example, use the RefGene gene model with Refseq canonical transcript set.

f. Click Save to save the annotation set.

The annotation set now appears in the Workflow Presets table and is
available in the Annotation chevron when you create a workflow in Ion
Reporter™ Software.

4. (Optional)When your preset works as you intend, then is ready for use in
production, select the preset in the Workflow Presets table, then click
Actions » Lockto lock the workflow. You cannot undo a lock action.

View custom annotation sources

Annotation sets created by users are displayed in the Annotation Source dropdown
list. See “Create annotation set workflow presets” on page 116 for details.

Note: For custom annotations that are very long, you can drag the column to the
right to resize the content for easier reading.

To view current list of custom annotation sets:

1. In the Workflows tab, click Presets.

2. Click Annotation Set » Annotation Source.
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A table listing the custom annotation sources appears. You can use these custom
annotation sources to create custom annotation sets.
Create filter set 1. In the Workflows tab, click Presets.

workflow presets

2. Click Create Preset » Filter Chain.
3. Enter a meaningful name and description of the filter chain.

4. Select the type of filter you want to add from the dropdown list.
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5. Click the Set button when you have configured it.

6. Repeat this process for each filter you want in your filter chain.

7. Click the Save button to save the filter chain.

The filter chain now appears in the Workflow Presets table and is selectable in
the Filters chevron of creating a workflow.
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Create a Copy
Number baseline

120

This section completes the instructions in Create workflow presets (annotation sets,
filters, reports, and so on), for CNV baseline presets. These are used in the Copy
Number chevron of creating a workflow.

Notes:

* Workflows that use baseline controls can provide better copy number detection
(for both CNV variants and aneuploidy) than a paired sample workflow.

* In this release, use only male samples for creating an informatics baseline control.

* Copy Number estimates are made by counting reads for each amplicon, making
adjustments to account for certain types of variability, comparing those read
counts to expected counts for those amplicons in a "normal" sample and then
making further changes.

* Known sources of variability include pool imbalance (when the assay has more
than one pool of amplicons), total number of reads and per amplicon attributes of
GC proportion and length of the amplicon insert. In practice, we observe other
variability that does not associate with known attributes yet is systematic.

To create a Copy Number baseline workflow preset, walk through the wizard and
complete each tab (Baseline Type, Samples, and Confirm tabs). See also the notes
about baseline samples, in the Samples tab section.

Configure Baseline Type

In the Baseline Type chevron, you select the type of baseline that you want to create
and select the regions file that corresponds to panel you are using. You can create the
following types of baselines:

Type Description

AmpliSeq Create CNV
baselines when
using lon AmpliSeqm
libraries (not
Exome).

AmpliSeq-Exome Create CNV
baselines when
using lon AmpliSeq"™
Exome libraries.

TargetSeq Exome Create CNV
baselines when
using lon TargetSeq "
Exome or other
targeted libraries.

Low-coverage Whole-Genome Create CNV
baselines when
using whole genome
libraries with low
coverage [e.g.
Aneuploidy).
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To configure your baseline type:

1. Select the baseline type, then select the regions file from the dropdown list.

2. Click Next.

Select samples

In the samples chevron, select the samples to be used in your baseline creation, based
on the following guidelines:

Samples that are used in CNV baselines:

e Use only male samples in the baseline creation process in Ion Reporter™ Software
4.x.Xx.

¢ Although at least five samples are required in the baseline creation, ten or more
samples are recommended for satisfactory results. (The use of more samples for
baseline calculation substantially reduces sample-to-sample variance in coverage
and results in fewer false positive calls.)

* Select control samples to add to your baseline which have no known CNVs in
any region that is covered by the Ion AmpliSeq™ panel that is used, if possible.
The presence of a CNV in your control samples can cause false positive CNVs to

be reported for that region in your test samples.
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Sample creation and gender assignment:

¢ If you do not see your samples in the table, see “Manage samples” on page 43 for
information on how to upload or define a sample.

* See “Gender information requirements” on page 45 for details.

* Samples must have "gender" attribute set to "male" to be selectable when creating
a baseline.

Follow these steps to select your samples:

1. Select all files for this baseline. The Next button is not active until you select at
least five samples.

2. Click Next.
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Confirm baseline

Use the Confirm chevron to name your baseline and review everything before you
launch the baseline creation.

Follow these steps to finish your baseline and start the baseline creation analysis job :

1. Provide a descriptive name for your baseline.

2. (Optional) Provide a description for your baseline.
3. Click the Create Baseline button.

4. The baseline creation job is started and the baseline with its status now appears
in your table. When the analysis completes, it is selectable in the Copy Number
chevron of creating a workflow.

If you click a baseline in the table, the details are provided on the right.

Create a report 1. In the Workflows tab, click Presets.
template

2. Click Create Preset » Final Report Template.
3. A skeleton report template opens.

4. At the top of the report template, enter a name and description for this template.
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5. Inthe Header section, enter the organization name and address. Click the
Upload button to add the organization's logo.

Create Final Report Template

Mame Description
Example for Pubs Example for Pubs
Sections
Header

This section can be customized with organization narme, arganization address, and logo.

Organization Name | Example Org Narme
Organization Address Example Org Address

Logjo
® Upload

6. For each optional section Background, Sign Off, and Disclaimer), either enter the
content for the section to contain or click the Exclude button for the section.

Sign Off (Optional) O Include

This section provides signature lines for a configurable set of persons identified by their name and title.

Disclaimer (Optional) O Exclude @ Include

This section provides a customizable legal disclaimer thatis placed atthe end ofthe report. (e.y. For research use only. Mot for use in diagnostic proceduras.)

I For research use only. Mot for use in diagnostic procedures.

7. If you want the Sign Off section to list more than one required approver), click
the Add button to add an additional approver.

8. Click the Save to create your report template preset.
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Fixed sections

The following sections always appear in every final report template. These sections
are not optional and are not configurable. Ion Reporter™ Software generates the
content for these sections for every analysis (in workflows that use this template).

* Analysis Information
* Samples Overview

* Reported Variants

* Variant Details

e Comments

Optional sections

The following sections are optional. You control whether or not each of these sections
appears in the final report with Exclude and Include radio buttons.

The information that you enter in these sections is fixed and appears as-is for every
analysis (in workflows that use this template).

¢ Background
e Sign Off
* Disclaimer
The information that you enter in the Header section also is fixed and appears as-is for

every analysis (in workflows that use this template). You specify the content for the
Header section.
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Export and import
a custom
workflow

126

Ton Reporter  Software gives you the ability to export a custom workflow, then
import that workflow to another Ion Reporter " Server or Ion Reporter  Software on
Thermo Fisher Cloud account. Exporting and importing a workflow that has the
settings you require saves time, since you can resuse the custom workflow, rather
than creating a new workflow for each server or account.

You must use an Ion Reporter ~ Software account with the analyze role to export and
import a workflow. A workflow can only be exported from, then imported to, a single
Ton Reporter  Software organization. Each compressed file directory can contain only
one workflow.

Note: The target regions, hotspot regions, and CNV baseline files, are not included in
the compressed directory that is exported. Presets for the workflow, including presets
for the annotation set, filter chain, copy number baseline, final report template, fusion
panel, target regions file, and hotspot regions file are also not included in the export
directory. The files must be uploaded separately, and the presets must be present in
the organization into which the workflow is imported.

1. In the Workflows tab, click Overview, then find the custom workflow that you
want to transfer, then select the workflow.

2. Click Actions » Export Workflow.

3. Browse to the directory where you want to download the compressed directory
of the files used for the workflow, then click Export.

4. Sign into the Ion Reporter™ Server or Ion Reporter™ Software on Thermo Fisher
Cloud account that you want to use to import the workflow. In the Workflows
tab, click Overview, then click Import Workflow.

5. Click Select File, then browse to and select the compressed directory (ZIP) file.
The filename of the workflow directory is workflow name.zip.

The workflow directory contains two files: a file with metadata to set the
workflow parameters, and a separate parameters file.

6. Click Open, then click Import.

7. Refresh the Workflows list, or search for the workflow by name, then verify that
the workflow is in the list for the Ion Reporter™ Server or Ion Reporter™ Software
on Thermo Fisher Cloud account on which you imported the workflow.

You can begin to use the workflow immediately, provided that the target regions,

hotspot regions, and CNV baseline files, and presets are available in the Ton Reporter
Server or Ion Reporter  Software on Thermo Fisher Cloud account.
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Workflow revision autonumbering

Ion Reporter™ Software displays workflow revision numbers and automatically
increases workflow revision numbers when you copy or edit a workflow.

To view workflow version numbers:

1. Click Workflows » Overview, then select the desired workflow.
The workflow revision number is displayed on the Details pane. By default,
every workflow starts at revision number 0; that number increases if you copy or
edit either a factory or custom workflow, then keep the name of the previous
version as the new workflow name.
You can only copy factory and custom workflows that are created in the most
recent version of the software. Older version workflows that are unlocked can be
edited, but the older versions workflows cannot be copied to create additional
workflows.
The revision numbers appear at the end of the workflow name (r.#). This revision
level also appears on the QC Report and Audit log.
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Lock a workflow

Locking a workflow allows you to ensure that no changes can be made to settings or
parameters.

Note: Once a workflow has been locked, it can not be unlocked.

Follow these steps to lock a workflow:

™

1. Log in to Ion Reporter™ Software and click on the Workflows tab.

2. Select the workflow you wish to lock from the table and the select Lock from the
£* Actions drop-down menu in the workflow details section.

Note: Once a workflow is locked, that action can not be undone.

3. Confirm you want to lock the workflow.

Lock Workflow

Are you sure you want to lock this workflow?

No

The workflow is now locked and cannot be edited.
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Run a plugin as part of a workflow

Use this procedure to run a plugin as part of a workflow.

lon Reporter™ Software 5.6 Help

Before a plugin can be used as part of a workflow, it must be uploaded into the
Ton Reporter  Software.

Currently, there are two ready-to-use plugins that are compatible with Ion
Reporter = Software:

- AmpliSeq RNA (version 5.4.0.1-IR1)
— RNASeq (version 5.4.0.1-IR1)

The AmpliSeq RNA and RNASeq plugins can be downloaded from the Thermo
Fisher Cloud and uploaded into the Ion Reporter  Software (see “Download
plugins from Themo Fisher Cloud” on page 316).

See the "Create your own plugins'.

. In the Ion Reporter screen, select the Workflows tab.

Select a workflow, then click Actions, then select copy in the dropdown list
menu.

To create a new workflow, select the default plugin workflow (Run Plugin w1.0).
The default plugin workflow is a template for running plugins as part of a
workflow, but does not have any specific plugins uploaded.

In the Edit Workflow screen, select the Plugins subtab.

Select a plugin or plugins from the list by clicking each plugin.

Note: Plugins can also be added when launching an analysis (see “Add
plugins” on page 140).

(Optional) Click # to configure plugin.

Click Next or click the Confirm tab.

Enter the name for the workflow.

(Optional) Enter a description.

Click Save Window.

The saved workflow now appears in the list of workflows in the Workflows
screen.

For plugins that support multi-sample visualizations or comparisons, to show
results that compare samples analyzed together for a plugin, all samples that you
want to compare must be added to a single analysis and launched as a single
analysis.

129



Analyses in lon Reporter” Software

Ion Reporter™ Software provides tools that enable you to manage your analyses. In
the Analyses tab, you can launch new analyses and review results of your completed
analyses.

Launch an analysis

Use one of the following methods to launch a single analysis in the analysis wizard:

* Launch an analysis from the Workflows page:
a. Log in tolon Reporter™ Software and click on the Workflows tab.

b. Select the row for the workflow that you want to launch.

The row that contains the workflow is highlighted and information about
the workflow is shown in the Details pane.

c. Click Actions, then select Launch Analysis from the dropdown list.

Proceed to “Choose samples” on page 134

* Launch an analysis from the Analyses Overview page:
a. Login to Ion Reporter™ Software, then click on the Analyses tab.

b. Click Launch Analysis, then select Manual.

Proceed to “Select a workflow” on page 131.
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Select a workflow In the Workflow chevron, you select a workflow to launch. If you have previously
selected a workflow, proceed to “Choose samples” on page 134

1.

lon Reporter™ Software 5.6 Help

In the workflow table, select the workflow that you want to launch. Click a row
to highlight a workflow.

Note: To find a workflow in the table, you can useSearch. Enter a string such as
"CCP", "Exome", "IDP", "tumor", "TargetSeq", or your own custom workflow

name and then click Search to get a list of results:

m fnabyses m

Overview

Launch

@ Analyses

Filter Analyses

O

v

Analysis

Stage +

demo

Created On

Search

Status

£ Refresh

oOooooooono O

[Cemaketagenomics Mock Communit_noPrimer_DE1_ce3_138
116121272

Derno Metagenamics Mook Community_1386103785220
(ESLdEtDEmpMEeq Exome VCF_c108_1386109949453
Demo AmpliSeq CCP CNY case_cT48_1386250657085

Demo AmpliSeq |DP Father_c759_1386250857085

Demo Metagennmics Motk Community_c763_1 386250657085
DemnAneup\mdUmj

Demo AmpliSeq IDF Mother_c773_1386250657085

Demno AmpliSed Exome GV case_c793_1 306290657085

Wariant Review

Wariant Review
Wariant Review
wariant Review
Wariant Review
wariant Review
Wariant Review
wariant Review

Wariant Review

Dec 032013 0415 Ph

Dec 032013 12:50 PM
Dec 032013 02:32 Ph
Dec 052013 05:49 Ab
Dec 05 2013 05:453 Ab
Dec 052013 05:49 Ab
Dec 05 2013 05:453 Ab
Dec 06 2013 06:43 Ab

Dec 052013 05:49 Ad

Successil

Successful
Successful
Successil
Successful
Successil
Successful
Successil

Successil
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2. View details for the workflow in the Summary on the right.

3. Click the Next button.

Proceed to “Choose samples” on page 134.
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Launch an analysis

Use the workflows and demonstration sample data listed here to practice working

with analyses.

Demonstration sample

Workflow Variant detection type
name
AmpliSeq CCP single Demo AmpliSeq CHPv2 Somatic
sample tumor, or Demo AmpliSeq
CCP tumor
AmpliSeq CCP tumor- Demo AmpliSeq CCP normal | Somatic
normal pair and Demo AmpliSeq CCP
tumor
AmpliSeq CCP paired Demo AmpliSeq CCP CNV Somatic
sample control and Demo AmpliSeq
CCP CNV case, or Demo
AmpliSeq CCP normal and
Demo AmpliSeq CCP tumor
AmpliSeq Exome paired Demo AmpliSeq Exome CNV | Germline
sample control and Demo AmpliSeq
Exome CNV case
AmpliSeq Exome single Demo AmpliSeq Exome CNV | Germline
sample (Germline) case
AmpliSeq Exome single Demo AmpliSeq Exome CNV | Somatic
sample (Somatic) case
AmpliSeq IDP single Demo AmpliSeq IDP Germline
sample Daughter
AmpliSeq IDP trio Demo AmpliSeq IDP Germline
Daughter, Demo AmpliSeq
IDP Father, and Demo
AmpliSeq IDP Mother
AmpliSeq Colon Lung v2 Demo AmpliSeq CHPv2 Somatic

with RNA Lung Fusion
single sample

tumor and Demo AmpliSeq
RNA Lung Fusion

AmpliSeq RNA Lung Fusion
single sample

Demo AmpliSeq RNA Lung
Fusion

Aneuploidy

Demo Aneuploidy

Metagenomics 165" beta

Metagenomics 165" w1.1

Demo Metagenomics Mock
Community

Annotate variants single
sample

Demo AmpliSeq Exome VCF
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Choose samples In the Samples chevron, you select the samples to be analyzed.

Select a single-sample or multi-sample analyses

Follow these steps to select samples for single sample DNA workflows or multi-
sample metagenomics workflows:

1. In the samples table, select the sample or samples to analyze. Click a row to
highlight the sample.

2. Click Next.

Note: For DNA workflows, if you select multiple samples on this page, Ton Reporter
Software creates a separate analysis for each sample.
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Select paired-sample or tumor-normal analyses

Note: For demo data samples with the tumor-normal workflow, use only the Demo
AmpliSeq CCP normal and Demo AmpliSeq CCP tumor data sets.

Follow these steps to select samples for paired-sample or tumor-normal workflows:

1. In the samples table, select the samples to analyze. Click on both samples to
highlight those samples rows for the pair.

This activates the Add Samples button on the pair window.

2. Click Add Samples to add the samples to the pair.

3. If the samples are placed in the incorrect roles, click the swap icon (%) to switch
the placement of the samples.
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4. Give your pair a descriptive name.

5. Click Add to Analysis.

6. Repeat to add multiple pairs. If you select multiple pairs, Ion Reporter™ Software
creates a separate analysis for each pair.

7. Click Next.

Control sample for CNV workflows

CNVs are reported based on their copy number relative to the control sample used.
For best results, choose a control sample with no known CNVs in any region that is
covered by the Ion AmpliSeq™ panel used. If most or all test samples are reported as
having a CNV in the same region, one possible cause is that the control sample
actually has a CNV in that region (leading to unexpected results).
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Analyze sample pairs

1.

2.

lon Reporter™ Software 5.6 Help

Select one or more samples and click Add Samples.

Name the sample pair and click Add to Analysis.

Review the sample that is Ready to Analyze and then click Next.

Click Next on the Launch Analysis page to bypass the option to install plugins.

Click Launch Analysis.
You are returned to the Analyses Overview page.

Verify there is a message that states the analysis started successfully:
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Select Trio analyses

Follow these steps to select samples for trio workflows:

1. In the samples table, select the samples to analyze. Click on each row of the
sample trio to highlight the samples for the trio.

This activates the Add Samples button on the trio window.

2. Click Add Samples to add the samples to the trio.

3. If the samples were placed in the incorrect roles, click the swap icon () to switch
the placement of the samples.
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4. Give your trio a descriptive name.

5. Click Add to Analysis.

6. Repeat to add multiple trios.

Note: If you select multiple trios, Ion Reporter™ Software creates a separate
analysis for each trio.
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Add plugins

140

7. Click Next.

Plugins provide additional content or functionality to an analysis. Follow these steps
to select the plugins you wish to include as part of your analysis:

Note: Functionality for the Oncomine Variant Annotator plugin is highly dependent
upon the panel used for the assay, so only data from supported panels should be run
through workflows that contain this plugin.

1.

To select an in-analysis plugin to include in your analysis, click anywhere on its
logo, title, or text. The plugin box is highlighted and marked with a checkmark.

Note: The Oncomine Variant Annotator plugin is selected by default for some
Oncomine workflows.

QTYFF Edit Workflow copy of Oncomine Focus w2.3 - DNA - Single

Research Application Reference Annotation Filters Copy Humber m

Pluging provide access to additional content and functionality. Select which pluging you wish to include in your workflow. Learn
In-Analysis Plugins

Oncomine Yariant Annotator w2.3 0
The Oncomine® annotation plugin enables rapid identification of driver gain-of-function/loss-of-function

variants in any cancer research sample by integrating data from more than 5,200 turmor-narmal

exomes across 48 types of cancer.

2. Click Next.
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Confirm and Your analysis is now ready to launch. Review the details of the analysis. When you
launch an analysis ~ are ready to start your analysis follow these steps:

1. Provide a name for your analysis or use the default name. Optionally, add a
description.

If you have multiple analyses, repeat this step for each analysis.

2. Click Launch Analysis.

3. If you have included a plugin in your analysis, you are presented with a cost
breakdown and confirmation screen. Click Confirm & Launch.

4. Your analysis is launched and the analysis table reopens.
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5. Click on an analysis to see more information in the Details section on the right.

How to launch This technique analyses multiple samples, or multiple sets of related samples, using
multiple analyses separate analyses with the same workflow. For example, with one use of the wizard,
you can launch several trio workflows, or several paired workflows -- and each

with the analysis analysis has its own related samples.

wizard
These steps follow the regular analysis launch, except for sample selection.

Follow these steps to launch multiple analyses with the analysis wizard:

1. Log in to Ion Reporter™ Software and click on the Analyses tab.

2. Click on the Launch Analysis button and select Manual.
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3. Select your workflow.

Click the Next button.
4. In the Samples & Relationships chevron, for ease in finding and selecting the

correct samples, enter a search string that includes all the samples for all your
multiple analyses. In this example, only CCP samples are shown.

5. Enable the checkboxes for the samples in your first analysis.

L3 Sample Gender Role Imported By Imported On =
Demo AmpliSeq CCP CHY case Male Unknown User, lon Mov 20 201310003 AM
Demo AmpliSeq CCP CNY control Male Unknown User, lan Moy 20 2013 10:03 Ap
Dermo AmpliSeq CCP normal Male Unknown User, lon Mo 20 201310003 AM
Demo Ampligeq CCP tumor Male Unknown User, lon Mow 20 2013 10003 A
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Follow the same steps as you would to analyse these samples in a single analysis:
a. Click the Add Samples button.

b. Your samples are added to the placeholders in the samples area.

Sample Pairs

Sample: Control:
Demo Demo
AmpliSeny AmpliSen
CCP TR CCP G
case cantrol

c. If the samples are placed in incorrect roles, swap them by clicking the swap
icon
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d. In the text field above your samples, enter a name for this set of samples.

Sample Pairs

Demo Ampliseq CCR Y

Sample: - Control:
Demn Demao
AmpliSen AmpliSen
CCP Gy CCP Y
Case control

Add to Anal

Click the Add to Analysis button.
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e. Your samples are added to the Ready-to-Analyze area.

Sample Pairs

Sample: Control:

Dema AmpliSeq CCP CNY

[}
Sample: Control:
Cemo Demo
AmpliSen AmpliSen
CCP TRy CCP TR
Case control
FReady to Analyze v

The Ready-to-Analyze area represents one separate analysis.
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6. Repeat this process for the set of samples for your second analysis:

a. Enable the checkboxes for the samples in your second analysis and click the
Add Samples button.

b. Your second set of samples are added to the placeholder area.

c. If necessary, swap the sample relationship with the swap icon
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d. In the text field above your samples, enter a name for this set of samples.

Click the Add to Analysis button.
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e. Your samples are added to a new Ready-to-Analyze area.

Sample Pairs

Reguired

Sample: - Control:

Add Samples

Dermo AmpliSeq CCP

m
Sample: - Control:
Demo Demo
Ampliseq Ampligen
CCF normal CCP tumor
Ready to Analyze v
Demo Amplisen CCP CRHY
m
Sample: - Control:
Demo Cemo
AmpliSen AmpliSeq
CCP TR CCP TR
Case control
Ready to Analyze v
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This new Ready-to-Analyze area represents a second separate analysis.

7. Repeat this process for every set of samples to be analyzed. You will have one
Ready-to-Analyze area for each separate analysis.

8. Check each Ready-to-Analyze area for the correct sample names and
relationships. When you are ready, click the Next button.

9. In the Plugin chevron, select any in-analysis plugin that you want to be included
in these analyses. (If you select a plugin, it is added to all of your analyses being
launched now.)

Note: In the Summary panel, "Samples: 2 pairs" refers to the two analyses.
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10. Click the Next button.

11. In the Confirm & Launch chevron, each analysis is named with the name that
you gave to the related samples.

12. You can rename your analyses. Click the Launch Analysis button.

13. Each analysis that is successfully launched is shown with a large checkmark.

Analysis ready to launch!

Review the selected options, name your analysis and then launch it

Analysis Name [ Demo AmpliSeq CCP CHNY example ]

(Demo AmpliSeq CCP CNV) «

Description: [ I

Analysis Name: l Demo Ampliser COP example ]

(Demo AmpliSeq CCPy 4

Description: [ l
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14. You are return to the analysis table.

Click on an analysis to see more details in the analysis details section on the
right.

Batch launch To use batch analysis launch, describe your analyses in a CSV file and upload that file
analyses in the Batch Launch Analysis page. Here is an example of the headings required:

Please read these notes about the use of the batch analysis CSV file:

* Download the example CSV file from the Batch Launch Analysis page download
example link.

m m Anabyses m

Launch IROrg = lon Reporter 4.0

& Batch Launch Analyses

The batch analysis launch page allows you to upload a set of analyses to launch in parallel | download example]. These analyses can cover any
combination of workflows . Learn more

Select file

¢ Each line defines a separate analysis.

* Order is important within an analysis entry.

e The first three of these fields are required:
type,workflow name, samples,plugins
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¢ In the Type column, if you are uploading fusions, please enter
"DNA_RNA_FUSION" for DNA and Fusions, and "SINGLE_RNA_Fusion" for
RNA only samples.

¢ The plugin field is optional (but the comma is still required).
e Thisentry: single,AmpliSeq CHPv2 single sample,Demo AmpliSeq
CHPv2 tumor, has the following meaning:
— single: This analysis uses a single sample.
— AmpliSeq CHPv2 single sample: The name of the workflow.
— Demo AmpliSeq CHPv2 tumor: The name of the sample.
— (blank field after the comma):No plugins are used.

¢ For multiple samples, use a colon to add the role to each sample name. For
example:

Demo AmpliSeq IDP Daughter:proband

IMPORTANT! Do not remove or edit the line t ype, workflow
name, samples, plugins. This line is required.

Follow these steps to batch launch a set of analyses:

1. Prepare your CSV file with analysis descriptions in the pattern "type,workflow
name,samples,plugins” as described above.

2. Log in to Ion Reporter™ Software and click on the Analyses tab.

3. Click on the Launch Analysis button and select Batch.

Launch Analysis =

hanual

Ea—
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4. Click the Select file button and upload your CSV file.

m m Anabyses m
IR Org = lon Reporter 4.0

Qverview Launch

@ Batch Launch Analyses

The batch analysis launch page allows you to upload a set of analyses to launch in parallel download example . These analyses can cover any

cormbination of workflows. Learn more..

Select file

5. Confirm that the correct file name appears in the display field and click the
Upload button.

6. Please wait while your file is verified and the analyses are created.

@ Batch Launch Analyses

The batch analysis launch page allows you to upload & set of analyses to launch in paraliel (download example). These analyses can cover any

combination of workflows. Learn more...

B launch_hatch_example.csv

Please wait while vour file is validated ..

7. If your analyses are created successfully, click the Start Batch Analyses button.

If the analysis creation runs into an error, a button appears to switch between analyses
that can be launched and analyses that got an error.

@ Batch Launch Analyses

The hatch analysis launch page allows you to upload a set of analyses to launch in parallel (download example). These analyses can cover ary

combination of workflows. Learn more..

Select file
Launchable analyses m
Line T Error details
number
Warkdlow grouping type is invalid

tumomormal AmpliSeq CCP tumor-normal pair,Demo AmpliSeq CCP tumortumor,Demo Amplis

eq CCP normalnormal null

154 lon Reporter™ Software 5.6 Help



Analyses in lon Reporter™ Software
Launch an analysis

The following describe an example of an analysis creation error:

& Batch Launch Analyses

The Errors button shows the CSV line that contains an error.

The batch analysis launch page allows you to upload a set of analyses to launch in parallel (download example). These analyses can cover any

combination of warkflows. Learn more..

Select file

Launchable analyses m

Line
number

Error details

tumomormal AmpliSeg CCP tumor-normal pair,Demo AmpliSeg CCP tumortumor,Demo AmplisS

eq CCP normalnormal,null

Wiorkflow grouping type is invalid

¢ The error message appears in the Errors Details section. In this case the workflow
sample group is incorrect. The CSV file contains tumornormal, while the correct
sample group name is paired tumor normal.

Click the Launchable analyses button to see analyses that were created correctly.

@ Batch Launch Analyses

The hatch analysis launch page allows you to upload & set of analyses to launch in parallel (download example). These analkyses

Select file
Launchable analyses Errors
Applicati G i
Hame ppiication rouping Workflow Samples Plugins
Type Tvne
Demo AmpliSeq CHPY2 turmor_1 385072725794 DA Single AmpliSeq CHPY2 single sample 1 T
Cemo AmpliSeq CCP CHY control_1 38507272584 DNA Pair I CE P e e 3

8

* You can click the Start Batch Analyses button to launch the analyses listed under
Launchable analyses, or you can correct the CSV file and upload it again.
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Rename analysis during Batch Upload

If you are uploading multiple analyses with a CSV file that contains duplicate analysis
names, the duplicate analyses are listed at the top of the table in red text. You can edit
the text to change the name of that analysis and proceed with your batch analyses
work.

1. If you find you have a duplicate analysis name during CSV upload, click on the
red text and change the name and click Enter.

2. You can now proceed with your batch analyses work.

Set table preferences

You can configure and save the columns displayed in the tables under the Samples
and Analyses tabs.

Under the Samples or Analyses tab, in the Overview screen, click Preferences and
select from the following options:

Select... To...

Table Preferences Select from a list of saved table preferences.

Save Table Save the selected column display under the current selected table
Preference preference name.

Save Table Save the selected column display under a new user-defined table
Preference As... preferences name.

Select Columns... Select from a list of available columns to display, including any

user-defined attributes.

Restore Defaults Restore the default table display.
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Set table preferences

You can set Table Preferences in Ion Reporter Software to show or hide the columns
in any table that lists samples or analyses, or summarizes other sample or analysis
information, such as Analysis Results. If you save a setting, it applies to all tables. If
you save a setting and name it, the preference is added a list of Table Preferences and
you can apply that setting at any time to any table. You can delete unused Table
Preferences.

In the Samples tab or Analyses tab, click Overview, then select a Analysis or an
Analysis.

e To save a Table Preference:

a. Click Preferences » Select Columns.

b. Select and deselect columns that in the Select Columns to add to Summary
dialog that you want to add or remove from the table. Click Apply.

* To create a custom table preference:

a. Click Preferences » Save Table Preference As.

b. Enter a name for the table preference and click Save.

c. Click another analysis.

d. Click Preferences » Table Preferences, then select the new Table Preference.
The analysis columns are modified as determined by the applied Table
Preference.

* To delete an unused Table Preference:

a. Click Preferences » Table Preferences, then select the Table Preference that
you want to delete.

The Table Preference is applied.
b. Click Preferences » Delete Table Preference.
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c. When you are prompted to delete the Table Preference, ensure that the dialog
refers to the preference that you want to delete, then click Yes.

The Table Preference is removed from the table.

Filter the analyses table

Tools for filtering analyses based on attributes are located under the Analyses tab in
the Overview screen.

* The Version and Workflow filters are available by default. Click each button
above the table to filter the list by analysis version and/or the workflows
associated with the analyses.
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Click More Filters to select additional filters from a dropdown list.

e Use the Find Filters field to search for filters in the list.

* Select the filter you want from the list. A button for that filter is added above
the table, and the filter is listed with a check mark in the More Filters list.

* To remove a filter button, click it again in the More Filters list to deselect it.

Each filter button you add to the table has different options to filter by, based on
the attributes of the analyses in the table. For example, the Analyzed On filter lets
you filter by ranges of dates when analyses were last performed.

Click each filter button you add to display a dropdown list of options.

* Select an option in the list to filter by that selection. The table will reconfigure
to list only the analyses that meet the filter criteria.

¢ C(lick a selected option again to deselect it and no longer filter by that option.
* Click Select All to select all the options for that filter.

e (lick Clear to clear the selections.

Click Clear All above the table to clear all selected filters.
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Delete an analysis

IMPORTANT! When an analysis is deleted, the action cannot be undone.

Follow these steps to delete an analysis:

1. Log in to the Ion Reporter™ Software, then click on the Analyses tab.

2. With the left column checkboxes, select the analysis (or analyses) in the table, and
then select Delete in the £ Actions dropdown list in the Details section.

3. Click Yes in the pop-up window to confirm that you want to complete the
deletion.

4. You are brought back to the analysis page and the analysis or analyses are
deleted.

160 lon Reporter™ Software 5.6 Help



Analyses in lon Reporter™ Software
Archive analyses

Archive analyses

If you have an Ton Reporter  local server, you can archive analyses to free up disk
space.

1. On the Analyses page, select the analysis you want to archive.
2. Go to Actions and click Archive or Archive with Samples. Note: You can only

archive the Analysis and the samples that were used by that analysis, if no other
analyses used those samples.

3. Click Yes to confirm you want to archive.

An Archive Qicon appears in the analysis row.
4. Toundo an archive, select the archived analysis and go to Actions » Restore.

5. To archive multiple analyses, select multiple and go to Actions button and select
Archive or Archive with Samples from the drop-down menu.
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Archival location New users and users upgrading from a previous version must specify a storage

must be specified location for archiving samples and analyses in Ion Reporter™ Software 5.4. Change
archivalMountPath=/tmp/ to archivalMountPath=/storage IP address/ in the
ionreportermanager/server/server.properties file, then restart the Tomcat server.

To check the data that you archived, go to the storage location of the archived data,
which is set up in /share/apps/IR/ionreportermanager/server/server.properties file as
archivalMountPath.

Monitor analyses

You can actively or passively monitor your analyses.

1. To actively monitor, go to the Analyses » Overview page and check the Status
column.

Your analysis will be reported as Pending, % complete, Successful or Failed.

2. To passively monitor, check your email. Ion Reporter™ Software sends an email
when your analysis is complete (success or failure).

Reanalyze an aborted analysis

You can reanalyze the results for an analysis run that has been aborted.

1. Inthe Analyses tab, select an analysis of interest that has a status of Aborted.

2. Click Actions » Reanalyze.

162 lon Reporter™ Software 5.6 Help



Analysis results

This section describes how to sort and display your analysis results. Analysis results
are displayed under the Analyses tab in the Overview screen. Click on an analysis in
this screen to display the results.

Review and interpret your DNA analysis results

To access the results of your DNA analysis:

1. Signin to Ion Reporter™ Software, then click Analyses.

2. Click on the name of your analysis in the Analyses list.

@ Analyses

Filter Analyses - Search < Refresh

[] « & |Analysis Stage Created On v Status

0O 16sQC_195ep2013_reanalysis_1385163543070 Wariant Review Moy 22 2013 03:39 PM Successful

16s¥cont_hi doo_21Mov2013_138514848609

O . SO TG L A Variant Review Nov 22 2013 11:23 AM Successiul

0O MATZB7E_1385107715290 Analysis Moy 22 2013 12:08 A Running - 12%
| Demo AmpliSeq Exome YCF_13850849153500 Interpretation Assignment Moy 21 2013 08:35 FM Successful

0O Demo CCP paired Pubs Interpretation Assignment Moy 21 2013 0512 FM Successiul

0O 1BsKIQC_20Mov2013_1385077578722 Wariant Review Moy 21 2013 0346 PM Successful

0O 16skKIGC_12Mov2013_1385076351047 Wariant Review Moy 21 2013 0326 PM Successful

O ?em Metagencmics Mock Communib_13850729320 |, ot eview Nov21 20130228FM  Successful

0O MAT2B7E Trio_1383846031285 Interpretation Assignment Moy 20 2013 08:38 FM Successful

0O Dermo AmpliSey Exome WCF_1 384954367082 Report Generation Moy 20 2013 0439 PM Successful

This action opens the analysis in edit mode.

Note: You cannot review analyses that are still running.
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To review your DNA analysis results, use any of the following tasks:

Purpose Your action

Display different data and annotations Click one of the
following options
above the variants
list:

e Summary

¢ Functional

¢ Population

¢ Ontologies

¢ Pharmacogeno

mics
¢ Somatic
e QC

The first few
columns are the
same for each
option. If necessary,
use the horizontal
scroll bar under the
table to see all the

columns.
View a variant's detail card Click the detail icon
[E for the variant.
View the original source of annotation Click on a blue link
information in the Genes column

or the Variant
Details card. The
links opens to a
public database that
contains the variant
(such as OMIM or

COSMIC).

Filter variants See “Filter
variants” on
page 197.

View the variant in IGV Click on the variant

position link in the
Locus column.

See “Visualize other
analyses with lon
Reporter™
Software” on

page 268.
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Purpose

Your action

Compare the results of multiple samples

Select multiple
analyses in the
Analysis Overview
tab, and select
Actions » Visualize.

Add a variant to the My Variants annotation
source

Enable the checkbox
for the variant, then
click » Important

The selected
variants (with flags
now in orange) are
added to the My
Variants annotation
source.

See also “About the
My Variants flags” on
page 172.

Remove one or more variants from the My
Variants annotation source

Click the flag menu
in the My Variants
column and click the
None option.

Or, enable its
checkbox and click
Remove from My
Variants in the
Selected Variants
menu.

See also “About the
My Variants flags” on
page 172.

Search variant information

See “Search on the
Analysis Results
list” on page 167.
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Purpose Your action

Hide variants Enable the
checkboxes for the
variants to be
hidden, click the
Selected Variants
menu, and click
Hide.

| of Selected Variants = I

23 s

Add to My Variants

Hidden variants do
not appear in the
Analyses list.

Display hidden variants In the Filter Options,
click Hidden
Variants link.

Filter Options x

Variants

o Filtered In Variants (4143)
« Hidden Variants (5)
* Filtered Outvariants (24)

Restore hidden variants Under Filter
Options, click
Hidden Variants.

Enable the
checkboxes for the
variants that you
want to restore, then
click Selected
Variants » Add /
Remove from
MyVariants List,
then optionally add
or change the flag
for the variant, then
click Confirm.
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Purpose Your action

Send to the Report Role After you filter out
unwanted variants,
click Send To Report
Role for

interpretation.

Read the
consequences in the
confirmation box:
you cannot edit the
analysis or filter its
variants if you send it
to a Report Role.

Send to Report Role

Do you veant o send this analysis "Demo CCP paifed Pubs” for report generation? After
confirming, itwill be sent to the report rales in your|organization

Cancel Send

If you agree, click
Send

Click the Back in the
browser to return to
the Analysis
Results.

Leave the Analysis Results page

Note: The Allele Coverage column reports counts for all reported alleles, not only
genotype alleles. In contrast, the Allele Read Count filter sets the minimum count of
the genotype alleles.

Most searching is better done with filters, rather than with the search field. For most
searches, use a filter instead.

Searches of analysis results can be performed in the Variant Review page using a
controlled vocabulary query language. This allows more advanced searches,
including OR and AND searches than is currently possible using filter chains. This
feature is available in both a single-analysis variant review table and a multi-sample
visualization table. However, the feature has only been tested on the single-analysis
variant review table.

Filter terms

Notation Meaning

key:value1,value2 key=valuel OR key=value?

key:[min,max] min <=key <=max

key:(min,max) min < key < max

key:[min,] min <= key
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key:[,max] key <= max
key:(min,) min < key
key:(,max) key < max
key:value* key contains value
key:* key exists (key has any value)
-key:value key !=value
The following keys are supported:

Key Example

locus chr2:123456
function missense

location exonic

cosmic, omim, pfam, drugbank, go glioma

dbsnp rs12345

gene, transcript TP53, NM_01010.1
maf [0.0,0.05]
coverage (10007

sift, polyphen, grantham ['0.05]

type INDEL

comment something*

vkb *

Search field behavior is different here on the variant table in the Analysis Results
page, than for searches on other pages.

"vbk" in the table above stands for My Variants.

Asterisks (*) for some variant table searches on the Analysis Results page
* An asterisk (*) in the search field is only allowed on the Analysis Results page.

* An asterisk (*) is required for some searches here, but is not allowed for other
searches. The differences are due to how the different types of information are
stored.

* The asterisk is a search wildcard. Without the asterisk, searches only match the
exact string entered. With asterisks both before and after your search string,
matches at the beginning, middle, and end are all found.
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Recommended search with asterisks

® Asterisks are useful to search for matches in any annotation source. (By contrast,
a filter search matches only one annotation source.)

e This example shows a search for *carcinoma®.

This search lists all variants that have an OMIM, COSMIC, ClinVar, DrugBank,
and so on, annotation that contains "carcinoma" anywhere in the annotation.
Click the detail icon [E] for one [N of the matched variants to open its variant
detail card. Scroll down to fine the entries that contain "carcinoma".

Variant Details: chr1:881627

Variant Details Motes

Annotation Source Annotation Value
AMAF 01562

Allele Coverage G=5 A=176E

Allele Ratio G=0.03, A=0.897
Amino Acid Change Wi

COSMIC adengcarcinama

Searches without asterisks

¢ To search for a locus, enter the complete locus entry, with chromosome number
and full position number.
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e Do not use an asterisk (*) for a locus search. Searches on a chromosome number
by itself or with a partial position number also are not supported.

e For other information, use a filter.

e Search terms within a filter chain also do not allow an asterisk.

Create Filter Chain

Mame Description
Sene Ontology b
keratin Search

Value

keratinization
keratin filarment

keratinocyte differentiation

O 0O 010

Examples

[ ]
(gene:TP53 OR (function:missense,nonsense AND (maf:

[0.0,0.05} OR -dbsnp:*))) OR type:CNV

This retrieves all variants that fall in TP53, all CNVs, plus variants that have a
functional impact of missense or nonsense AND either have a minor allele
frequency less than 0.05 or are noval (not found in dbSNP).

cosmic:carcinoma* AND ((type:SNV AND sift:[0.0,0.10]) AND
coverage: [300,] OR locus:chrX

This retrieves all SNV variants annotated with COSMIC histology terms
containing "carcinoma" with a deleterious SIFT score ( <0.10) and high coverage(>
300), plus any variant that falls on chromosome X.

Add or edit a note 1. Inthe Analysis Results screen, click + or ¥ in the Variant Details column
to a variant (second from the leftmost column).
Note:

- The + icon indicates that the variant does not have any notes that are
associated with that variant.

- The ® icon indicates that the variant already has a note that is associated with
that variant.

The Variant Details screen appears.
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2. Click Notes.
A new Variant Details screen appears.

3. Enter the note in the Note text textbox.

4. Click Add Note.
* You are returned to the Analysis Results screen.

¢ If the variant previously did not have a note that is attached, the icon
changes from + to @ .

View note Variants with notes attached, display ® in the Variant Details column (second from
attached to a the leftmost column).
variant In the Analysis Results screen, click @ in the Variant Details column for the variant

of interest.
The Variant Details screen opens. Notes can be viewed in the Variant Details screen.

Links to external databases

In the following cases, the links to external databases that are included in the
Analysis Results can lead to database pages that are not specific, contain an error, or
are blank.

e The 5000 Exomes database link in Ion Reporter™ Software uses gene information.
Because the 5000 Exomes site does not provide a unique identifier for each
record, if the website does not have specific information about the gene of a
variant, the link in Ion Reporter™ Software leads to a blank page. In this case, try
to search for the rsID of the variant on the 5000 Exomes site. (Not all 5000 Exomes
records contain rsIDs.) This image shows example 5000 Exome links in the
Population tab of the variant table:

Summary Functional Ontologies Pharmacogenomics Somatic Qc Search
Genotype Ref Type Gene dbSNP MAF EMAF AMAF GMAF | UCSC Common SNPs
334 T G SHY SAMD11 rs4072383 0493 WES
220 cm (o3 Sy SAMD11
a2 TC T Sy SAMD11
489 GIG A Sy SAMD11 rs4372192 0082 |00623 01167 00807 | YES
714 GIG c SHY SAMD11 rsBEDA0RR 0106 WES
723 TG T SHY SAMD11 (2}
238 GIG A SHY SAMD1T (2) rs3748592 0ny? WES
327 iR G Sy NOC2ZL 152272757 0,473 03621 01562 04748 | YES
325 GIG A Sy MNOCZL rs4970378 oo 0.0000 0.0005 00002
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e When a ClinVar annotation does not have a CLNACC ID associated with it, the
annotation string is "untested" and the link leads to a generic ClinVar page
instead of to the specific variant page.

¢ Some COSMIC records' link-outs may no longer be displayed on the COSMIC
website. In such cases, the link-out leads to a generic COSMIC page that displays
"no entry found".

About the My Variants flags

172

The My Variants flags store information about specific variant positions (loci) in the
My Variants database (formerly known as VariantKB).

You can view and export My Variants annotations in reports. As you analyze and
create reports, you can view the list of variants in the My Variants screen under the
Analysis tab. You can see the flag status, locus, and overlapping gene(s) of each
variant in My Variants. You can see additional details for each variant such as the list
of analyses in which the variant was called. You can also click through the list of My
Variants and search on the list of My Variants.

Note: Parameter settings for the Hit Level in the My Variants database are
deprecated. For instance, the attribute gene does not work.

There are three options for the My Variants flag:

* None: Removes current flags and removes the variant from your My Variant's
annotation source.

¢ Important: Adds a variant to the My Variants annotation source marked as
Important.

¢ Ignore: Adds a variant to the MyVariants annotation source marked as Ignore.

My Variants flags affect analyses in the following ways:

* Appear in all analyses in your organization:These flag settings affect all of your
analyses, including completed analyses. For example, if you set a variant as
Important, then open a previous analysis that includes that variant, the variant is
flagged as Important in the Analysis Review page.

* Appear in other users' analyses: These flag settings affect all analyses in your
organization (not just your own analyses).

* Supports only one setting: The last setting of the My Variants flag takes effect for
that variant in all your organization's analyses.

Note: If multiple people in your organization use the My Variants flag, it is
possible for inadvertent conflicts to happen. For example, one person could set a
variant as Important and another person, reviewing a different analysis, could set
the flag to Ignore for the same variant. In this case, only the last flag setting is
kept in Ion Reporter™ Software. More importantly, the difference of opinion
between the two reviewers is lost. If it is important for your organization to keep
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a record of decisions about a particular variant, consider using the My Variant
Notes to manually record the following information about the flag when a setting
is reversed or undone.

¢ In a deleted original analysis: If you delete the analysis in which you originally
flagged a variant, its My Variants status is not affected.

You can add notes to My Variants to explain why a variant is flagged as important, or
flagged to be ignored. You can also use the My Variant Notes to record information
about a flag when a flag setting is reversed or undone, if it is important for your
organization to record decisions about why a flag was changed.

Note: These notes are seen only within the analysis in which the notes were
originally entered.

1. Click the detail icon [£] for the variant to open the Variant Details card, then click
the Notes tab.

2. Enter text for the note, then click Add Note.

The Notes field automatically records the date and your login ID when you add
the Note.

A Classification column is now visible on the My Variants list. Variant classifications
can now be viewed in different analyses. Classifications include: Unclassified,
Unknown, Benign, Suspected Benign, Deleterious, and Suspected Deleterious.

You can view notes about variants in the My Variants Notes section. Click on the
notes tab of the details cardfE] to view notes for the My Variants.
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To remove a flag from a variant, right-click on the flag and select None. The flag will
be removed when you refresh your screen.

In addition, links in the Analysis Name and Sample Name columns link to analyses
and samples that contain the variants.

View and export You can now view and export all favorite variants, that is, those flagged Important or
My Variants Ignore in reports.
annotations 1. Under the Analyses tab, click My Variants to open the list of variants.

2. Click My Variants, then select Show All, Important, or Ignore.

3. Click Export TSV .
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4. When the download is finished, a myvariants_results.zip file is downloaded in

the browser. Open or save the file to your hard drive.

The TSV file contains the information for each variant such as Locus, Gene, Type,

Flag Type, Analysis Name, and so on. You can also view additional details for

each variant such as the list of analyses in which the variant was called.

Note:

- When flagging a variant from a paired-sample analysis, the variant from the
primary sample (not control) is picked and stored in the My Variants database.
If there is no explicit call at the location in the primary sample, then nothing

gets added to the My Variants database.

- Sorting on the Gene(s) column factors for each gene in a multi-gene result.
Therefore the order of the genes in one row is by chromosomal order, not

alphabetical order.

- My Variants from analyses in Ion Reporter™ Software 4.6 and later show all
details correctly in the My Variants table (comments, analysis/sample names,

™

and so on). Full details might not appear in Ion Reporter™ Software 4.4 and

earlier analyses, due to backward incompatibility.

The variant fields that are examined to evaluate whether a variant is already present

in a My Variants database are the following:
¢ Chromosome number
® position
* end position
* variantid
¢ ncbi (for GRCh38)
e chr_type (for GRCh38)
* CNV subtype
* observed allele
* genotype
e fusion 3' breakpoint

* fusion 5' breakpoint

VariantDB is an annotation source preset used during workflows to annotate analyses.

VariantDB is not designed to be dynamically updated and changes made to its

contents will not impact previously-run analyses. My Variants flagging functionality
provides the ability to dynamically annotate variants as "Important” or "Ignore" for

analyses which have been run previously, and those flags are stored and will be

applied in future analyses until removed with the "None" flag.

CNV subtypes in the Analysis Results screen

Some CNV subtypes in the Analysis Results screen are specific for Oncomine™

research assays. See your Oncomine™ assay user guide for more information.
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Known common
CNVs

CNV variant filter

CNV variant
information
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CNV variants should be interpreted in light of a resource, such as the
Database of Genomic Variants, that contains known common CNVs.

This database shows where common and (usually) non-pathogenic CNVs often occur
in various populations. When you design amplicons to detect CNVs, avoid putting
amplicons in regions that contain many common variants. Amplicons in these regions
tend to indicate common non-pathogenic copy number variants that are based on
population differences rather than on pathogenic events.

For germline analyses, select the filter "Confident Germline CNVs - CNVs Only". This
filter is not automatically applied as a default. Save the filter chain in an Analysis
Results page for the filter to be the default filter for that analysis.

The Copy Number and CytoBand information for a CNV variant appear in the
Summary tab of the variant table.

The Confidence and Precision scores appear in the variant detail card.

Variant Details: chr1:12979841

Variant Details Hotes

Annotation Source Annotation Value
CHY Confidence 0
MY Pracision 22T TR

(Click the detail icon [Z] for the variant to open the variant detail card.)
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The Median of the Absolute values of all Pairwise Differences (MAPD) score is
reported on Aneuploidy analyses and other analyses that detect CNVs.

MAPD is one of the metrics that we define to assess whether the panel data is useful
for copy number (CN) analysis.

MAPD is defined as the Median of the Absolute values of all Pairwise Differences
between log2 ratios per tile for a given run. Tiles roughly correspond to amplicons in
an Ion AmpliSeq™ assay. Each pair is defined as adjacent in terms of genomic
distance. Tiles corresponding to Copy Number amplicons and other amplicons are
being treated equally as no differences in variability are seen between these types.
Then, any two log2 ratios that are adjacent on the genome are a pair. Except at the

beginning and the end of a chromosome, every log2 ratio belongs to two pairs.

Formally, if xi is the log2 ratio at position i, with i ordered by genomic position:
MAPD = median ( | x(i - 1) - x(i) | )

MAPD is a per-sequencing run estimate of copy number variability, similar to
standard deviation (SD). If one assumes the log2 ratios are distributed normally with
mean 0 and a constant SD, then MAPD/0.95 is approximately equal to SD. However,
unlike SD, using MAPD is robust against high biological variability in log2 ratios
induced by known conditions such as cancer.

Regardless of the source of the variability, increased variability decreases the quality
of CN calls.

Note: MAPD is not shown on the QC Report.
For aneuploidy analyses, the ratio of mitochondrial(chrM) DNA read counts to

autosomal (chr1-22) DNA read counts is reported.

The coverage tracks in the IGV browser visualize mosaic data whether or not a copy
number gain or loss is called in the region.
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This information serves two purposes:

e Confirms that the data supports the ploidy calls made by Ion Reporter™ Software:
The colored tile data appears on or very close to the called ploidy change.

¢ Helps identify mosaic copy number changes that are not called as a ploidy
change:
Non-integer copy number changes are apparent in the colored tile data as a
cluster of tile coverage ratio data that is consistently a little above or a little below
the gold ploidy line.

Notes about CNV and ploidy visualization in IGV:

* The red lines represent regions of copy number loss. The blue lines represent
copy number gains.

¢ The gold line in the Coverage Ratio track gives the ploidy call made by Ion
Reporter™ Software.

* The colored data points around the gold line are the coverage ratio signal
intensities for the individual Amplicon Designer tiles as expressed in ploidy
space. These data points are the raw tile data.

¢ Both the Coverage and Coverage Ratio tracks present mosaic data.

* Notes about the Coverage Ratio track:

— This track has coverage overlaid on ploidy calls to show the data supporting
the ploidy calls.

— This track’s data scale is less compressed than the scale of the Coverage track.

— This track plots the estimate of the most likely copy number (the raw copy
number without rounding) of the test sample at this tile, given only the
coverages at this tile.

The IGV Coverage tracks contain coverage data that is not available in either the
variant detail or the variant table. This data is available in the workflow output files
and can be exported. (This applies to the aneuploidy workflow and to the single
sample workflows, paired workflows, and tumor/normal workflows that support
CNV calls.)

Note: IGV assumes that a sample's gender is female, if the sample's gender is not
specified or is specified as "Unknown".

Starting with the Ion Reporter™ Software version 4.2, the Aneuploidy workflow will
make a call as to the gender of the sample (Male or Female) base on the presence or
absence of a Y chromosome. This call does not overwrite an user-entered gender
information. The Called Gender is used to determine the expected ploidy of the sex
chromosomes in the sample and to report aberrant Copy Number variants. The 4.0
versions of the Aneuploidy workflow will have sex chromosomes called according to
the table below.
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This table shows how the user-assigned gender of the control and test samples affects

™

CNV calling restrictions in Ion Reporter™ Software. These rules apply to the single
sample workflows, the paired workflows, the tumor/normal workflows, and the 4.0

Aneuploidy workflow.
Test sample Control sample CNV calling restrictions

Male Male Call CNVs on all
chromosomes

Male Female Do not call CNVs on the Y
chromosome

Female Female Do not call CNVs on the Y
chromosome

Female Male Do not call CNVs on the Y
chromosome

Unknown Female, Male, or Unknown Do not call CNVs on the X or
Y chromosome

Female, Male, or Unknown Unknown Do not call CNVs on the X or
Y chromosome

Copy number state and confidence scores on X and Y chromosomes are determined
relative to the gender of the control sample. For example, the expected ploidy of X for
a male control sample is 1. If the test sample also has 1 copy of X, the confidence score
for a CNV will be 0, since there is no evidence of an unexpected ploidy state.

If most or all test samples report a CNV in the same region, one possible cause is that
the control sample actually has a CNV in that region (leading to unexpected results).

Germline Copy Number variant calls involve the following scores:

¢ Copy number -- The predicted copy number for the region.

* Confidence -- The log likelihood that the called copy number state is not normal
ploidy, i.e. 2 on autosomes (reflects the likelihood of the region's ploidy number
being different than the normal ploidy 2).

¢ Precision -- The log likelihood that the called copy number state is different than
next closest copy number state (reflects the likelihood that the precise ploidy

number is correct).
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Note: Confidence and Precision scores appear in the variant detail card.

Variant Details: chr1:12979841

Variant Details Hotes

Annotation Source Annotation Yalue
CHY Confidence 0
CHY Precision 22T TR2

Click the detail icon [Z] to open the variant detail card.

Note that the algorithm can call a ploidy variant with good confidence in the variant
(a high confidence score) but without confidence in the called ploidy number (a low
precision score), especially for high ploidies. For example, a ploidy variant with copy
number 5 might have high confidence but low precision. These scores mean that we
are confident that the ploidy is not 2, but we also are not confident that the ploidy is
exactly 5.

IMPORTANT! Ploidy results depend on the correct gender attribute being assigned to
the input samples.
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Copy Number

The Copy Number value gives the predicted number of chromosomes for the variant
region. The column appears in the variant table (on the Analysis Results page)

Note: The maximum copy number that we report for a variant is 10. A copy number
value of 10 is interpreted as copy number 10 or higher.

The length of the affected region is also given (in the Length column).
Precision

The Precision score reflects the likelihood that the stated copy number number is
correct. This score is expressed as the log likelihood of the copy number number.

The precision is defined as the likelihood determination of the assigned copy number
state and a state that is closest to it. Small precision denotes the uncertainty in the
absolute copy number value assignment. Quite often high copy number states have a
low precision and high confidence, indicating that the algorithm is uncertain about
the absolute copy number value (N or N-1 or N+1), but quite certain about the
existence of a copy number state that is different from the expected copy number (N !
=2 for expected diploid region).

Note: The expected copy number states are set from the customer-specified gender of
the sample. Gender defaults to male if unknown. Correct scores depend on the gender
of the input samples being correctly specified.
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Confidence

The Confidence score describes the likelihood of the region's copy number number

being different than the normal copy number 2.

The Confidence Score appears in the variant detail card.

Variant Details: chr1:12979841

Variant Details Hotes

Annotation Source

Annotation Yalue

CHY Confidence

CHY Precision

0

227762

This list describes the confidence score:

A confidence score of 0.0 indicates copy number 2.

Variants with a higher confidence score are more likely to be true positives.
Variants with lower scores are less likely to be true variants.

A confidence score of 10 or 20 or higher indicates a high quality copy number

variant.

True copy number variants might still have a low confidence score if the data is
noisy, if the variant region is short, or if coverage is low.

The confidence score addresses the likelihood of the copy number number being
different than normal. The confidence score specifically does not predict that we

know the correct copy number number.

Confidence is defined as the likelihood determination between the called copy
number state of the segment and the expected copy number state. Confidence is small
for segments that have copy number state likelihood close to the expected copy
number state likelihood. A high confidence score means that the algorithm is very
certain that there is a copy number state that is different from the expected.
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CFTR analysis results

Review the following examples for information about how to review data in the
analyses results from CFTR workflows:

* The Variant Name column reports matches with the Named Variants annotation
source.

¢ The following IGV visualization for CFTR analysis results include tracks for long
deletions:

¢ The following IGV visualization for CFTR analysis results include a named
variant:
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The following IGV visualization for CFTR analysis results include a hotspot
position:
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Hover the mouse over a position in the IGV visualization to view details such as

the following:

ﬂ

Position: chr?, 117199533
ID: M470Y

Reference: G¥

Alkernate:; [A]

Qual; 100

Twpe: SHP

I= Filkered Cut: Mo
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&0 445 FSAF: 254
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Cuality: 99
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1= Filkered Out: Mo
Minar Allele Frackion: 1
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Mon Variank: 0
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-Het: 0
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Note: The factory-provided CFTR workflow includes long deletion detection. You
can copy/edit the CFTR workflow and preserve long deletion detection. If you create
your own CFTR workflow (even with the CFTR regions file), your workflow includes
the standard Ion AmpliSeq™ workflow template and does not include the long
deletion detection module.

Allele calls for hotspot positions

For hotspot positions, sometimes an allele with zero coverage is reported in the Allele
Coverage and Allele Ratio columns of the Analysis Results table.

This is by design and occurs only with hotspot positions. For hotspot positions, the
results table reports all alleles that have any evidence in either basespace or in
flowspace. Alleles with zero coverage appear in the results table for a hotspot position
if the second alternate allele has non-zero reads reported in basespace (even though
zero reads are reported in flowspace).

Phred QUAL Score

Phred quality score column is added to the Analysis Results.
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Visualize results of single or multiple analyses

You can visualize results for single analyses, or compare the results of multiple
analyses. Multi-analysis visualization supports the following views, depending on
workflow type.

¢ Table view, with side-by-side columns to compare variant calls in different
analyses:

® Variant Impact heat map that is based on the predicted variant impact:
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Variant Impact heat map that is based on other scoring:

* Gene Fusions heat map:
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* CNV heat map:

e RNA Exon Variants:
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Note:

- In most cases, you will compare similar analyses. However, Ion Reporter  Software
does not restrict comparisons to only similar analyses.

* You can compare one trio or one paired analysis without selecting multiple
analyses. Each trio or paired analysis contains more than one set of variants.

+ Hover over the legend of a heat map:

Hover over the legend of a cell to see more information:
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Visualize Multiple The following attributes are used to compare what variants fall in the intersecting
Analyses with areas versus the non-intersecting areas of the Venn diagrams for the different tabs in
Venn Diagrams the Visualize page. If these attributes of the compared samples' variants are the same,

they are considered "common" and add a count of 1 in the corresponding samples'
intersecting area. Otherwise, they are considered different and add a count of 1 to
each of the sample's non-intersecting areas.

Main Variant Table variant chromosome + start position + end
position + optional fusion ID

Variant Impact Heatmap gene symbol

CNV Heatmap gene symbol + CNV chromosome

Fusion Heatmap fusion 5" breakpoint chromosome + pos +
fusion ID

Therefore the counts in the Venn diagram (as well as the counts for the Total, Filtered-
In, and Filtered-Out) represent the following:

* Main Variant Table: number of unique variants

e CNV Heatmap: number of unique genes (genes with same name but on different
chromosomes are treated as different)

¢ Fusion Heatmap: number of unique fusions

Note: If you edit an analysis and concurrently try to view it on another page, a
negative filtered-out count may occur. Perform these tasks consecutively.

Compare multiple Follow these steps to compare multiple analyses:
analyses and
download TSV file

1. In the Analysis > Overview tab, select multiple analyses.
2. (Optional) Use the Filter Applications menu to view only analyses of interest.

3. In the Actions menu on the right, select Visualize.
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4. All results are shown initially.

10.

Click the numbers in the Venn components to toggle for inclusion.

Then use the Filter button to update the results to include only toggled
components.

Use the Clear button to deselect all Venn components.
When no components are selected, no Venn filtering is performed.
Hover over a sample name to see the analysis to which it belongs.

To download the results, go to Download » Current Results TSV.

The software outputs a zipped TSV file of all the analyses for comparison.

Clustering in CNV heat map For CNV heat maps, ploidy is used as the score for
every gene-sample pair to generate the heat map. Thereafter hierarchical clustering is
conducted for clustering genes and samples within the heat map.
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Note on the Variants Table view

The contents of the Samples column vary by variant type:

SNVs and indels: Genotype
CNVs: Cytoband
Fusions: Presence or Absence detection call

Restrictions on analysis selection

Comparison and visualization are not supported for Metagenomics analyses. If
one of these is among the analyses selected, then the Visualize option is not
available in the Action menu.

If a Failed or In-Progress analysis is among the analyses selected, then the
Visualize option is not available in the Action menu.
If only one set of variants is selected, the Visualization option is not available:
— Trio and paired analyses each contain more than one set of variants. These
analyses support visualization one a single trio or paired analysis.

— A tumor-normal analysis has only one set of variants and does not support
visualization. (A tumor-normal analysis reports only the set of variants for
the tumor sample, not the set of variants for the normal sample.)

Variant Impact tab The legend at the top of the heat map is color-coded for the following variant impacts
using the associated score values:

unknown: 0

synonymous: 1

missense: 2

non-frameshift block substitution: 3
non-frameshift insertion: 4
non-frameshift deletion: 4
nonsense: 5

stop-loss: 6

frameshift block substitution: 7
frameshift insertion: 7
frameshift deletion: 7

splice variant: 8

Set the Scoring menu to a different option, such as SIFT or PolyPhen2, to base the
legend and the heat map on those scores.

Clustering in Variant Impact heatmapFor variant impact heat maps, based on the
scoring criteria selected from chart options, most deleterious score is picked for every
gene-sample pair to generate the heat map. Thereafter hierarchical clustering is
conducted for clustering genes and samples within the heat map.
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Chart options Set the Scoring menu to a different option, such as SIFT

or PolyPhen2

, to base the legend and the heat map on those scores.
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Set the Sample Order menu to base the presentation order of the sample on name or
on their similarity in terms of variants found.

The following ordering options are supported:
¢ Name: Alphabetically by sample name

e Similarity: By how similar the samples are in the fusion calls made (presented
from fewest fusions to most fusions)

¢ Similarity (reversed): By how similar the samples are in the fusion calls made
(presented from the most fusions to the fewest fusions)

* Analysis: Alphabetically by analysis name

Set the Color Scale menu to a different option, such as SIFT, to base the legend and the
heat map on those colors.
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How to export heatmaps

Use the Export Heatmap menu to download your heatmap.

The supported download formats include PNG, SVG, and comma-separated file. This
works best in Firefox, Chrome and Safari browsers.

Filter impact on If you save your filter chain on the Analysis Results page, then the heat maps and

the variants other multiple analysis visualizations show only filtered in variants.

displayed in heat If you do not save your filter on the Analysis Results page, then the heat maps and

maps other multiple analysis visualizations show only the entire result sets (nothing is
filtered out).
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Filter variants

With filters, you change which variants are displayed in the variant table or remove
variants that are not likely to be relevant to your research. You filter out uninteresting
variants when you save your filter chain.

Note: The data in the backend can contain more significant digits than the data that is
shown in Ion Reporter™ Software. Therefore, to capture all intended data, you can add
an extra digit to threshold values when you filter data.

Shipped filters The following filters are shipped with Ion ReporterTM Software. Several of these filters
are automatically applied when an analysis is first opened.

Note: Filters that are automatically applied to a workflow the first time you review
the Analysis Results screen Ion Reporter  Software are referred to as default filters in

this guide.

Filter name Description

CNV Somatic Confidence - CNV Includes 5%
Confidence Interval
Range and 95%
Confidence Interval
Range.

Default Variant View Filters in DNA

variants SNVs,
indels, MNVs, long
deletions, and
confident CNVs
(which are germline
Copy Number
variants with a
Confidence value >=
10).

Default filter for the
AmpliSeq Exome
single sample (both
Germline and
Somatic), TargetSeq
Exome v2 single
sample, AmpliSeq
CHPv1 tumor-
normal pair,
AmpliSeq CHPv2
tumor-normal pair,
AmpliSeq CCP
tumor-normal pair,
AmpliSeq Exome
paired sample,
AmpliSeq CCP
paired sample, and
Low-pass whole-
genome aneuploidy
workflows.
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Default Fusions View Filters in all of the
following:

e FUSIONS
variants that are
detected as
Present

o All
EXPR_CONTRO
L markers

o All
ASSAYS bHP 3P
markers

Default filter for the

AmpliSeq RNA Lung
Fusion single sample
workflow.

Default DNA and Fusions View Filters in all of the
following (a
combination of
Default Variant View
and Default Fusions
View]:

e FUSIONS
variants that are
detected as
Present

o All
EXPR_CONTRO
L markers

o All
ASSAYS HP 3P
markers

e DNA variants of
all types

Default filter for the
Ampliseq Colon
Lung v2 with RNA
Lung Fusion single
sample workflow.

Genetic Disease Variants Filters in
genetically-relevant
variant types such as
IsNewlyHomozygous
NonRef,
HasUnknownX, etc.

Default filter for the
AmpliSeq Exome trio
and AmpliSeq IDP
trio workflows.
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Homopolymer Length A range filter that
only applies to
indels. Default range
is 0 to 1000,
including
boundaries.

AmpliSeq Exome Tumor Normal v1 Filters in both of the
following:

e AlLCNVs

¢ Confident
somatic
variants with
the following:

- Allele Ratio
between
0.1and 1.0

- Allele Read
Count
between 4
and 100000

- PValue
between 0
and 5.0E-6

Default filter for the
AmpliSeq Exome
tumor-normal Pair
workflow.

Confident Germline CNVs - CNVs Only For germline
analyses, filtersin
Copy Number
variants with a
Confidence value >=
10.

Not a default filter.

Variant Classification Filters on
classification
options: unknown,
benign, suspected
benign, suspected
deleterious, and
deleterious.
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Notes:

* To see the results without a filter applied, set the Filter Chains menu to No Filter.

¢ If you or another user save a filter setting, the next time the Analysis Results page
for that analysis is opened, it opens with that filter.

Use filter chains Open an analysis:

1. Sign in to Ion Reporter™ Software, then click on Analyses.

2. Click on the name of your analysis in the Analysis list:

A list of variants opens in the Analysis Results.
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Use quick filters The Chromosome menu

Use the Chromosome menu to restrict the displayed variants to only those called in
one chromosome:

1. Click the Chromosome menu and select the chromosome of interest.
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2. Notice that the number of Filtered In Variants changes to reflect only those in the
selected chromosome. Because variants called in other chromosomes are
considered to be "not displayed", as opposed to "filtered out", their variant totals
are not added to the Filtered Out Variants.

Filter Options x

Variants

Filtered In WYariants (1445) I
« Hiddenariants
+ Filtered OutVariants (22

Samples
[] Control: Demo AmpliSeq CCP normal

[] Sample: Dermo AmpliSeq CCP turmor

Filter Samples

Chromeoseme

149 -

Filter Chains

Default Yariant View - [

Total Variants: 4172

1000 == ChY
Confidence Range
==1.0E7

Yariants: 4143 Genes: 382
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3. Compare with the totals when the Chromosome filter is not used.

lon Reporter™ Software 5.6 Help

Filter Options x

Yariants

+ Filtered In Variants (4148)
+ Hidden Variants
« Filtered Out Variants (24)

Samples
[] Control: Demao AmpliSeq CCP normal

[] Sample: Demo AmpliSey CCP turmor

Filter Zamples

Chremeseme
All -
Filter Chains
Default Yariant View - [

Total Yariants: 4172

10.0 == CHY
Confidence Range
==1.0E7

Yariants: 4143 Genes: 382
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The Sample checkboxes

This filter is available only with the paired samples workflows. Use this filter to
display only those variants that are called in the test sample and do not appear in the
control sample:

1. Click the Sample checkbox to enable it. Leave the Control checkbox not enabled.

Filter Options x

Variants

+ Filtered InVariants (4148)
+« Hidden“ariants
+ Filtered Qutvariants (243

Samples

[] Control: Demo AmpliSeq CCP normal

I

Sample:[Demo AmpliSeq CCP tumaor

Filter Samples

)

Chromosome

Al -

Filter Chains

Default Variant Wiew - k

Total Wariants: 4172

10.0 == TR
Confidence Range
==1.0ET

Yariants: 41483 Genes: 382
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2. The Filtered In Variant total changes to the number of variants that are in the
Sample (test) sample and not in the Control sample.

Filter Options x

Variants

+ Filtered In Variants (328)
+ Hidden“ariants
+ Filtered QutvVariants (243

Samples
[] Control: Dermo AmpliSeq CCP normal

Sample: Demo AmpliSeq CCP tumor

Filter Zamples

Chromosome
All -
Filter Chains
Default Variant Wiew - k

Total Wariants: 352

100 == ChY
Confidence Range
==1.0ET

Yariants: 328 Genes: 387

The variant table also shows only this set of variants.
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Filter Options

Yariants

+ Filtered In Variants (4148)
+ Hidden Variants
« Filtered Out Variants (24)

Samples
[] Control: Demao AmpliSeq CCP normal

[] Sample: Demo AmpliSey CCP turmor

Filter Zamples

Chremeseme
All -
Filter Chains
Default Yariant View - [

Total Yariants: 4172

10.0 == CHY
Confidence Range
==1.0E7

Yariants: 4143 Genes: 382

3. Compare with the totals when the Sample checkbox filter is not used.
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The Filtered and Hidden links

While not strictly filters, these links change the set of variants that are displayed in the
Analysis Results page.

Filter Options x

Variants

+ Filtered InYariants {4148)
+ Hidden Variants
« Filtered COutVariants (24)

Samples
[] Control: Dermo AmpliSeq CCP normal

[] Sample: Cemo AmpliSeq CCP tumar
Filter Samples
Chromeosome

19 -

Filter Chains

Diefault Variant Wigw - k

TatalYariants: 4172

10.0 == ChY
Confidence Range
==1.0ET

Wariants: 4148 Genes: 332

* Filtered In Variants: Displays variants that are still being considered for inclusion
in the final report or as interesting for your research. This is the default view.

¢ Hidden Variants: Displays variants that have been explicitly hidden with the
Selected Variants menu.

¢ Filtered Out Variants: Displays variants that are no longer being considered
because of the filter chain setting.
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Filter chains With filter chains, you also restrict the displayed variants according to variant
annotations or metrics.

Note: Specific filters only appear in workflows for which they are relevent. For
example, the Genetic Category Type filter is available with trio analyses, but not with
other analyses.

Saved filter chains
When you save a filter chain, you restrict the variants in the analysis' results set.

The saved filter chain also becomes available in the Filter Chain menu for use in other
analyses.

208 lon Reporter™ Software 5.6 Help



Analysis results
Filter variants

Use an existing filter chain

If a filter chain already exists with the filters you want, click the Filter Chains menu
and select that filter chain.
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Include unannotated variants option

Enable the Include unannotated variants option to have the filter include variants that
have not been annotated with the specific filter key. This behavior is similar to the Ion
Reporter™ Software 1.x "Include if missing" option. This example includes variant that
with a blank MAF value (as well as variants with MAF values in the specified range).

Edit Filter Chain

MName Description

MAF example

Winor Allele Frequency v Selected Filters

Name Value

Range: 0.0 — — 0.5
Minar Allele Frequency 0.0 == Minor Allele Frequency <= 0.5 ]

From 0.0
To 05
< Inclusive

| # Include unannotated variants |

Set

The plus sign in the Selected Filters area listing indicates that the filter includes
variants that are missing the annotation.
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Inclusive checkbox
The Inclusive checkbox controls whether a range includes its end-points or not.

When the Inclusive checkbox is enabled, variants with the same values as end-points
are filtered in.

When the Inclusive checkbox is not enabled, variants with the same values as end-
points are filtered out. To be filtered in, variants must have values that are in between
the range's end-points.

In this example, the Inclusive checkbox is not enabled. If a variant has an MAF value
of 5.0 (the same as the end-point), the variant is filtered out and not displayed.

Edit Filter Chain

Name Description
MAF example
Winor Allele Frequency v Selected Filters
N Val
Range: 0.0 — — 0.5 b Al
Minor Allele Frequency 0.0 <= Minor Allele Frequency <= 0.5 4 Tl
From 00
To 05

Inclusive
# Include unannotated variants

Set

Follow these steps in these sections to create a filter chain.
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Open the filter chain
Click the New icon to the right of the Filter Chain menu.

Filter Options

Variants

+ Filtered In Variants (4148)
+« Hidden¥Yariants
+ Filtered Qutariants (243

Samples
[] Control: Demo AmpliSeq CCP normal

[] Sample: Cema AmpliSeq CCP tumar

Filter Samples

Chromeosomse
All -

Filter Chains m
Default Variant Wiew - QE.)

Total Wariants: 4172

10.0 == CHW Confidence Range _
==1.0ET M

Wariants: 4148 Genes: 382
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Create the first filter in the chain

1. Enter a name and description for your new filters. The name is used if you later
save your new filters.

Create Filter Chain

Mame Description

Example Filters

Selected Filters
Choose Filter v
Name Value

2. In the Choose Filter menu, select the type of filter ("PValue" in this example).

Create Filter Chain

Mame

Exarmple Filters

Choose Filter i~

|5

Filtered Coverage
Functional Scores
Gene Ontology
Gene Symbol
HotSpot
Ingenuity Yariant Analysis
Location
Minor Allele Frequency
ity Wariants
Mamed “ariants
Ok
Oncomine
Pfam
%wres

mman SRS
wariant Effect

variant Type L)
Zygosi v
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3. The PValue default settings appear next to the Choose Filter menu.

Create Filter Chain

MName Description
Example Filters Example
Pv/alue b

Fange: 0.0 — — 1.0
Fram 0.0
To 1.0
Inclusive

Set

4. Change the PValue settings to your desired value ("0.001" in this example).

214 lon Reporter™ Software 5.6 Help



Analysis results
Filter variants

5. Click the Set button. Your new PValue range appears in the Selected Filters area.

6. At this point, you can select another filter in the Choose Filter menu. Or, click the
Apply button to see how many variants are filtered out.
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See the effects on the Analysis Results page

You return to the variant review page. The Filter Options panel has these changes:

Filter Options *

Variants

+ Filtered In Variants (3785)
+« HiddenVariants
Filtered QutWariants (387 |

Samples
[] Control: Dema AmpliSeq CCP normal

[] Sample: Cemo AmpliSeq CCP tumar

Filter Samples

Chromosome

All -

Filter Chains

Example Filters - Gk

Total Wariants: 4172

| 0.0 == Pvalue == 0.001 | i ]

Wariants: 3785 Genes: 474

Save Filter Chain

1. The Filtered Out Variants number is increased, due to variants which fail your
new PValue threshold. These filtered-out variants are also dropped from the
variant table.

2. The Filter Chains menu shows the name you entered in the Create Filter Chain
popup-

3. Your new PValue filter is shown in the Filter Chains area.
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Create another filter in the chain

1.

Click the Edit icon [# to modify your filter chain. The Edit Filter Chain popup
opens (with your PValue setting still listed in the Selected Filters area).
Edit Filter Chain

Mame Description

Example Filters Example

Selected Filters:
Choose Filter v

Hame Value

Palue 0.0 == P¥alue == 0.001

Follow these steps in the Edit Filter Chain popup:

a. In the Choose Filter menu, select dbSNP as a new filter to add. Change the
dbSNP setting default setting ("In") to Not in.

Edit Filter Chain

Marme Descrigtion

Example Filters Example

dhshP v

Filter value In

b. Click the Set button. Your new dbSNP setting appears in the Selected Filters
area.
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c. In the Choose Filter menu, select Variant Type as a new filter to add.
Change the Variant Type to only SNV (Deselect the other checkboxes.).

d. Click the Set button. Your new Variant Type setting appears in the Selected
Filters area.

e. Click the Apply button.
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Create an advanced filter chain query

You can use filter names and AND and OR modifiers and parentheses to construct
precise custom queries to filter your variant data.

Note: AND and OR must be all caps.

1. In the Workflows tab, click Presets.
2. Click Create Preset » Filter Chain.
3. Name your filter chain. In this example, the name is SNP variant detection.

4. Select filters one at a time. In this example, the selections are: dbSNP and filter
value is In. Click Set.
The filter appears on the table on the right.

5. Add another filter. For example, add COSMIC, then set filter value to In. Click
Set to add the filter to the table on the right.
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6. Add a third filter. For example, add Variant Effect, then select values Missense
and Nonsense. Click Set to add the filter to the table on the right.
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7. To change the order or manner in which these filters are applied, use brackets ()
to group the filters you want to apply first. You can also change AND to OR to
alter the filtering algorithm in the FilterChain Query dialog.

Note: When you use a custom grouping different from AND-ing each filter, then
the progressive filter counts are not shown on the Analysis Results page.

8. Click Save. The filter chain is available to use from Filters dropdown list during
workflow creation, workflow editing, and on Analysis Variant Review screen.

The new filter option is available on the Filter chevron.

When used, the details of the advanced filter query appear on the Summary
Panel under Filter Chains. All filter components are listed.
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See the effects on the Analysis Results page

You return to the variant review page. Only 6 variants are still filtered in.

Filter Options

Yariants

« Filtered In Variants (6)

* HiddenVariants
+ Filtered Qut'ariants (4166)

Samples
[ control: Dermao AmpliSey CGP normal

[] Sample: Derno AmpliSeq CCP tumar

Filter Samples

Chromosome
All -
Filter Chains
Example Filters > el |

Tatal Variants: 4172
0.0 == PValue == 0,001 Y

Wariants: 3785 Genes: 4749
dbSMP = Mat In T

Yariants: 1932 Genes: 467
Wariant Type in ShY T

IVarianls: 4} IGenes: kil

Save Filter Chain

lon Reporter™ Software 5.6 Help



Analysis results
Filter variants

This image shows the entire page.

Additional steps
* You can repeat the filter chain edit to add additional filters to the chain.
* You can edit the filter chain at any time (before you save it) to rename it.

e Click the trash can icon [ to remove a filter from a filter chain that you are
editing.

* Click the Save Filter Chain button if you want to reuse this filter in other
analyses.

Types of filters and filter chains

Note: If the filter you use includes Annotation Source versions that differ from the
version that is used in the analysis, it will not affect filtering. For example, if you
apply a gene ontology filter with Gene Ontology version 20160928 and Gene

lon Reporter™ Software 5.6 Help 223



Analysis results
Filter variants

Ontology version 1.218 is used in the analysis, variants are returned without any
change.

Note: For some annotation sources, multiple versions for each source are available
for a given reference. When a filter chain contains a filter that uses a single version of
the annotation source is used to filter multiple analyses that might not use the same
annotation source version, the filtering uses the original version of the annotation
source used in that analysis.

For example, if two analyses (A and B) that use different annotation source versions
are visualized: (A): uses dbSNP 138 - filter chain filters in 47331 variants for a generic
dbSNP In filter. (B): uses dbSNP 147- filters in 52044 variants for a generic dbSNP In
filter.

Multi-visualization of these two analyses A and B: Application of a dbSNP In filter for
this multi-visualization shows 47331 variants for analysis A and 52044 variants for
analysis B.

¢ Allele Ratio Filter: The Allele Ratio filter filters on non-reference allele
frequencies. All variants that have at least one non-reference allele reported with
a frequency in the selected filter range is returned when applying this filter.

e Allele Read Count: The Allele Read Count filter sets the minimum count for
genotype alleles. Use this filter to filter out variant candidates that do not have at
least this number of supporting reads. More specifically, the Allele Read Count
filter uses the minimum value in FAO if it exists, else it falls back to AO if it exists
(which can be the case for some indel variants). The Allele Ratio filter uses the
same logic. It uses FAO/sum(FRO+FAOQO) values if they exist, else AO/sum(RO
+AQ) if it exists.

Create Filter Chain

Hame Description

Selected Filters:
Allele Read-Count b

Name Value
Fange: 0 «— — 100000

Frorm a0
Ta 100000

Inclusive

In contrast, the Allele Coverage column in the variant table reports counts for all
reported alleles, not only genotype alleles. In Ion Reporter™ Software the allele
ratio that is displayed in the graphical user interface is slightly different from the
allele ratio used in filtering due to rounding. The filtering happens on a value
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stored in the database, which is sometimes different from the value that is
displayed in the user interface.

Demo AmpliSeq Exome CNV case_2

Analysis results
Filter variants

v Functional Ont Pharmac: iti ﬂ
Allele Coverage Allele Ratio p-value Coverage
C=0,G=114 C=0.0,G=1.0 0.00001 114
G=0, Z=102 G=0.0,C=1.0 0.00001 102
C=0,T=114 C=0.0T=1.0 0.00001 114
G=0, A=120 G=0.0, A=1.0 0.00001 120
C=0,T=118 C=0.0T=1.0 0.00001 118
A=1,5=137 A=0.01, G=0.99 0.00001 138
A=2,G=111 A=0.02, 5=0.92 0.00001 113
G=0, A=105 G=0.0,A=1.0 0.00001 1a7
C=1, T=106 C=0.01, T=0.93 0.00001 a7
T=0, &=133 T=0.0,C=1.0 0.00001 133
T=0, =107 T=0.0,C=1.0 0.00001 a7
1 C=178,T=201 C=0.47,T=0.53 0.00001 379
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* CNVs: CNV variant calls can be filtered out by several filters that do not apply to

CNVs. For example, CNVs are filtered out by the Variant Effect filter. To instead
include CNVs in the filter, select the "Include unannotated variants" checkbox. To
exclude CNVs, you must include an explicit Variant-Type filter.

Edit Filter Chain

Name Description

Missense example

Selected Filters

Variant Effect v
) ) . . Name Value
Filter Option Select Specific Annotations v
I ¥ Include unannotated variants I “ariant Effect Variant Effect in missense m

Search Set

Value

refAllele
unknown
SYnonymaous

" missense
nonframeshifinsertion
nonframeshiftDeletion
nonframeshiftBlockSubstitution
nonsense
stoploss
frameshiftins ertion
frameshiftDeletion
frameshiftBlockSubstitution

- 20 v  items perpage

117 Af42 itame

CNVs: The Ion-supplied filter "Confident CNVs (Germline)- CNVs Only" applies
to analyses that employ germline CNV detection. This filter has no effect on
analyses that use somatic CNV detection.

Genomic Coordinates: This filter filters by genomic regions, and can be used to
identify regions that are targeted by an amplicon or amplicons in a user-defined
assay. The filter value is a chromosome region or multiple regions that are
separated by OR operators, such as: chr1:11174371-162724600 OR
chr2:24991141-42492092.

Minor Allele Filter (MAF): The MAF filter filters on 1000-Genomes Global MAF
values (as obtained from the dbSNP database). This filter excludes
locations/variants where the minor allele happens to be the same as the reference
allele. Therefore, the filter can return fewer variants than expected.

Named Variants Filter is made up only of variants in the CFTR gene panel.

5000Exomes MAF filters: If a variant is missing a value for a 5000Exomes MAF
field, that variant is filtered out by the 5000Exomes MATF filter (5000Exomes
AfricanAmerican MAF, 5000Exomes EuropeanAmerican MAF, and 5000Exomes
Global MAF filters).

Paired Analysis Filtering: In a Paired Sample analysis review page, Filtered Out
Counts is only designed to get counts from the filter chain, not from using just the
Sample Filter.
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* These images give examples of some filters:

— Variants that are annotated as either pathogenic or probable-pathogenic in
ClinVar:

— Variants that are not in My Variants knowledge base:

— Variants that appear in the COSMIC database (no matter what the
annotation):
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— Variants that do not appear in either the COSMIC or the dbSNP databases:

— Variants that match a hotspot position (based on the hotspots file that is used
with the analysis):

— Variants that do not match a hotspot position (based on the hotspots file that
is used with the analysis):
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— Variants that are annotated as either splicesite_3 or splicesite_5 (with the
Location filter):

Note: Third-party algorithms that make more precise predictions of splice-
site variants can be used independent of Ion Reporter™ Software. These
include: SpliceSiteFinder-like, MaxEntScan, GeneSplicer, NNSPLICE, and
Human Splicing Finder.

Variants that are annotated as either missense or stoploss (with the Variant
Effect filter):
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— Grantham, Polyphen, or SIFT scores (with the Functional Scores filter):
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Analysis results
Metagenomics 165 analysis results

The results page contains the following sections and features:

@ Analyses

Filter Analyses -

« L Analysis v

demo

Stage

Created On

Search

Status

= Refresh

frindemo

Demo Metagenamics Mock Community_138507 283205
Derno CCP paired Pubs 2

Derno CCF paired Pubs

Derno Aneuploidy_test

Dermo AmpliSed Exome VCF_1385094919500

Derno AmpliSed Exome VCF_1384994367092

Demo AmpliSeq CHPvZ tumor_1385543881904

CF18_demo

Ooooooooo|o

Header: States the analysis name.

Interpretation Assignment
Variant Review
Interpretation Assignment
Report Published
Interpretation Assignment
Interpretation Assignment
Report Generation
Interpretation Assignment

Report Published

Mow 28 2013 02:33 At

Moy 21 2013 02:28 P

Mow 27 2013 12:27 Pl

Moy 21 2013 05:12 P

Moy 28 2013 05:36 A

Moy 21 2013 08:35 P

Moy 20 2013 04:38 P

Moy 27 2013 01:15 Ant

Moy 27 2013 0237 Pl

Buccessiul
Successul
Successiul
Successiul
Successiul
Successiul
Successiul
Guccessiul

Buccessiul

¢ View Sample Results menu: For a multi-sample analysis, switches to data for a

different sample.

e Visualization / Downloads area: Contains links to download results files and to

visualize your results with Krona™.

* Summary: Contains analysis and parameter information and read metrics by

primer.

* Results: Contains either consensus data (combined from all primers) or data
broken out by primer. Reads that can be identified down to the species level are

marked in green.

Note: In the results table, Total Mapped Reads in a sample differs from the sum of
the bottom species-level counts. The reason is that the Total Mapped Reads are filtered
by genus cutoff, species cutoff, and minimum alignment coverage. The topmost
number in the "count" column will differ from the sum of the taxonomy levels below
it, since the reads that did not satisfy the filters are also included in the total mapped

reads.
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Note: When your metagenomics workflow uses two databases, only reads that do not
map to the first database are attempted with the second database. In the Results
section, the DB counters column shows how many reads matched sequences in each
database.

@ Analyses

Results

Data View By Primer b

Primer Phylum Class Order Family Genus Species %ID  Count] DB
counters|

w2 35460 | 30575
4894

Actinobacteria 450 4500
Actinobacteria 450 4a0:0

Actinomycetales 450 450:0

Propionibacteriaceae 450 450:0

Propionibacterium 450 450:0

acnes 100- 450 4500
100

Bacternidetes 3053 | 301439
Bacteroidia 3053 ) 301439

Bacteroidales 3053 ) 301439

Bacteroidaceas 3053 | 301439

Bacternides 3053 | 301439

{genus level ID 13 0:13
only)

99.08- 3040 [ 3014 - 26

100

For example, in the last row, for the species vulgatus, the value

3014:26

means that 3014 reads matched sequences in the MicroSEQ™ database and 26 matched
sequences in the Greengenes database.
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Note: When primer information is missing in the metagenomics workflow, a warning
message appears during analysis review.

Steps to interpret your metagenomics 16S" analysis results

1. Log in to the Ton Reporter  Software application and click on the Analysis tab.
2. Click on the name of your metagenomics analysis in the analysis table.

3. Click on the Visualization / Downloads, Summary, or Results section headers to
collapse the section.
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4. Click on the Data View menu to display either consensus data (combined from
all primers) or data broken out by primer, with or without slash calls.

5. Click on one of the visualization links to view your results with Krona" charts.

Note: Sequences from different 16S databases may use different taxonomic
hierarchies. For example, Greengenes may have de novo classified sequences labeled
as Archaea>Crenarchaeota>Thaumarchaeota where Thaumarchaeota is a class of
Crenarchaeota. Records from other databases may treat both Thaumarchaeota and
Crenarchaeota as phyla. Therefore, you may see differences in taxonomies when you
compare 16S analysis results from the two databases used in Ion Reporter™ to other,
external databases.
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Alpha-beta The 16S Metagenomics workflow in Ion Reporter  Software includes alpha diversity
diversity results calculations and beta diversity calculations.

Alpha diversity results describe the diversity in a single sample at the Species, Genus,
and Family levels. Beta diversity results describe the diversity between multiple
samples at the Species, Genus, and Family levels. For results interpretation guidance,
see the QIIME online help at qiime.org.

Note: If you only run one sample, Ion Reporter returns only alpha diversity results. If
you have two or more samples, you get beta diversity results. However, PCOA plots
can only be generated for more than three samples, depending on the quality of data
input.

Quantitative Insights Into Microbial Ecology (QIIME) algorithms determine what
species, genus, or families are present.

To review results:

1. Inthe Analyses, click Overview, then select the analysis of interest.
An Analyses summary page appears.

2. Review your results by clicking the Visualize links in the Alpha Diversity
column or the various plots and matrices links in the Beta Diversity column.
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3. Scroll down to Summary and Results sections to see overall statistics.

Alpha-beta diversity calculations are based on the information that is gathered
from the consensus files that are generated by the 165 Metagenomics workflow.
Read counts per sample for species, genus, and family are collected. Operational
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taxonomic unit (OTU) tables are generated. These tables are used by QIIME to
generate alpha-beta diversity results.

4. Select your metrics.

5. Repeat for Genus and Family links under Alpha Diversity Results to see the
genus and families that are in the sample.

6. Click Species under Beta Diversity Results.
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7. Here you can view several plot types, including: Eucledian, Manhattan, Chi-
Square and Bray Curtis PCOA Plots and PC Matrices.

8. Tools on the right side can be used to produce an image.

Visualize OTU New in Ion Reporterm software, OTU files are displayed graphically. For instance, in
results with R- the example below, the OTU_family.txt file is rendered graphically in the
scripts graphs OTU_family.png file.

1. Download your results.

2. Click on the PNG file of the results.
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The data is displayed visually.

Visualize your The Krona' visualization package enables you to browse through your data using
metagenomics interactive zoomable pie charts. Krona documentation is available on their

165 results with ~ 8ithubssite

Krona charts Note: The Snapshot button does not work on the Krona visualization page in the

Metagenomics workflow. Krona documentation states that their charts are best
viewed with the Firefox browser.

This table describes your actions to visualize your metagenomics 165" results with
Krona charts:

Purpose Your action

Open your analysis data in a Krona™ chart | Click on the Visualize results by primer
link.
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Purpose

Your action

Open Krona™ on your consensus data

Click the Visualize consensus results link.

Display percentages for one area of the
chart

Click on that area of the chart. The
percentages for that area are displayed in
the top right of the page.

Make that area the new focus of the chart

Click the expand box in the top right of the
page.

Return to the previous chart focus

Click the back arrow near the Krona™
logo in the top left of the page. (Only one
go-back is supported at a time.)
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Purpose Your action

Change the number of circles shown in the | Click the minus or plus icons [-] [ +] near
chart the Max depth label.

Change the font size Click the minus or plus icons [- ] [+] near
the Font size label.

Change the size of the chart Click the minus or plus icons [-] [+ ] near
the Chart size label.
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Purpose

Your action

Show read depth by color

Enable the Color by Reads checkbox. A
color legend appears in the bottom left.
(This example shows a consensus chart.)

Simplify wedges

Enable the Collapse checkbox. This
selection combines redundant wedges (that
contain only another wedge).

Create an image of the pie chart

Click the Snapshot button.

This button creates a SVG (Scalable Vector
Graphics) format image file. See Krona "
documentation on their github site for
browser support. (For example, on Chrome
an SVG file is not created directly. You have

to save the page as a PDF.]
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Purpose Your action
Create a sharable link to the chart Click the Link button.
Open Krona" documentation Click the question mark button. This link

™
opens the Krona ~ sourceforge
documentation in a new tab.

1. Log in to the Ton Reporter  Software application and click on the Analysis tab.
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2. Click on the name of your metagenomics analysis in the analysis table.

3. Click on the link next to the Krona™ piechart label.

4. See the table above or Krona  documentation on their github site for next steps.

Immune Repertoire analysis results

Sample QC tab The Ion AmpliSeqN Immune Repertoire Assay results are represented graphically.
Select the QC metric to view from the Views dropdown list.
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After the first stage of data processing raw sequencing reads are classified and
proportionally represented in a stacked barplot. Actual read counts for each

classification are listed below the figure in the results report.

Read classification

Description

Example

Off-target/low-
quality (dark gray)

Reads which are of low quality
or represent the product of an
off-target amplification.

Unproductive (gray)

Reads that have uncorrectable
sequencing or PCR errors which
lead the rearrangement to have
out-of-frame variable and
joining genes or a premature
stop codon.

Rescued productive
(light blue)

Reads having an in-frame
variable and joining gene, and
no stop codons after indel error
correction.

Productive (blue)

Reads having an in-frame
variable and joining gene, and
no stop codons.
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Proportion of full length, quality trimmed and reads lacking P1-key, by read
classification

Stacked barplot indicating the frequency of quality trimming for reads classified as
productive, rescued productive, unproductive and off-target/low-quality. Full length
reads categorized as low quality/off-target are likely to represent off-target

amplifications.
Color Description Example
Red Quality trimmed reads lacking
an identifiable P1-key.
Yellow Quality trimmed reads having an
identified P1-key.
Green Full length reads having an
identified P1-key, and no quality
trimming.
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Base composition of overcalled and undercalled homopolymers

Stacked barplot indicating the nucleotide composition of overcalled bases (base
insertion sequencing errors) and undercalled bases (base deletion sequencing errors).
Highly skewed nucleotide composition may indicate lower quality sequencing or low

library diversity.
Color Description Example
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QC metrics

The QC metrics include the read classification counts and strand QC metrics.

Category

Description

Read classification

Total productive
reads

Productive + rescued productive reads

Productive reads

Reads having an in-frame variable and joining gene, and no stop
codons.

Rescued productive
reads

Reads having an in-frame variable and joining gene, and no stop
codons after indel error correction.

Unproductive reads

Reads that have uncorrectable sequencing or PCR errors which
lead the rearrangement to have out-of-frame variable and joining
genes or a premature stop codon.

Off-target/
low-quality

Reads which are of low quality or represent the product of an off-
target amplification.
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Sample Results
tab
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Category Description

Strand QC metrics

Plus strand (v- Number of sequence read counts from the plus (+) strand.
side) read counts

Minus strand (c-side] | Number of sequence read counts from the minus (-] strand.
read counts

Plus strand CDR3 Average PHRED score for plus (+) strand reads.
avg PHRED

Minus strand CDR3 | Average PHRED score for minus (-) strand reads.
avg PHRED

The Ton AmpliSeq  Immune Repertoire Assay results are represented graphically.
Select the Sample Results to view from the Views dropdown list.

Spectratyping plots

The immune repertoire within a sample is represented in each spectratyping plot by
the range of CDR3 lengths and their pattern of distribution. Reads for identified
clones are arranged along the X-axis according to the variable gene identity and the
Y-axis according to the CDR3 nucleotide length. The variable gene order reflects the
gene position within the TCRf locus. Dots are separated vertically along the Y-axis by
3 nucleotides (one codon), the higher up the Y-axis the longer the CDR3 region. Circle
size indicates the frequency of a particular variable gene-CDR3 nucleotide length
combination within the dataset. Circle color represents a forth metric specific to each
graph (e.g., shannon diversity, evenness, clone frequency). Key repertoire metrics are
displayed along the lower margin of the plot.

In the Ton Reporter  Software the spectratyping plots are interactive, allowing you to
adjust the data and access clone details. Drag the ends of the horizontal bar below the
X-axis to limit the region (v-genes) to view in the plot. Drag the ends of the color
range up or down to limit the clones that are viewed. Hover your cursor over any dot
to view the details of an individual clone. Click Q to restore the default plot view,
click & to download a static image of the plot (if you have adjusted the plot view, the
adjusted plot is downloaded).

Note: T-cell Leukemia (Jurkat) Total RNA is derived from a cell line consisting of a
single T-cell clonotype. Running the Ton AmpliSeq Immune Repertoire Assay Plus—
TCRp on Jurkat Total RNA should detect a single clonotype (a single spot on

spectratyping plot).
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Figure 1 TCRB V-gene usage and mutation rate

Spectratyping plot highlighting frequency of mutated bases over the variable gene of identified
clones. Circle color indicates the average frequency of mutated bases for clones having a
particular variable gene-CDR3 nucleotide length combination. The two large circles in the
TRBV3-1 column indicate the presence of expanded clones having that particular variable gene.
The light color of the circles indicates that the variable gene sequences of the sample closely
match reference variable gene sequences in the IMGT database. Systematic differences with
respect to reference may indicate the presence of polymorphism within the variable gene that is
not captured by the IMGT database.

Figure 2 TCRB V-gene usage and evenness

Spectratyping plot highlighting evenness of identified clone sizes [Normalized Shannon
Entropy). Circle color indicates the evenness of clone sizes for clones having a particular
variable gene-CDR3 nucleotide length combination. Values range from 0 to 1, with 1 indicating
most even clone sizes. In this representation, portions of the repertoire containing highly
expanded clones appear white.
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Figure 3 TCRB V-gene usage and shannon diversity

Spectratyping plot highlighting Shannon Diversity (entropy) of identified clones. Circle color
indicates the Shannon Diversity of clones having a particular variable gene-CDR3 nucleotide
length combination. Portions of the repertoire containing highly expanded clones typically have
a corresponding low Shannon Diversity value.

Figure 4 TCRB V-gene usage and largest clone frequency

Spectratyping plot highlighting the frequency of the largest clone for each variable gene-CDR3
nucleotide length combination. Circle color indicates the frequency of the largest clone having a
particular variable gene-CDR3 nucleotide length combination. Dark color indicates the
presence of particularly expanded clones. These may be indicative of response to antigen but
are also more commonly found in aged healthy individuals.

250 lon Reporter™ Software 5.6 Help



Analysis results
Immune Repertoire analysis results

Figure 5 TCRB V-gene usage and number of clones

Spectratyping plot highlighting the number of clones that are identified for each variable gene-
CDR3 nucleotide length combination. Circle color indicates the number of clones having a
particular variable gene-CDR3 nucleotide length combination. Specific variable genes may more
frequently participate in VDJ recombination, leading to an enrichment in distinct clones for
those variable genes.

V-gene usage

The Ton AmpliSeq  Immune Repertoire Assay results are represented graphically.
Select V gene usage from the Views dropdown list. The stacked barplots indicate the
representation of variable genes among identified clones. Ordering of variable genes
reflects position within the TCRf3 locus.

Figure 6 V-gene usage highlighting alleles
Color segments within each bar indicate the frequency of particular variable gene alleles,
arranged by frequency from rarest (top) to most common (bottom).
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Figure 7 V-gene usage highlighting clone sizes
Color segments within each bar indicate the contribution of individual clones, arranged from
smallest clones (top) to largest clones (bottom).

VJ-gene usage heatmap

The Ton AmpliSeq  Immune Repertoire Assay results are represented graphically.
Select V]- gene usage heatmap from the Views dropdown list.

Figure 8 VJ-gene usage heatmap

Heatmap illustrating the frequency of particular Variable gene-Joining gene combinations for

identified clones. Frequencies are log transformed with pseudocount added. Over-represented
Variable-Joining gene combinations (white) may indicate presence of a highly expanded clone.
Ordering of variable genes reflects position within the TCRB locus.
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Clones detected per variable gene

The Ion AmpliSeq  Immune Repertoire Assay results are represented graphically.
Select Clones detected per variable gene from the Views dropdown list. The barplot
indicates the number of identifed clones having a particular variable gene. Ordering
of variable genes reflects position within the TCR3 locus.

CDR3 histogram

The Ton AmpliSeq  Immune Repertoire Assay results are represented graphically.
Select CDR3 histogram from the Views dropdown list. The histogram indicates the
distribution of identifed clones with a given CDR3 nucleotide length.

Relative frequency (Y-axis) of identifed clones with a given CDR3 nucleotide length (X-axis).
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Clone summary The Clone Summary table lists the identified clones in rank order from the most

table frequently occurring to least frequent. Each row represents an individual clone. For
each clone the identified Variable and Joining region are listed as well as the amino
acid (CDR3 AA) and nucleotide (CDR3 NT) sequences of the CDR3 region.

For multi-sample analyses the Clone Summary table lists the frequency of each clone
identified in any of the samples—sorted in descending order based on the frequency
of the clones in the leftmost column—for each sample in the analysis.

b o

©) Sample 1 ® Sample 2
Table 3 Clone summary information fields
Coloumn header Description

Variable The best matching IMGT variable gene of the rearrangement.

Joining The best matching IMGT joining gene of the rearrangement.

CDR3 AA The CDR3 amino acid sequence of the rearrangement, denoted
using the IMGT definition of the CDR3 region.

CDR3 NT The CDR3 nucleotide sequence of the rearrangement, denoted
using the IMGT definition of the CDR3 region.

Count The total number of reads mapping to the rearrangement after
quality filtering.

Frequency The frequency of the rearrangement as a proportion of total reads
passing quality filtering.

Rank The frequency rank of the rearrangement.

Note: Additional details are available by downloading the Clone Summary table.
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Download the clone summary table

1. In the Immune Repertoire Results screen, Sample Results tab, select Clone
Summary from the Views dropdown list.

2. Click Download Clone Summary.
The clone summary CSV file downloads automatically.

3. Open the clone summary CSV file to view the additional information that is
included in the spreadsheet.

Table 4 Additional clone summary information fields

Column header

Description

Diversity

The best matching IMGT diversity gene of the rearrangement. This
field is blank if the diversity gene cannot be identified with
confidence, often as a consequence of exonucleotide chewback.

Plus Counts

The number of reads mapping to the plus strand (V to J
orientation] after quality filtering.

Minus Counts

The number of reads mapping to the minus strand (J to V
orientation) after quality filtering.

Variable Mutation

The proportion of bases within the variable gene region that do not
match the IMGT variable gene reference sequence. Variable gene
alleles that are not found in the IMGT database will have a non-
zero value for this metric.

Variable Gene Allele

The allele of the best matching IMGT variable gene.

Diversity Gene Allele

The allele of the best matching IMGT diversity gene. This field is
blank if the diversity gene cannot be identified.

Joining Gene Allele

The allele of the best matching IMGT joining gene.

Constant Gene

The constant gene of the rearrangement.

Sequence

The sequence of the read corresponding to the rearrangement,
presented in plus strand (V to J) orientation.

Reference Sequence

The combined sequence of the best matching IMGT variable,
diversity and joining genes, aligned to the rearrangement
sequence. Dashes indicate positions within the reference VDJ
sequence that do not match the rearrangement sequence. Often
these represent N-additions within the V-D and D-J junctions due
to the action of terminal deoxynucleotidyl transferase (TdT).
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Manually launch an analysis in lon Reporter "

1.

2.

5.

6.

Sign in to the Ion Reporter™ software.

Launch the analysis.

From the... Directions

Home tab 1. In the Dashboard screen, click Launch analysis.

2. In the Launch Analysis screen, select Immune Repertoire from
the Research Application dropdown list.

3. Click Next.

Analyses tab 1. Click Launch Analysis, then select Manual from the dropdown

list.

2. In the Launch Analysis screen, select Immune Repertoire from
the Research Application dropdown list.

3. Click in the AmpliSeq Immune Repertoire Plus TCR beta chain
- w1.0 - Single Sample row, then click Next.

Workflows tab| 1 gelect Immune Repertoire from the Research Application

dropdown list.

2. Click in the AmpliSeq Immune Repertoire Plus TCR beta chain
- w1.0 - Single Sample row, then select Launch Analysis from
the Actions dropdown list in the Details pane.

Search by any unique identifier you used to label your samples during setup,
select one or more samples to include in the analysis, then click Next.

(Optional) Select plugins to run with your analysis.
a. Click £} adjacent to the selected plugin.

b. Configure the plugin parameters as necessary, click Submit, then click
Close.

Click Next.

Enter an Analysis Name and Description (Optional), then click Launch Analysis.

The Ton Reporter  Software performs the analysis and the results will appear on the
Analyses page.
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Multi-sample The Ion ReporterTM Software can perform multi-sample (or cross-sample) analyses to
analysis compare the immune repertoire between samples. To perform a multi-sample
analysis:

1. Under the Analyses tab, in the Overview screen, select AmpliSeq Immune
Repertoire Plus TCR beta chain - w1.0 - Single Sample from the Workflow filter
dropdown list.

2. Click the adjacent checkboxes to select 2 or more results files from the available
list of analyses, then click Visualize.

3. Click the checkboxes to select 2 or more samples for multi-sample analysis, then
click Compare Samples.

The multi-sample analysis results are reported side-by-side in a clone summary table
(see page 254) in rank order from most to least frequent.
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lon Reporter Genomic Viewer overview

Ion Reporter™ Genomic Viewer, formerly IGV Light, is a streamlined version of the
Integrative Genomics Viewer (IGV) that the Broad Institute offers. Ion Reporter™
Genomic Viewer is faster loading, but not as granular as the IGV application. You can
set Ion Reporter™ Genomic Viewer preferences in Account Preferences, such as an
option to determine how many rows appear in the list of results on theAnalysis
Visualization screen. For more information, see “Set IRGV or IGV as default

viewer” on page 21.

Note: The maximum number of analyses you can open in a single visualization
depends on the size of the analyses results data.

The following aneuploidy visualization shows the main area of the viewer.
¢ Whole Genome View
¢ Selected Chromosome View
¢ Summary Table
* Filters

e Preferences

258 lon Reporter™ Software 5.6 Help



Visualize results with lon Reporter™ Genomic Viewer or IGV
lon Reporter™ Genomic Viewer overview

You can view multiple analyses at a time and multiple types of analyses. The image
below is a Whole Genome View of an aneuploidy, Oncomine™, and cancer hotspot
analyses. Notice, that different types of analyses look different in the Whole Genome
View and have different contents in the Summary table.

Note: The maximum number of analyses you can open in a single visualization
depends on the size of the analyses results data.

The first Whole Genome View includes CNV calls, a MAPD call, and a Confidence
Filter threshold. Blue and red bars in the whole genome view represent CNV calls.
Blue bars represent calls above the expected normal ploidy value (Copy Number
Gains/Duplications/Insertions) for that chromosome (chr14 and 15 in this aneuploidy
example). The Red bars represent calls below the expected ploidy value for the
chromosome (Copy Number Losses/Deletions, chr 13 in this aneuploidy example).

The second Whole Genome View above is an Oncomine analysis where somatic CNV
calls have been made. Instead of using a confidence filter, this data uses 5% and 95%
Confidence intervals that are not shown in this view. The green dots are a density plot
of SNPs, Indels, and other calls. Click on any green density plot and the software
zooms and displays the area in detail.
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The various types of analyses also produce differing summary tables.

CNV analysis summary table

Trio analysis summary table

Aneuploidy analysis summary table
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RNA View summary table
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Smoothing, No Gender and Mosaicism results in IRGV

This image shows five aneuploidy analyses run in various lon Reporter Software 5.4
aneuploidy workflows that show how smoothing, No Gender and Mosaicism appear
in Ton Reporter Genomic Viewer visualizations. To make data points easier to see on
the screen and in reports, visualization of aneuploidy detection is enhanced by tile-by-
tile data points that are rendered as easier-to-see circles in the whole genome views.
All results from Ion Reporter  Genomic Viewer 5.4 aneuploidy workflows use this
enhanced view.

Note: Analyses 2 through 5 have smoothing of the discrete tile data turned on by
default. Smoothing of the discrete data has no impact on the calls that are made by the
aneuploidy pipeline in the software. Smoothing can be turned on or off in any
workflow.

Analysis number Description

1 An analysis performed with the lon

Reporter” Software 5.2 version of the Low
Pass Whole Genome Aneuploidy workflow
and the Demo Aneuploidy sample that is
available in the software, with a loss of one
copy of chr13 and single copy gains of chrs
14 and 15; this analysis was run with a lon
Reporter™ Software 5.2 workflow version
which does not include smoothing of the
discrete tile data.

2 An analysis of the Demo Aneuploidy sample
run through the default ReproSeq workflow
in lon Reporter™ Software 5.4.
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Analysis number

Description

An analysis of the Demo Aneuploidy sample
run through the ReproSeq No Gender
workflow. Use of this No Gender workflow
generates analysis results that do not
record or display the called gender of the
sample in display or in data files; instead, a
called gender value of SxXChrNrml is given
when the sample is either a normal XY male
or a normal XX female with no sex
chromosome aberrations, or a gender call
of SxXChrAbnrml when the sex
chromosomes deviate from normal male or
normal female by either whole-
chromosome or sub-chromosomal
aneuploid events. Aneuploidies on
autosomes do not impact the called gender
value, and can be present in samples with
normal sex chromosomes.

An analysis of the Demo Aneuploidy sample
run through the ReproSeq Mosaic
workflow. Note that some chromosomes
can look like they were called aneuploid if
the copy number is called as CN loss
=ploidy 1.95, or CN Gain = ploidy 2.05 (as
shown in this example on chr1), and on the
Y chromosome as a slight policy gain. Gain
or Loss events with ploidy very close to
expected normal ploidy can be a result of
slight differences in normalization instead
of true biological ploidy changes.

Analysis 5 is an analysis of a spiked-in
sample that was mixed to have a chr9p
event of relative copy number ploidy of 2.5,
analyzed through the ReproSeq Mosaic
workflow. The two mixed samples consisted
of one male and one female, one of which
had an integer copy number gain of
ploidy=3 for chr 9 while the other sample
was normal ploidy=2 for chr 9, and the
mixing of these two samples of different
gender which can be seen in the observed
ploidies of the X and Y chromosomes.
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Navigate from variant to variant in IGV and lon Reporter Genomic
Viewer

You can use the links from the variant review table and coverage analysis table to
move from location to location in the same Ion Reporter  Genomic Viewer tab or in
the same IGV browser tab or window.

1. Click on one locus link to open the Ion Reporter™ Genomic Viewer or IGV
browser at the location of the relevant experimental data, panel files, and
genomic annotation sources. If opening IRGV, drag the newly opened IRGV's
web browser tab out to make it a separate window.

2. Click on another locus link in the Analysis Results table to navigate the browser
to the next variant.

Note: In some web browser versions, this functionality may be blocked for IGV. If
you click on subsequent variants, the next variant's locus is not selected, and a new
instance of IGV opens instead, use Ion Reporter Genomic Viewer or use a different
web browser for the variant-to-variant navigation.

Visualize aneuploidy analyses with lon Reporter Genomic Viewer

You can visualize aneuploidy results and generate reports with the Ion Reporter -
Genomic Viewer (IRGV). With this viewer, you can visualize multiple analyzes at
once.

1. Under the Analyses tab, click Overview.

2. Select one or more analyses then click Visualize from the Actions dropdown list.

Note: You can also click Visualize to complete this step.
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Visualize aneuploidy analyses with lon Reporter™ Genomic Viewer

The Analysis Visualization page opens to the IRGV tab. A copy number
histogram for each analysis selected appears, along with ploidy maps for
selected chromosomes or chromosome regions, and karyograms showing copy
number gains and losses.

Note: If you select multiple analyses generated from workflows with different
confidence filter settings, the software will use the lowest confidence filter setting
among the analyses and apply it across the group. You can adjust the Confidence
and Mapd filters with the slider controls in the lower right corner of the screen.

Example of an IRGV plot showing non-integer ploidy of the short arm of
chromosome 9, indicating that the sample was mosaic.
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Generate
aneuploidy report
with lon
Reporter™
Genomic Viewer
graphics
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3. To set preferences, click IRGV/Export » Show Ion Reporter Genomic Viewer

Preferences:
Table 5
Option Description
Use filter chain If set to True, smallest confidence filter chain value would be
Confidence value used as confidence filter. If set to False, the value set as
default confidence filter below will be used.

Default confidence If no filter chain is used in the analysis, or Use filter chain
value (if not filter Confidence value is set to False, then this value will be used
chain] as confidence filter by default.

Default mapd value This value will be used as default value in the Mapd filter.

Default sort order | The preferred sort order for Aneuploidy analyses (NR, CID, EID

or BIOPSY] for the summary table and tracks. NR sorts by the

analysis nr, CID sorts by couple ID, EID sorts by embryo ID and
BIOPSY sorts by biopsy days.

Analysis limit for Maximum number of analysis that will include BAM tracks in
BAM tracks IRGV [if available). Loading higher number of tracks would
result in longer loading time and also a crowded view.
Analysis limit for Maximum number of analysis that will include BED tracks in
BED tracks IRGV (if available). Loading higher number of tracks would
result in longer loading time and also a crowded view.
Limit for coverage By default, the maximum limit of 25000 is used. Reduce this
data number if you do not want to see the coverage data, or you

have problems with the browser, such as freezing.

Max number tracks | By default, 5 tracks are shown. You can set a value of 1 to 10.
in karyo When you increase the number of tracks, more space is used
in the Karyo view.

4. For each value that you want to change, click Edit next to the value that you want
to change, then enter a new value into the Edit Preferences window, then click
OK.

5. When your edits are complete, click Save Preferences.
Click Reset Preferences to reset all of the Preferences to the original values.

6. Select Open in IGV (download .jnlp file) from the IGV/Export dropdown list, or
click Download at the upper right to download a file from which to launch the
IGV application, or download the analysis results package.

When you visualize multiple aneuploidy results in Ion Reporter  Genomic Viewer,
you can generate a single PDF report that contains graphics from each results.

1. Under the Analyses tab, click Overview, then select the aneuploidy workflows
that you want to visualize in Ion Reporter™ Genomic Viewer.

2. ClickVisualize.
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3. Click Generate Report.

Note: For six or more aneuploidy analyses, the Whole Genome Karyoview is not
able to show Gain and Loss data segments.

A preview of the report is shown. You can customize the report.
4. Make changes to the report if desired. Enter an organization name for the report.

5. Click Download PDF.
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The report is downloaded to the location used for downloads from the browser. This
location depends on your browser settings.

Visualize other analyses with lon Reporter”~ Software

You can visualize any human DNA or RNA analysis type with the Ion Reporter
Software.

Note: When displaying Hotspots files as a track in IGV Browser, you may see
Hotspot annotations displayed in the track which were not used to call bases in the
data.

You can also visualize many at a time. In the example below, we look at DNA and
Fusions analyses.

1. Under the Analyses tab, click Overview.

Note: You can also launch Ion Reporter™ Software from the heatmap views
(variant impact, CNV, fusion plots) and from the variant review table and the
coverage analysis table. However, the preferences used for IGV Browser track
loading will differ depending on where the IGV browser is launched from, either
Analysis Results or Visualize > Multianalysis results.

2. Select one or more analyses and click Visualize.

In this example, the IRGV tab opens. The tab that opens depends the type of
workflows that you selected and the number of analyses.
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Click on the IRGV tab and view your results.

@ Analysis Whole Genome View labels - top left, show CNV confidence threshold and
MAPD threshold.

(2) Selected Chromosome bar - shows variant location on selected chromosome.
@ DNA coverage bars - show coverage data for CNV segments.

@ Annotations - at bottom, show annotation source results. You can click the gear
button and rearrange the annotation source tracks.

@ Chart View Options - top right, allow you to toggle between a DNA or an RNA view.

@ Sample/Analysis Summary - allows you to sort by Sample number and rearrange the
analysis rows on the left.

@ Search - allows you to search by chromosome coordinates or gene names
Confidence filter - allows you to set a CNV confidence level.

@ MAPD filter - allows you to set a threshold for the display of passed and failed MAPD
values.

IGV/Export - allows multiple export options, including export to the full IGV viewer
app, and access to preferences.

Use In+ and Out - to zoom in and out on the selected chromosome.
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Track order for Note: In the GRCh38 genome reference, there exist alternate loci which are not part

non-aneuploidy of the 1-22, X,Y chromosome contigs, and so are not annotated by the software (by

analyses design), for example chr22_K1270879v1_alt. Ion Reporter™ Software does, however,
annotate the GSTT1 gene which is also located on an alternate loci.

After the Whole Genome View of each non-aneuploidy analysis, the various data
tracks are loaded in this order by default:

(1) Selected chromosome ideogram

(2 Copy Number segment [.seg] file

B .vcffile

(® .bam track for each sample

(8 genome reference track

(® design .bed files and hotspot files

@ annotation tracks (COSMIC, ClinVar, and preferred transcript annotation tracks)
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When you zoom in on an analysis, you see the coverage histogram and reads from
the .bam track. The histogram in gray shows read depth at that location and reads
from the .bam track show read direction and location of variants.

Before you set preferences, generate an analysis visualization report for Aneuploidy
results. For details, see “Generate a report and include Ion Reporter = Genomic
Viewergraphics” on page 272.

You can modify the elements that are included in analysis visualization.

. Select one or more analyses in the Analysis Results screen, then click Visualize.
2. In the open Visualization, click IRGV/Export » Show IRGV preferences .

3. In Preferences you can set the following options:

Option

Description

Use filter chain
Confidence value

If set to True, smallest confidence filter chain value would be
used as confidence filter. If set to False, the value set as
default confidence filter below will be used.

Default confidence
value [(if not filter
chain)

If no filter chain is used in the analysis, or Use filter chain
Confidence value is set to False, then this value will be used
as confidence filter by default.

Default mapd value

This value will be used as default value in the Mapd filter.

Default sort order

The preferred sort order for Aneuploidy analyses (NR, CID, EID

or BIOPSY] for the summary table and tracks. NR sorts by the

analysis nr, CID sorts by couple ID, EID sorts by embryo ID and
BIOPSY sorts by biopsy days.

Analysis limit for
BAM tracks

Maximum number of analysis that will include BAM tracks in
IRGV (if available). Loading higher number of tracks would
result in longer loading time and also a crowded view.

Analysis limit for
BED tracks

Maximum number of analysis that will include BED tracks in
IRGV [if available). Loading higher number of tracks would
result in longer loading time and also a crowded view.

Limit for coverage
data

By default, the maximum limit of 25000 is used. Reduce this
number if you do not want to see the coverage data, or you
have problems with the browser, such as freezing.
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Option Description

Max number tracks | By default, 5 tracks are shown. You can set a value of 1 to 10.
in karyo When you increase the number of tracks, more space is used
in the Karyo view.

Max Ploidy in Whole | Maximum value of the Y-axis (ploidy) in the Whole Genome
Genome View View graphs.

4. Click Save Preferences and your selections are used when you visualize other
analyses. To restore the preferences to the default settings, , click Reset
Preferences.

Generate a report You can use the Ion Reporterm Genomic Viewer to create images for reports.

and mduge lon 1. When you have a view on the screen that you would like to use in a report, click
Reporter Generate Report.

Genomic

Viewergraphics 2. On the Visualization Report template, select the views you want to include by

dragging them from Available Sections to the Report.

3. Enter any other relevant information and then click Download PDF.
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Ton Reporter  Software leverages the Broad Institute Integrative Genomics Viewer
(IGV)http://software.broadinstitute.org/software/igv/home) to provide visualization

capabilities.

Note: When displaying Hotspots files as a track in IGV browser, you may see
Hotspot annotations displayed in the track which were not used to call bases in the

data.

The instructions vary slightly by platform and browser. These steps are for Chrome

browser on the Windows = operating system.

Follow these steps to visualize a variant in IGV:

™

1. Sign in to the Ion Reporter™ Software and click on the Analysis tab.

2. Click on the name of your analysis in the analysis table.

@ Analyses

Filter Analyses - Search 3 Refresh
O « L | Analysis Stage Created On » Status

0 1650C_195ep201 3_reanalysis_1385163543070 Variant Review Nov22201303:39PM  Successful

0 165X°°m*h”*m°usefd°g*21Nmm FVIBTABEEII et Review Mov22201311.25AM  Suceessul

0 NA12878_1386107719290 Analysis Mov 22 2013 12:08 &M Running - 12%
0 Dermo AmpliSed Exame VCF_1385024919500 Interpratation Assignment  Nov 21 201303:35PM  Successhul

L] Derma CCF paired Pubs Interpretation Assignment Moy 21 2013 0512 PW Successiul

0 1BSKItQC_20Nav2013_1385077570722 Variant Review MNov21 201303:46PM  Successiul

0o 1BSKItQC_12Mov2013_1 385076351047 Variant Review MNov21 201303:26PM Successful

0 1Dem° Metagenemics Mock Communit 138507293205 1yt Review NovZi 20130226 FM Successful

0o 1A12878 Tria_1383846031285 Interpretation Assignment Moy 2020120838 PM Suceessful

0 Demo AmpliSed Exame VCF_1 384994367002 Report Generation MNov2020130439PM  Successiul

3. In the Analysis Results page, click on the locus of a variant.

@ Analysis Results

Demo CCP paired Pubs

Functional Pog i Ontologi Pharmat i Qc
F |® | Locus = Genotype Control Genotype Ref Type Gene
[ chrl:2488153 MG MG A Sk LoC100133445
O ™ Fchrl:2494330 Gin GiA G ShY THFRSF14
O ™ §chrl 6579607 TIT TT [ Sk PLEKHGS
chrl: 9782556 CiT TT o] Sk Pl3CD
chrl: 9784423 CiT o] Sk Pl3CD
O chri: 11190804 cic GG o] REF MTOR
O chrl:11205058 CiT TT [ Sk MTOR ..{2)
O chri: 11288758 A AR G Sk MTOR
O chri 11301714 GG GIG A Sk MTOR

4. A notice appears in the browser download bar. Click the Keep button.
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5. Double-click the igv.jnlp link on the browser download bar (or the igv.jnlp
filename in the explorer).

@ igw. jnlp v

This image is an example of the IGV browser.

Note: When comparing different analyses in IGV that use the same samples or the
same panel files (but different algorithm versions, for example), the reads, read
counts, BED file, and other tracks will load only once in the browser. Only exact
duplicate tracks have this behavior of being loaded only once; any differences in
results data or input tracks between multiple analyses will trigger any and all unique
tracks to be loaded for visualization of the requested analyses.

IGV parse header error

IGV does not load variants and displays this error message when a VCF file uses
"CHR" instead of "CHROM" for a column header name:

Errors were encountered loading the session: Unable to parse
header with error: Your input file has a malformed header:
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unknown column name 'CHR'; it does not match a legal column
header name.

The Ton Reporter  Software annotation-only workflow successfully analyzes a VCF
file with a "CHR" column header name. The error is seen when you attempt to view
one of the variants in IGV.

To avoid this error, use the "CHROM" column header name in input VCEF files (for
example: #CHROM POS ID REF).

IGV unidentified developer error on Macs

The error message "igv.jnlp cannot be opened because it is from an unidentified
developer" is seen on Macintosh ~ computers, depending on security settings.

To open IGV after seeing this error, change either your Macintosh™ security
preferences or your browser settings to allow applications from unidentified
developers.

Run IGV as an applet

You can run IGV as an applet, even on a Macintosh ' computer.

1. Go to https://[IRServer]/IgvServlet/igvclient.html. Replace IRServer with your Ion
Reporter™ server address.

Note: To enable this on a Macintosh™ computer, you must enable the Java Plugin
in Safari and run it in "unsafe" mode. Otherwise it cannot access the local IGV
cache folder.

2. Go to Safari/Preferences/Security tab, then select Java plugin on the left.

3. Then select Run in Unsafe Mode and When visiting other websites.
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This section describes how to export and share data analysis results. Topics include:

Export data from the analysis table for single and multiple samples
Export data from the Variant Review page

Export results as a TSV file

Understanding interpretive reports

Interpret a VCF file

Share data from an lon Reporter Software analysis

276

Ion Reporter™ Software provides a simple mechanism to share data with anyone.
They do not have to be users of Ion Reporter™ Software.

By default, all data in your organization is visible only to users within your
organization. You can use share data with users from other organizations, even
though they do not have access to all of your data. Users whose permissions include
the analysis role can also share analysis reports.

When data from analysis is shared:

The people with whom you share data or analysis reports receive an email with
links to download the variant information (filtered and unfiltered) for DNA
datasets and species quantification data for metagenomic datasets. Registered
users of Jon Reporter™ Software can view the shared analysis in their
organization.

You are notified about the status of the share in your Ion Reporter Software Home
page. If you share data with registered Ion Reporter™ Software users, they also
receive notifications.

You are sent an email to confirm that the share is complete. If you shared the data
with multiple users at the same time, you will receive just one email for the entire
share.

When the share is complete, this icon =+ appears beside the report that contains
shared data on the Analyses Overview page for you and the recipients of the
shared data. When a share is in progress, you see this icon: 3.
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* The statuses in the messages that are shown at the top of the Analyses page are

as follows:
Table 6
Status Description
Sharing/Unsharing A share is in progress.
Shared The share is successful.
Failed The share failed. The notification
includes the reason for the failed action.
Note: The Analyses Overview page does
not show the latest status. It shows failed
status if any shares for that analysis has
failed.
Share analyses You can share data from lon Reporterm Software with anyone, whether or not they are
data users of the software.

Note: When a share is in progress, the analysis and the sample(s) associated with it

can not be edited, archived or deleted.

1. Inthe Analyses tab, select the analysis that contains the data that you want to
share, then click -ﬂI-Actions » Share in the analysis Details.
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2. Enter the email address of the person with whom you want to share data in the
Share Analysis dialog, then click Share.
A message about the status of the share opens briefly. When a share is in

progress, you see this icon: . You can continue with other tasks inlon
Reporter™ Software while the share is in progress. When the sharing is complete,
you and the recipients of the shared data see this icon beside the report that

contains shared data: = .

3. Click the Home tab, then click Notifications to view notifications about the
share.

Note: Variants cannot be flagged when an analysis report has been shared by a user

in another organization. The flag column on the on the Analysis tab and the option to
flag multiple variants are not available for shared analysis reports.
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Unshare analyses When you unshare an analyses data, the links to the data contained in the notification

data emails are inactivated. After you unshare the data, subsequent emails with
information about the unshare action are sent to both you and your destination users.
For Ion Reporter ' Software users, the copied analysis is removed from their
organization.

Note: This action can not be undone.

™

1. Log in to Ion Reporter™ Software, then click the Analyses tab.

2. Select the analysis that you want to unshare, then click £ Actions » Share in the
Details.

Note: This icon appears next to analyses that are shared in the Analyses list: +.
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3. Click the trash can icon fJ next to the user or users to unshare the dataset.

4. Click Confirm in the Unshare column to complete the unshare.

Search on the Analysis Results list

Most searching is better done with filters, rather than with the search field. For most
searches, use a filter instead.

Searches of analysis results can be performed in the Variant Review page using a
controlled vocabulary query language. This allows more advanced searches,
including OR and AND searches than is currently possible using filter chains. This
feature is available in both a single-analysis variant review table and a multi-sample
visualization table. However, the feature has only been tested on the single-analysis
variant review table.

Filter terms

Notation Meaning
key:value1,value2 key=valuel OR key=value?2
key:[min,max] min <=key <=max
key:(min,max] min < key < max
key:[min,] min <= key

key:[,max] key <= max

key:(min,) min < key

key:(,max] key < max

key:value* key contains value

key:* key exists (key has any value]
-key:value key !=value

The following keys are supported:
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Key Example
locus chr2:123456
function missense
location exonic
cosmic, omim, pfam, drugbank, go glioma
dbsnp rs12345

gene, transcript

TP53, NM_01010.1

maf [0.0,0.05]
coverage [1000°]

sift, polyphen, grantham ['0.05]

type INDEL
comment something*
vkb *

Search field behavior is different here on the variant table in the Analysis Results
page, than for searches on other pages.

"vbk" in the table above stands for My Variants.

Asterisks (*) for some variant table searches on the Analysis Results page

* An asterisk (*) in the search field is only allowed on the Analysis Results page.

* An asterisk (*) is required for some searches here, but is not allowed for other
searches. The differences are due to how the different types of information are

stored.

e The asterisk is a search wildcard. Without the asterisk, searches only match the

exact string entered. With asterisks both before and after your search string,

matches at the beginning, middle, and end are all found.

Recommended search with asterisks

* Asterisks are useful to search for matches in any annotation source. (By contrast,
a filter search matches only one annotation source.)

¢ This example shows a search for *carcinoma®.
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This search lists all variants that have an OMIM, COSMIC, ClinVar, DrugBank,
and so on, annotation that contains "carcinoma" anywhere in the annotation.
Click the detail icon [E] for one [W® of the matched variants to open its variant
detail card. Scroll down to fine the entries that contain "carcinoma".

Variant Details: chr1:881627

Variant Details Hotes

Annotation Source Annotation Value
AMAF 01562

Allele Coverage G=5 A=176

Allele Fatio E=0.03, A=0.97
Amino Acid Change WT

COsSMIc adendgearcinoma

Searches without asterisks

* To search for a locus, enter the complete locus entry, with chromosome number
and full position number.

® Do not use an asterisk (*) for a locus search. Searches on a chromosome number
by itself or with a partial position number also are not supported.

¢ For other information, use a filter.
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Search terms within a filter chain also do not allow an asterisk.

Create Filter Chain

Mame Description
Sene Ontology b
keratin Search

Value

keratinization

keratin filarment

O 0010

keratinocyte differentiation

Examples

lon Reporter™ Software 5.6 Help

(gene:TP53 OR (function:missense,nonsense AND (maf:
[0.0,0.05} OR —-dbsnp:*))) OR type:CNV

This retrieves all variants that fall in TP53, all CNVs, plus variants that have a
functional impact of missense or nonsense AND either have a minor allele
frequency less than 0.05 or are noval (not found in dbSNP).

cosmic:carcinoma* AND ((type:SNV AND sift:[0.0,0.10]) AND
coverage: [300,] OR locus:chrX

This retrieves all SNV variants annotated with COSMIC histology terms

containing "carcinoma" with a deleterious SIFT score ( <0.10) and high coverage(>
300), plus any variant that falls on chromosome X.
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This section describes how to generate reports, including:
¢ Auditlog - analysis
¢ Audit log - sample
* QCreport

¢ Final report

Reports

Ion Reporter™ Software provides a wide range of reports that are generated as part of
each analysis.

* Audit log - analysis

¢ Audit log - sample

* QCreport

¢ Final report
Each of these reports is explained in the following sections.

Note: Each report can be viewed directly in the UI and can be exported as a PDF file.
The report layout is different in the UI than in the PDF.

Customize PDF New in Ion Reporter'M Software 5.4, you can customize reports in more ways than in
reports previous versions.

1. Inthe Analyses tab, select the Overview subtab.

2. Select the analyses to be included in the report, by clicking the checkbox next to
each analysis. See the figure in step 3.
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Generate reports
Reports

4. In the Select Final Report Template dialog, select a template, then click OK, or
click Create Report Template to create a new report template.

5. Click the section blocks to edit, delete, or move up or down in the report.

6.

lon Reporter™ Software 5.6 Help

Deleted section elements are moved to the right under Available Sections. Click
and drag back to the left if you decide you need them for your report.

Enter information.

Category

Description

Organizational information

e Date: Date and time when the report
was created.

. Required: Organizational name.

. [Optional/Upload a logo and/or
enter the address

Background (Optionall Enter background information

Comments [Optional/ General comments

Sign-0ff Affix an author's name and qualification
to the report

Disclaimer (Optional/Enter a custom legal

disclaimer.
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7. To select annotations, click the appropriate checkbox.
8. Edit Analysis or Sample information by clicking a topic in either section.

9. (Optional)To customize the report display, in the Reported Variants section, click
Select Columns.

Option Description

Add or delete Select one of the following:

columns. e Select a column button in the Select Reported Columns

dialog to delete that column.

e Click Select Columns in the Reported Variants section to
open a menu, then click a column to add, remove, and
rearrange columns.

Change column | Drag a column button in the Select Reported Columns box to the
order desired position.

10. Click Next.
A preview of the PDF report opens. Click Previous to go back and change the
report.

11. When you are satisfied with the report sections, click Lock and Publish. A
warning appears. Click Publish.

12. Click Download to download the publication in PDF format.
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Access Audit log - analysis

The analysis audit log allows you to see which users have accessed a particular
analysis and what was done by that user. Follow these steps to access the analysis
audit log for a completed analysis:

1. Find your analysis in the analysis table and click its row to highlight it (do not
enable its checkbox).

2. In the Actions menu, select Audit Log.

lon Reporter™ Software 5.6 Help 287



Generate reports
Access Audit log - analysis

3. The audit log opens.
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4. (Optional) Download a PDF of the audit log from the Export menu. Select PDF.
(The downloaded filename is analysis_id_audit_log.pdf, where id is a system-

generated analysis id.)

The analysis audit log contains three sections.

Section

Description

Analysis information

Meta-information on the analysis that was
performed

Sample information

Meta-information on the samples that are
part of the analysis

Log information

The individual events that have been logged
for this analysis including: date / time, user,
action, and details on the action performed
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Access Audit log - sample

The sample audit log allows you to see which users have accessed a particular sample
and what was done by that user. Sample audit logs are not available for the pre-
installed demo data samples.

Follow these steps to access the sample audit log:

1. Find your sample in the sample table. Click the sample to highlight it.

2. Inthe Actions menu, select Audit Log.

3. The audit log opens.

290 lon Reporter™ Software 5.6 Help



Generate reports
View Quality Control (QC) report

4. (Optional) Download a PDF of the audit log from the Export menu. Select PDF.
(The downloaded filename is sample_name.pdf, where sample_name is the name of
the sample.)

View Quality Control (QC) report

You can access a Quality Control (QC) report for a completed analysis in Ion
Reporter  Software. The QC report provides a high level summary on key metrics for
a particular analysis to assess the quality of the data.

1. In the Analysis tab, click Overview.

2. Find the analysis of interest, then select the row that lists the analysis to generate
a QC report.

Note: Alternatively, you can select the checkbox in the row to generate the QC
report.
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3. Click Actions » View QC Report.
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The QC Report opens:
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4. (Optional) Click Export » PDF to download a PDF version of the QC report. Select
PDF, then download the file through your browser.

The filename for the PDF is id_QC.pdf, where id is a system-generated analysis

identifier.
Quality Control You can access a Quality Control (QC) report for a completed analysis in Ion
(QC) report Reporter™ Software that provides a high level summary on key metrics for a
contents particular analysis to assess the quality of the data. The QC report contains three
sections:
Section Description
Analysis Information Meta-information on the analysis that was
performed
Sample Information Meta-information on the samples that are
part of the analysis
QC Metrics Quality and variant summary information

QC metrics that are available for QC reports are as follows.

QC Metrics field Description

Total Number of Reads Total number of reads

Total Number of Bases (Mbp) Total number of bases, in million base pairs

Total Number of Bases (AQ20)(Mbp) Total number of bases at AQ20 (1% error
rate) accuracy, in million base pairs

MAPD Median Absolute Pairwise Difference, a
metric for noise in Copy Number data

Mean Coverage Depth (fold) Mean depth of coverage

Coverage within Target Region Coverage with target regions (defined by

the input regions of interest file)

Mean Read Length (AQ20) Mean read length at AQ20 (1% error rate)
accuracy

Mean Read Length (AQ30) Mean read length at AQ30 (0.1% error rate)
accuracy

Number of Homozygous SNVs Number of homozygous SNV calls

Number of Homozygous Indels Number of homozygous indel calls

Number of Heterozygous SNVs Number of heterozygous SNV calls

Number of Homozygous MNVs Number of homozygous MNV calls

Number of Heterozygous MNVs Number of heterozygous MNV calls

Number of Heterozygous Indels Number of heterozygous indel calls

Ti/Tv Ratio (SNPs) Ratio of transition to transversion

substitutions
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QC Metrics field

Description

dbSNP concordance

Overall dbSNP concordance

The ratio of the number of SNP and indel
calls that appear in dbSNP with hit level
“locus” or "allele”, to the total number of
SNP and indel calls.

Heterozygotes/Homozygotes

Ratio of heterozygotes to homozygotes

This ratio is calculated from SNP and indel
variants only. MNVs are not considered.

Indels/Total Ratio of indel calls to all variant calls

Indels/kb Number of indel calls per thousand bases
For an analysis that uses a regions of
interest BED file, the number of bases in
those regions is used.

SNPs/kb Number of SNP calls per thousand bases

Total Mapped Fusion Panel Reads

Sum of all reads for Fusion variants and for
ASSAYS 5P 3P, and
EXPRESSION_CONTROL markers on a
fusion panel

Expression Controls Total Reads

Sum of all reads that are assigned to all of
the expression control targets in the
sample. If panels contain multiple pools,
ExpressionControlTotalReads is the
aggregate sum from all expression control
targets in all the pools.

POOL-n Expression Control Total Reads

The sum of expression control reads for
individual reads are also reported
separately as POOL-1
ExpressionControlTotalReads and POOL-2
ExpressionControlTotalReads, and so on.
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View Quality Control [QC] report

About the QC The coverage distribution is calculated for each region and reported in the No, Low,
package coverage Medium, and High columns based on the values of Bamstats input parameters.

columns These Bamstats parameters (which are set when the workflow is created) control the
reporting of the coverage distribution in the coverage statistics files:

* Maximum Coverage

DZfF[: Create Workflow

Application Reference Annotation Filters Copy Humber Plugins

Warning! It's

semings w

These are configurable runtime parameters to optimize your workflow. Fixed and community panels imported
from AmpliSeq.com include optimized variant calling parameters. Learn more.__.

¥ Annotation Advanced
» Bamstats

> Cnv Finding

) ) Maximum Coverage
¥ Primer Trimmer

Maximum Coverage of a locations in the reference. Locations with coverage more
than the maximum caoverage values will ke ignored during coverage calculaitons.

100 == 100000 | <= 1000000

» Read Mapping
¥ Variant Finding

Maximum read length

Maximum read length

700 <= 700 <= 20000

(Main parameter tab)
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Generate reports
View Quality Control (QC) report

e Maximum Medium Coverage (QC)

lon Reporter™ Software 5.6 Help

ﬁﬁ: Create Workflow

Application

Reference Annotation Filters Copy Humber Plugins

Warning! It's not recommended to change these defaults unless you know what you're doing. Invalid

settings will NOT be saved

These are configurable runtime parameters to optimize your workflow. Fixed and community panels imported
from AmpliSeq.com include optimized variant calling parameters. Learn more...

% Annotation

¥ Cnv Finding

¥» Primer Trimmer
¥ Read Mapping
$ Variant Finding

Max mapping qv
Maximum mapping quality value. Any alignment with mapping quality value more
than the specified value will be ignored.

0=<=| 255 <= 2585

Max mismatches

Maximum mismatches allowed in the alignments. Any alignment with more then
the specified number of mismatches will be ignored while generating reports
related to number of mismatches.

0 == 500 <= 500

Max base qv

Max base quality values. Any base with base guality value more then the specified
value will be ignored while generating reports.

0 == 100 <= 100

Minimum Target Overlap Reverse

The fraction of an alignment that must be overlapped by a target in order to be
classified as on target

0.0001 == 0.5 =1

Maximum Medium Coverage (QC)

Max Medium Coverage value. Any base with coverage value more then the
specified value will be ignored while generating reports. Value of Maximum
Medium Coverage (QC) should be greater than Maximum Low Coverage (QC).

2 <= 1000

Maximum Low Coverage (QC)

Max Low Coverage value. Any base with coverage value more then the specified
value will be ignored while generating reports. Value of Maximum Low Coverage
(QC) should be less than Maximum Medium Coverage (QC).

1 == 500

Minimum Target Overlap Forward

The fraction of an alignment that must be overlapped by a target in order to be
classified as on target

0.000001 <= 0.000001 <=1 297
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Generate reports
View Quality Control [QC] report

(Advanced parameter tab)
e Maximum Low Coverage (QC)

ﬁ{?" Create Workflow

Filters Copy Number Plugins Final Report Confirm

Warning! It's not d to change these defaults unless you know what you're doing. Invalid Summary
settings will
These are configurable runtime parameters to optimize your workflow. Fixed and community panels imported Application: DA
from AmpliSeq.com include optimized variant calling parameters. Learn more. Sample Group:  Single
Reference: hg19
9 Annotation Main
tain Target Regions: lon AmpliSeq CHPv2 Regions

3 Bamstats
Variant Type

¥ CnvFinding Germline

Max mapping qv Detection:
% Primer Trimmer
» Read Mapping Maximum mapping quality value. Any alignment with mapping quality value mare H°t5°°t‘ lon AmpliSeq CHPv2 Hotspots
than the specified value will be ignored. Regions:
$ Variant Finding
0<= 255 <= 255 Annotations: All
Report §
Max mismatches —— Default Final Report Template
Maximum mismatches allowed in the alignments. Any alignment with more then
the specified number of mismatches will be ignored while generating reports
related to number of mismatches
0<= 500 <= 500
Max base qv =~

Max base quality values. Any base with base quality value more then the specified
value will be ignored while generating reports

0== 100 <=100

Minimum Target Overlap Reverse

The fraction of an alignment that must be overlapped by a target in order to be
classified as on target

0.0001 <= 05 <=1

Maximum Medium Coverage (QC)

Max Medium Coverage value. Any base with coverage value more then the
specified value will be ignored while generating reports. Value of Maximum
Medium Coverage (QC) should be greater than Maximum Low Coverage (QC).
2<= 1000

Maximum Low Coverage (QC)

Max Low Coverage value. Any base with coverage value more then the specified
value will be ignored while generating reports. Value of Maximum Low Coverage
(QC) should be less than Maximum Medium Coverage (QC).

1<=| 500

Minimum Target Overlap Forward

The fraction of an alignment that must be overlapped by a target in order to be
clagsified as on target
0.000001 <= 0.000001 <=1

(Advanced parameter tab)
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Generate reports
View Quality Control (QC) report

This table shows how the Bamstats coverage parameters affect the coverage reporting
in the coverage statistics files:

Coverage column Description
No Zero coverage (not controlled by Bamstats
parameters)
Low Values from 1 to

Maximum Low Coverage (QC)

Medium Values from 1 more than

Maximum Low Coverage (QC)

to

Maximum Medium Coverage (QC)

High Values from 1 more than

Maximum Medium Coverage (QC)

to

Maximum Coverage (QC)
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Generate reports

Download Quality Control [QC) files

Download Quality Control (QC] files

300

You can download files from a Quality Control (QC) report that you open in Ion

Reporter  Software. The compressed directory contains the following Quality Control
(QC) files:

QC/id.pdf: A copy of the QC Report PDF file.

QC/sample name/AnnotatorActor/variome-stats.csv: A tab-separated
file of variants statistics for this sample. These statistics are also listed in the QC
report PDF file.

QC/sample name/StatsActor/

amplicons low no coverage statistics.txt:Coverage statistics by
amplicon.

QC/sample name/StatsActor/

analysis low no coverage statistics.txt :Coverage statistics for the
analysis.

QC/sample name/StatsActor/

genes low no_ coverage statistics.txt :Coverage statistics by gene.

. In the Analysis tab, click Overview.

Find the analysis of interest, then select the row that lists the analysis to generate
a QC report.

Note: Alternatively, you can select the checkbox in the row to generate the QC
report.
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Generate reports
Download Quality Control (QC) files

Click Actions » View QC Report.
The QC Report opens:

Click Export » QC Package to download the QC Package to Ion Reporter™
Software.

™

¢ If you use Ion Reporter™ Software in the Thermo Fisher Cloud, open the
Home tab, then click J¥ to open the notifications list and find, then
download the QC package download.

¢ If you use Ion Reporter™ Server Software, use the browser to download the
file, then find the QC package in the folder used for downloads.

The downloaded filename is qc-report-id.zip, where id is a system-generated
analysis id.
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Generate reports
Download Quality Control [QC) files

The following fields are in the * coverage statistics.txt files:

Column

Description

#1d

The amplicon id or gene name (if any)

Region

Usually the chromosome that contains
the amplicon, gene, or hotspot region

Start

Initial position of the amplicon, gene, or
hotspot region

End

End position of the amplicon, gene, or
hotspot region

No

Number of reads with zero coverage

Low

Number of reads with low coverage

Medium

Number of reads with medium coverage

High

Number of reads with high coverage

TargetSize

Region size (in bases) of the amplicon,
gene, or hotspot region

Min

Minimum coverage of any base in the
amplicon, gene, or hotspot region

Max

Maximum coverage in the amplicon,
gene, or hotspot region

Avg

Average coverage in the amplicon, gene,
or hotspot region

1XBases

Number of bases with at least 1X
coverage in the amplicon, gene, or
hotspot region

AvgBQ

Average base quality value
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Final report

Final report

The final report provides a high level summary on key metrics for a particular
analysis to assess the quality of the data. The analysis must be in the "Report
Published" stage.

The gene field in this report is comprised of
GeneSymbol_ExonNumber_Locus_Transcriptld_Classification.

Follow these steps to access the final report for a completed analysis:

1. Find your analysis in the analysis table and enable its checkbox.

2. In the Actions menu, select View Final Report.
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Final report

3. The final report opens. Here is an example:
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Amplicon Coverage Report

4. (Optional) Download a PDF of the final report from the Export menu. Select PDF.
(The downloaded filename begins with analysis report.)

5. Optional) From the Final Report page, use the Switch To menu to view either the
audit log or the QC report.

Amplicon Coverage Report

You can now generate a per-amplicon report in Ion Reporter™ software v5.2. You can
see which amplicons, SNPs, and bases in an amplicon, and which fall below a certain
level of coverage that you set as a threshold for coverage.
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Amplicon Coverage Report

Generate 1. Go to Analyses » Overview and select an analysis.
Amplicon

Coverage Report 2. Click Actions » View Coverage Report.

The initial table displays all amplicons. In the Filter Options pane, the Coverage
Threshold default is set to 0.

3. Enter a threshold value, for example 60, and click Filter. To make this a default
filter, click Save.

The table now displays amplicons less than 60.

Note: You must save the filter in order for the % BED region > threshold, %
amplicons > threshold, and Coverage Threshold metrics to appear in the QC
Report.

% amplicons > threshold provides the filtered out percentage.
% BED region > threshold provides the percent greater than threshold.
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Amplicon Coverage Report

4. To view the results in the QC Report format, click Switch To » QC Report.

Note: You can also use the Switch To menu to view the Audit Log or Analysis
Results table.

5. Scroll down to the QC Metrics section and you'll see results for % Bed region >
threshold, % amplicons > threshold, and Coverage Threshold.

6. To view an amplicon in IGV Light viewer, click on the amplicon link and IGV
Light displays the results visually.
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Administer lon Reporter Software

This section provides an overview of basic administrative functions for Ion Reporter"™

1

Software. Most of the procedures and functions described in this section require
administrative permissions for an organization that you administer. Where indicated,
procedures apply to either Ion Reporter™ Software that is installed on local servers or
to Ion Reporter™ Software in the Thermo Fisher Cloud.

Create multiple lon Reporter  Software server users

308

Note: This information applies only to Ion Reporter  Software server.

You can create a spreadsheet that contains user information and then upload it to

create multiple Ion Reporter = Software users.

Note: Use a minimum of two letters for first and last names for user accounts.

™

* Signin to Ion Reporter ™ Software as an administrative user, then click the Admin

tab.

¢ C(lick Create User » Batch, then click download examples on the Import Users

page.

* Open the UserDefinitionTemplate.csv that is downloaded through the browser.

e Enter information for each new user that you want to create into the following

columns of the spreadsheet:

Table 7
Column name Description
First Name First name of the account user
Last Name Last name of the account user
Emailld Email address of the account user. The
email address will be used as the user ID
when the user signs in. For example,
user(institute.com.
Import Role Enter 1 to assign the Import role
Analyze Role Enter 1 to assign the Analyze role
Report Role Enter 1 to assign the Report role
Administrator Enter 1 to assign the Administrator role

¢ Save the spreadsheet to a file directory on your hard drive or in a location that

you can get back to.
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Set or reset the password on a user account

Set or reset the password on a user account

Note: After you set or reset a password, you must notify the user about the new or
updated password.

A user becomes locked out after five attempts to log in with an incorrect password.
The administrator must reset the password to unlock the account. There are two
mechanisms to set or reset the password for a user account.

On the Ton Reporter  Software server:

™

1. Sign in to Ion Reporter™ Software, then click the Admin tab.

2. Select the user account in the Userslist (without clicking on the hyperlink for the
account), then select Reset Password from the -I:I- Actions drop-down menu in
the User Details.

3. Enter the new password and re-type the password in the Reset User Password
dialog.

Reset User Password

Password

Cancel

4. If you are certain that you want to change the password, click Confirm.

5. Notify the user that the password has been reset, and give the user the new
password.

Modify the permissions of a user

Follow these steps to modify the permissions of a user in Ion Reporter = Software:

1. Signin to Ion ReporterTM Software and click the Admin tab, then click the user
account in the Users list (without clicking on the hyperlink for the account).

2. Click Edit in User Details.
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Modify the permissions of a user

3. In the Roles area of the Edit User dialog, modify the user permissions.

4. (Optional) Select Requires private folder if you want to give the user the
authority to restrict all visibility to their data. For details, see “Enable or disable

private folders” on page 313.

5. Click Save.
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Disable a user

Disable a user

You can disable an Ion Reporter ~ Software account. When you disable an account, the
email address is not available to be reused for a different user account. If you want to
reuse the email address, you must delete the user.

1. Sign in to the Ion Reporter™ Software. Under the Admin tab, in the Users screen,
click the hyperlinked email address of the user.

2. In the Edit User dialog, select Disabled in the Status dropdown list, then click
Save.

You are returned to the Users page. The user account is disabled. You can re-
enable the account at any time.

Delete a user

Note: This action can not be undone.

When you delete a user, the email address for that user can be reused for a different
user account.

1. Sign in to Ion Reporter™ Software and click the Admin tab.

2. Select the user in the table (without clicking on the hyperlink for the account),
then click £¥Actions » Delete in the User Details:

3. If you are certain that you want to delete the user, click Yes to confirm this
deletion.

The user account is deleted.
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Manage the AP/ token

Manage the API token

The API token is used to upload data to the server version of Ion Reporter  Software
and access data from the API. These steps can be performed by either an
administrative user or a regular user.

The API token is like a password. When you generate a token, it is similar to resetting
a password and existing users become locked out.

Note: Under most circumstances, you should not generate a new API token if one
already exists.

Two functions of the IonReporterUploader plugin do not work when you regenerate
the token. The functions and the steps to recover functionality are as follows:

e IonReporterUploader plugins that are configured with your Ion Reporter
Software account. To recover, in IonReporterUploader plugin configuration in
Torrent Suite” Software, retype your password, then click Update .

e Scripts or code that access the Ion Reporter  Software API with your previous
token. To recover, use your new token with those scripts.

Follow these steps to access your API token:

1. Sign in to Ion Reporter™ Software and click the Admin tab.
2. Click £ifActions » Manage API Token.

3. In the Manage API Token dialog, if the API Token field is blank, click Generate
to create your token.

If a token already exists, click Generate to generate a new one.

A new token is created. The functions noted above will no longer work with the
new token until you perform the described actions.
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Enable or disable private folders

Enable or disable private folders

Private folders enable a user to restrict all visibility to their data.

IMPORTANT! If a user stops using a private folder, all data generated in that folder
can no longer be accessed.

Note: This functionality is only available for the Ion Reporter ~ Software sever. It is
not available for Ion Reporter Software in the Thermo Fisher Cloud.

Follow these steps to enable or disable a private folder in Ion Reporter  Software:

1.

lon Reporter™ Software 5.6 Help
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Sign in to Ion Reporter™ Software as an administrative user, then click on the
Admin tab.

Select the row for the user in the Users list, then click Edit in the User Details.

In the Edit User window, select or unselect Requires private folder, then click
Save.

IMPORTANT! If a private folder is disabled anytime after it is enabled, data that
was generated in that folder can no longer be accessed. A new private folder is
created if you reselect 'Requires private folder', and all data generated in the
previous private folder remains inaccessible.

After a private folder is enabled, the data, analysis and workflows created by that
user and generated in that folder is visible only to that user.

313



Administer lon Reporter™ Software
Delete custom annotation sources

Delete custom annotation sources

Custom annotation sets created by users are displayed in Workflow Presets screen.
An administrator can view and delete custom annotation sources created by users.

1. In the Workflows tab, click Presets.

2. Click Annotation Sets » Annotation Source.

A table that lists the custom annotation sources opens. It shows the following
information about the annotation: name, version, source version, reference,
created by, created on, and source type.

3. Click the custom annotation source that you want to delete in the Workflow
Presets list, then click Settings (-l:!-) » Delete.

Note: If an annotation source is used in a workflow, it cannot be deleted.

The annotation source is removed from the Workflow Presets list.
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Manage system services

Manage system services

Note: This procedure applies only to system services that are related to Ion Reporter -
Software server.

1. Sign in to your Ion Reporter™ Software server with your administrator account.

2. Inthe Admin tab, click the System Services subtab.

3. Click System Services subtab to display data for servers that are connected to the
Ion Reporter™ Software.

The pane displays the following information.

Parameter Description
Name Identifies services.
Status Running or stopped.
Actions Click any of the following buttons:
o Restart: restart a service.
o Start: Start an service.
U Stop: Stop an service.

4. Click Configure Services subtab, then enter the number of concurrent analyses
that can be run.

9. Click Download All Logs to down load zip files of logs to your desktop.

6. To power off the IR server, click Shutdown IR Server subtab, then click the
Shutdown IR Server button.

IMPORTANT! All processes are stopped as a result.
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Download plugins from Themo Fisher Cloud

The AmpliSeq RNA and RNASeq plugins can be downloaded from the Thermo
Fisher Cloud, then installed into the Ton Reporter  Software. See “Install and uninstall
plugins” on page 316 for details to install the plugins.

1.

2.

In a web browser, go to https://apps.thermofisher.com/, then sign in.

Click on the apps icon (=58).

In the apps dashboard, click Plugins.

(Optional) Click a category at the top of page.
The list of plugins is narrowed to only plugins included in the selected category.

Click ¥, to download the plugin. Enable the checkbox next to indicate that you
agree to the End User License Agreement (EULA), then click Download Plugin.
A compressed directory that contains the plugin is downloaded to your local
machine.

Install and uninstall plugins

Note: The following steps apply only to lon Reporter Server.

Only administrators can install plugins for their IR organization.

1.

2.

7.

8.

In the Admin tab of the Ion Reporter screen, select the Plugins subtab.

Click Install Plugin.
The Upload Plugin file dialog appears.

Click Select file.
Select the file for the plugin, then click Open.

Note: Only .zip files of the plugins are supported.
The file to be uploaded appears in the file text dialog.

Click Upload.
A confirmation appears in the Upload Plugin file dialog.

Click Close.
¢ The plugin is added to the list of plugins.
¢ Installed plugins are automatically enabled.

Select a plugin by clicking the checkbox (left-most column).

(Optional) to uninstall, click Actions, then select Uninstall.

See “Run a plugin as part of a workflow” on page 129 for instructions on how to run a
plugin.
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Install and uninstall plugins

See “Guidelines to develop lon Reporter plugins” on page 421 for information on
how to create custom plugins for Ion Reporter  Software.
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Troubleshooting

This section provides some basic information on how to troubleshoot any issues you
may be having with Ion Reporter™ Software. If you do not find the answer to your
question here, please contact Support.

Provide feedback

Information on how you can provide feedback on Ion Reporter ~ Software can be
found in the FAQ section of the help guide.

Contact support

Information on how you contact support for any questions on Ion Reporter = Software
can be found in the FAQ section of the help guide.

If you cannot open the analysis

Sometimes the analysis name is in plain text and does not provide a link to open the

analysis.
& Analyses
Filter Analyses - Search 5 Refresh

F g ; 3 Analysis Staye Created On v Status
O Demo CCP paired Pubs 2 Analysis Moy 27 201312027 FM Running - 15%
(] Demo AmpliSeq CHPY2 tumor_13855432051904 Interpretation Assignment Moy 27 2013 01:19 Ad Successful
O 163QC_195ep201 3 reanalysis_1385163543070 Wariant Review Moy 22 2013 0339 PM Successiul
O TEsHeont_hu_mouse_dog_21Mov2013_1385148486097 Variant Review Moy 22 2013 11:28 AM Successul
O Demo AmpliSeq Exome YCF_138508458193500 Interpretation Assignment Mov 21 2013 08:35 Fu Successful
(] Demo CCP paired Puhs Wariant Classification Moy 21 20130512 P Successful
O TEsKIQC_20Mov2013_1385077578722 Yariant Review Mov 21 2013 0346 FM Successiul
F 16sKItQC_12Mov2013_1385076351047 Wariant Review Moy 21 2013 03:26 FM Successful
O Demo Metagenomics Mock Community_1385072832051 Wariant Review Mov 21 2013 02:28 PM Successful
O MAT2878 Trio_1383846931295 Interpretation Assighment Moy 20 2013 02:38 PM Successiul
O Demo AmpliSeq Exame YVCF_1384084367092 Report Generation Moy 20 2013 04:38 FM Successful

318

lon Reporter™ Software 5.6 Help



Troubleshooting
/f someone else is already editing the analysis

This scenario can happen for the following reasons:

¢ The analysis is still running. The analysis can be edited when the processing is
complete.

e The next stage is Variant Classification and you do not have the required Report
Role permissions.

¢ The interpretive report is already published for the analysis, and editing is not
possible. In this case, the stage is "Report Generation".

If someone else is already editing the analysis

If someone else is already editing the analysis, you see a checkmark in the "being
edited" column of the analysis table in the Analysis Overview tab.

You can still open the analysis in view-only mode. A banner at the top of the Analysis
Results page names the user who is editing the analysis and notes your view-only
mode.

@ Analysis Results
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Annotation sources

Ion Reporter™ Software provides a variety of annotation sources from a wide range of
public resources. You also have the option to import your own annotations sources if
you want to add custom annotation data. Both types of annotation sources are for use

™

directly in Ion Reporter™ Software.

Annotation sources available in lon Reporter  Software

plon Reporter ' Software provides several annotation sources are derived from public
and private annotation databases for hg19. Ion Reporter ~ Software also provides
factory-shipped annotation sets. An annotation set is a collection of annotation
sources that you can use to annotate variants in your analyses. You can use the
factory-shipped annotation sets or create custom annotation sets.

To add custom annotation sources to an annotation set, see “Import new or custom
annotation sources” on page 326.

Table 8 Annotation sources included in lon Reporter™ Software

Annotation Description Source

5000 exomes Population frequency information | NHLBI ESP
from the 5000 exomes project

Allele coverage Number of reads supporting the | lon Reporter" Software
called allele

Allele frequency | Frequency of the allele observed | lon Reporter™ Software
from the raw data

Amino acid Amino acid change lon Reporter™ Software
change
Genetic category | Genetic category lon Reporter™ Software
Note: For use with trio workflows
only.
ClinVar Assessment of impact of the ClinVar

variant observed from NCBI
ClinVar database

Coding Nucleotide change lon Reporter™ Software
Copy number The copy number ploidy state lon Reporter™ Software
COSMIC Catalog of somatic mutations in COSMIC

tumor tissue
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Annotation sources

Annotation sources available in lon Reporter™ Software

Annotation

Description

Source

Coverage

Total coverage for a variant

lon Reporter™ Software

Custom

See “Import new or custom
annotation sources” on
page 326for more information

lon Reporter™ Software

Cytogenetic band

The cytogenetic band where the
CNV was detected

Note: For use with aneuploidy
workflows only.

lon Reporter™ Software

Note: For use with trio workflows
only.

DRA Disease Research Area lon Reporter™ Software
dbSNP Single Nucleotide Polymorphism | dbSNP
database
DGV Database of Genomic Variants: A | DGV
curated database of human
genomic structural variation
DrugBank List of drugs known to target the | DrugBank
gene(s] affected by the variant Note: When you create an hg19
annotation set, do not use the
annotation source DrugBank
version 20150107. Use instead
annotation source DrugBank
version 1 or DrugBank version
20161212. If you use the
DrugBank version 20150107 in an
hg19 annotation set, you will not
be able to create filter chain of
DrugBank for any analysis that
uses the annotation set.
ExAC Exome Aggregation Consortium: | ExAC
Database catalog of variant
frequencies
Father genotype | Genotype of father lon Reporter™ Software

FATHMM scores

Prediction of the functional
consequences of a variant. In lon
Reporterm Software, FATHMM
scores are available for COSMIC
version 77 and later. These scores
are populated when "COSMIC" is
chosen as a part of the annotation
preset that is used.

COSMIC

Gene models

Set of genes the variant overlaps

RefSeq

Ensembl

lon Reporter™ Software 5.6 Help
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Annotation Description Source
Gene panel Filter variants based on specific lon Reporter™ Software
amplicon in an AmpliSeq panel.
For example, lon AmpliSeq CCP.
Gene set Focus on variants found withina | lon Reporter" Software

specific set of genes

Genetic category

The genetic category. For
example, compound heterozygote
of the variant identified.

Note: For use with trio workflows
only.

lon Reporter™ Software

Genotype

Genotype of the sample in each
position

lon Reporter™ Software

Gene Ontology

Standardized ontology for gene
and gene products. For example,
functional role or localization.

GO

Grantham score

A measure of evolutionary
distance. See “Grantham
score” on page 342.

lon Reporter™ Software

Hotspot
information

If variant overlaps a hotspot file

lon Reporter™ Software

Location

Position of the variant. For
example, exonic.

lon Reporter™ Software

Locus

Position of the variant

lon Reporter™ Software

MAF

Population frequency information
from the 1000 genomes project.

MAF numbers are provided by the
dbSNP in lon Reporter™, which
gets the MAF numbers from 1000
genomes. Therefore, the version
of dbSNP annotation sources used
within the lon Reporter™ analysis
may impact these MAF values.

1000 Genomes

Mother genotype

Genotype of mother

Note: For use with trio workflows
only.

lon Reporter™ Software

MyVariants

A personal knowledge base of
genomic variants (Formerly,
VariantKB database)

lon Reporter™ Software

Named Variants

An lon-supplied list of known
variants in the CFTR gene panel

lon Reporter™ Software
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Annotation sources available in lon Reporter™ Software

Annotation

Description

Source

OMIM

Online Mendelian Inheritance in
Man®

OMIM

p-value

p-value of the variant call

lon Reporter™ Software

Pfam

Protein domain families in the
coded protein

Pfam

PhylopP

Measure of conservation of the
protein across a wide range of
organisms

Cornell University

PolyPhen-2

Prediction of the functional effect
of a variant on a protein

Harvard University

Reference

The reference allele (hg19)

lon Reporter™ Software

Reference /
variant coverage

Individual strand coverage
information for the reference and
variant calls

lon Reporter™ Software

SIFT

Prediction of the functional effect
of a variant on a protein

Jevi

Size

Size of the variant

lon Reporter™ Software

Transcript set

Preferred transcripts used to
determine coding regions of
genes.

Note: If youinclude a transcript
file, only transcripts that are
present in your selection of
canonical transcripts are
reported. Other transcripts are
filtered out.

RefSeq canonical; Ensembl
canonical

Type

Type of variant. For example, SNP,
Indel, CNV, and so on.

lon Reporter™ Software

Variant effect

The effect of the variant on the
coding sequence. For example,
missense or stoploss.

lon Reporter™ Software

Annotation

The following annotation sources are available for the Ilon GRCh38 reference:

sources for the lon
GRCh38 reference

Name

Description

GRCh38_clinvar_20160203

GRCh38 CLINVAR version 20160203

GRCh38_cosmic_75

GRCh38 COSMIC version 75

GRCh38_dbsnp_146

GRCh38 DBSNP version 146

GRCh38_dgv_20150723

GRCh38 DGV version 20150723

lon Reporter™ Software 5.6 Help

323



http://www.ncbi.nlm.nih.gov/omim
http://pfam.sanger.ac.uk
http://compgen.bscb.cornell.edu/phast/
http://genetics.bwh.harvard.edu/pph2/
http://sift.jcvi.org
http://www.ncbi.nlm.nih.gov/refseq/
http://www.ensembl.org/index.html

Annotation sources

Annotation sources available in lon Reporter™ Software

Transcripts
included in
GRCh38 RefSeq
canonical
transcripts file

324

Name Description
GRCh38_ensgeneScores_5 GRCh38 Ensembl Gene Functional
canonical transcripts scores version 5
GRCh38_ensgene_79 GRCh38 ENSEMBL version 79 gene model
GRCh38_esp6500_20151203 GRCh38 5000 EXOMES version 20151203
GRCh38 _namedVariants_20151113 GRCH38 Named Variants version 20151113
GRCh38_pfam_29 GRCh38 PFAM version 29
GRCh38_phylop_20151118 GRCh38 PHYLOP version 20151118
GRCh38_refgeneScores_5 GRCh38 Refgene Functional canonical
transcripts scores version 5
GRCh38_refgene_72 GRCh38 REFSEQ version 72 gene model
drugbank_20150107 DRUGBANK version 20150107
go_20151216 GENE ONTOLOGY version 20151216
omim_20160128 OMIM version 20160128

In addition, the following canonical transcripts sets are included for GRCH38
ENSEMBL v79 and REFSEQ v72 gene models:

¢ GRCHB38 ENSEMBL v79 gene model UCSC genome browser canonical transcript
set

¢ GRCH38 REFSEQ v72 gene model UCSC genome browser canonical transcript
set

In UCSC's curated canonical transcripts set, there were some discrepancies where
there were multiple transcripts for a given gene. We removed the shorter transcripts
and kept the transcript with the "appris_principal_1" tag in the Ion Reporter
Software refseq canonical transcript set. This tag is used by gencode to mark the
primary transcript of a particular gene. In the cases, where the appris_principal_1 was
missing, we chose the longest transcript in order to have only one canonical transcript
for a given gene. In cases where two transcripts were the same length, we used
alphabetical order.

The UCSC transcripts for the seven genes in this table are replaced with the
transcripts in the New transcript column in Ton Reporter  Software:

Gene Current transcript New transcript
FGFR2 NM_022970.3 NM_000141.4
FGFR3 NM_001163213.1 NM_000142.4
ABL1 NM_007313.2 NM_005157.4
ARAF NM_001256196.1 NM_001654.4
CHEK2 NM_001005735.1 NM_007194.3
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Gene Current transcript New transcript
GNAS NM_080425.2 NM_000516.4
TP53 NM_001276760.1 NM_000546.5

The Functional Annotator in Ion Reporter  Software can annotate only variants that
map to the following contigs as provided in the GRCh38.fasta and GRCh38.fasta.fai

files:

Table 9 Contigs (sequences) supported by lon Reporter™ Software

Contig Name Length (bps)

chr1 248956422
chr2 242193529
chr3 198295559
chr4 190214555
chrb 181538259
chré 170805979
chr? 159345973
chr8 145138636
chr9 138394717
chr10 133797422
chr11 135086622
chr12 133275309
chr13 114364328
chri1s4 107043718
chr15 101991189
chr1é 90338345

chr17 83257441

chr18 80373285

chr19 58617616

chr20 64444167

chr21 46709983

chr22 50818468

chrX 156040895
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GRCh38 dbsnp

Contig Name Length (bps)

chry 57227415
chrM 16569
chr22_KI270879v1_alt 304135

There are two kinds of variants that we do not support, currently:

1. Variants that map to a contig we do not support

2. Variants that map to a masked region

In particular, chr22_KI270879v1_alt is completely masked except for 269,814 - 279,355,
which contains only the GSTT1 gene. No amino acid changes are provided for the
masked regions. However, gene and transcript information is provided.

The GRCh38 dbsnp version in Ion Reporter  Software 5.2 is dbsnp version 146 for
both Ion Reporter ' Software 5.2 and 5.4. However, since the UCSC genome browser
did not have the UCSC common genes available for dbSNP v146 when Ion Reporter -
Software 5.2 was released, UCSC common genes version 144 are used to set the UCSC
common genes in lon Reporter Software 5.2.

Import new or custom annotation sources
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You can use your own annotation source files in Ton Reporter  Software. If you have
annotation data that you want to use, you can import the files into a custom
annotation set.

There are four types of annotation sources that you can import into Ion Reporter -
Software. The types of annotation sources and the file formats required for each
annotation source are as follows:

Note: Only one version of an annotation source can be used in an annotation set.

Annotation source type Description Import format
Genomic region A set of regions BED
Gene set A set of genes TXT
Preferred transcript set A set of transcripts TXT
VariantDB A set of variants VCF

1. In the Workflows tab, click Presets.

2. Click Create Preset » Annotation Set.
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3. Select an annotation type from the drop-down list:

Option

Description

Genomic region

See for more details.

Gene set

See for more details.

Preferred transcript set

See for more details.

VariantDB

See for more details.

Click Create New.

4. Enter a descriptive name for the custom annotation set.

5. (Optional) Enter a description for the custom annotation set.

6. Click Select File.

7. Browse to and select your custom annotation source file, then click Choose.

8. Click Done.

9. The new custom annotation source is added to the custom annotation set.

Genomic region With a genomic region annotation source, you provide annotation information for

specific regions of interest in the genome. Add your custom annotations in the fourth
column, as key-value pairs separated by semi-colons.

The information in your input genomic regions file is used in the following ways in

your analysis results:

¢ In the Analysis Review screen and in the downloaded TSF variant files,
information from the fourth column is added to matching variants in your

analysis results.

* In the Analysis Review screen, you can create a filter based the first key-value

pair in the fourth column. (Only the first key-value pair can be used as a filter.)

Here is an example file:

#CHROM

chrl
chrl
chrl
chrl
chrl
chrl

Start

000000
000001
000002
000003
000004
000005

End
000001
000002
000003
000004
000005
000006

Annotation wvalues

fldl=abc; £1d2=123; £1d3=this
fldl=abd; f1d2=124; £1d3=that
fldl=abe; f1d2=125; £1d3=this
fldl=abf; £1d2=126; £1d3=that
fldl=abg;f1d2=127; £1d3=this
fldl=abh; £1d2=128; f1d3=that

The hit level for a genomic region annotation source is not configurable and is always
set to overlap.

To import a genomic region custom annotation, see “Import new or custom
annotation sources” on page 326
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With gene sets, you provide annotation information for specific genes of interest. A
gene set annotation source file is a two-column tab-separated file of gene names and
your categories for those genes.

Notes about the format for a gene set annotation source file:

e This annotation source file uses a .txt format.

e The file includes an optional column header. The second column name is used as
the annotation key name. If the header line is not provided, the default
annotation key name of Name is used.

* The header line is not required. If the header line is not provided, the default
annotation key name of Name is used.

¢ Subsequent lines list comma-separated gene symbols, a tab character, and any
annotation string.

The information in your input gene sets file is used in the following ways in your
analysis results:

¢ In the Analysis Review screen and in the downloaded TSF variant files,
information from the second column is added to matching variants in your
analysis results.

* In the Analysis Review screen, you can create a filter based on the second column
name. You can filter your results on any of the values that appear in the second
column.

Here is an example file:

#Geneset5 Disease
Genel,Gene?2 diseasel
Gene3 disease?2
Gene4, Geneb5, Geneb disease3

Gene7,Gene8 diseased

To import a gene set custom annotation, see “Import new or custom annotation
sources” on page 326.

With a transcript set, you provide annotation information for specific transcripts of
interest. A transcript set limits the annotations applied to your variant calls to those
that match your list of preferred transcripts.

Notes about transcript sets:

* The file's contents are in the format: GENE_NAME transcript_accession_id1,
transcript_accession_id2, ..., with a tab character between the gene name and the
first transcript id.

* Gene names must be specified as HGNC gene symbols.
* A tab character is required after the gene name.
* A comma and a space character are required between transcripts.

* If gene name is missing in the file, all transcript annotations for that gene are
preserved.
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e Transcripts can be specified as RefSeq or Ensembl® accession ids with version.
However, if the accession id contains no dot version, then all versions of the
transcript are matched. For example, Genel NM_0000006 will be matched with
all versions of this transcript . This annotation source uses a TXT format with tab
characters. In Ion Reporter™ Software 5.4 and later, even if the version numbers of
the custom transcripts do not match, the variant will be annotated as long as the

transcript names match.

Here is an example file:

GENE REFSEQ AND ENSEMBL TRANSCRIPTS
Genel NM 00000006.2, NM 000000005.3, ENST000000000007.3
Gene2 NM 00000001.1, NM 000000007.1, NM 0000000004.5,

NM 000000008.3, ENST000000000006.4

RefGene GeneModel and Ensembl GeneModel transcript versions

You can view the details about the annotations that Ion Reporter " Software supports
for a particular gene model transcript in the list of Variant Details.

Variant Details: chr1:7527892

Variant Details Hotes

Annotation Source

Annotation Yalue

Coding
Codon
Exon
Gene
Gene Ontalogy
Genotype
Length
Location
Locus
DhtI
FPFAR
PhyloP
Ref
Transcript
Type

Wariant Effect
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And in the TSV variants file (in the Variants/sample_name subdirectory):

Use these version numbers with the transcript IDs in your preferred transcript file.

VariantDB files allow you to provide custom annotation information for specific
variants of interest.

Note: Custom variantDBs must have unique names. For example, name and version
number should be combined to ensure unique names.

MName: variantdbaA_ vl Version: vl
MName: wariantdba w2 Version: v2
MName: variantdbaA_v3 Version: v3

An example file is shown below. This file is tab-delimited and the header line is
required.

##fileformat=VCFv4.1

#CHROM POS ID REF ALT QUAL
FILTER INFO

chrl 124535436 COSM00001 TG
AA . o AMPID=AMPL495041; TEMP ID=0

chrl 124535494 COSM00002 G
T o o AMPID=AMPL495041; TEMP ID=1

chrl 128808434 COSM00003 T
A o o AMPID=AMPL30014; TEMP ID=2

chrl 124597624 o T
G o o AMPID=AMPL30014; TEMP ID=3

chrl 136671158 o TT
CA . o AMPID=AMPL30014; TEMP_ ID=5

chrl 141128903 COSM00006 TTG
crT o AMPID=AMPL30014; TEMP ID=6

We recommend that the custom input file provided to VariantDB be left-aligned. Left
alignment is used to normalize the positions of ambiguous indels that can be placed at
multiple positions.
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The information in your input VariantDB file is used in the following ways in your
analysis results:

* In the downloaded variants TSV file, the content in your ID, REF, ALT, and INFO
fields are added to the variant.

* In the Analysis Review screen, the content in your ID and INFO fields are added
to the variant.

* In the Analysis Review screen, you can create a filter that is based on the content

in your ID field. If the content of the ID field does not contain a value (contains
only a period), then the first key-value pair of your INFO field is used.

Further information on VCF format:

¢ Official specification of VCF (Variant Call Format) version 4.1:
http://www.1000genomes.org/wiki/Analysis/Variant%20Call %20Format/vcf-
variant-call-format-version-41
In VCF format files, missing values are represented by dots. The content must be
tab-separated. Ensure that no extra or hidden characters are added to the VCF
files, which may occur when they are opened in programs like Excel or Word, or
when emailed as an unzipped attachment.

* Mandatory headers required when creating a VariantDB file: The following
three headers must be present in the first three lines of the VCF file (FORMAT
and Sample columns are optional in VCF files):

##fileformat=VCFv4.1

##FORMAT=<ID=GT, Number=1, Type=String, Description="Genotype">
#CHROM POS ID REF
ALT QUAL FILTER INFO FORMAT Sample

* Hit-level information in a VariantDB file: You can adjust the hit level of each
VariantDB file individually by including this information in the header. The
following hit-level parameters can be included in the VCF header.

- ##HITLEVEL=overlap matches all annotations whose loci overlap with
variant.

- ##HITLEVEL=locus matches all annotations whose loci start at the variant
locus.

- ##HITLEVEL=allele matches all annotations that are 'locus' matches plus
have at least one allele in common with variant.

- ##HITLEVEL=genotype matches all annotations that are 'allele' matches
where the genotypes also match.

- ##HITLEVEL=auto matches the most specific hit level possible, which could
be any of the hit levels listed above.
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* Mandatory columns required in the VCF file when creating a VariantDB:
Providing FORMAT and SAMPLE fields is not mandatory according to the
official VCF specification. However, in order to perform a "genotype" hit level
match in Ion Reporter™ Software, you must specify a GT (genotype) for the
variant in the FORMAT column.

An example of a variant with a GT field of 0/1 in the FORMAT field of a VCF file
is given below:

chrl 141128903 COSM00006 TTG CTT
AMPID=AMPL30014; TEMP ID=6 GT 0/1

If only an "overlap" or "locus" or "allele" match is needed, you do not need to
specify a GT field. However, the missing values must be represented by dots in
the appropriate columns. For example:

chrl 141128903 COSM00006 TTG CTT
AMPID=AMPL30014; TEMP ID=6...

If the "auto" hit level match is chosen, Ion Reporter™ Software will try to find the

most specific hit level match possible. However, if no GT value is supplied, the

most specific hit level possible will be an allele match, as there is no GT value to

do an allele or genotype level match.

* How to filter on VariantDB:
— Option 1:

Ion Reporter™ Software automatically exposes a filter on the first INFO key
of the VariantDB VCF file if such a key is specified and if the ID field of the
VCF file is missing.

— Consider the example below:
##fileformat=VCFv4.1l

##FORMAT=<ID=GT, Number=1, Type=String, Description="Genoty

pe">
#CHROM POS ID
REF ALT QUAL FILTER INFO FORMAT Sample
chrl
124535436 . TG AA .
AMPID=AMPL495041; TEMP ID=0...
chrl

128808434 o T A o
AMPID=AMPL30014; TEMP ID=2...

If the above VCF file with two variants is used in order to make a VariantDB
in Ion Reporter™ Software, you will be able to filter on the AMPID field, since
the AMPID key is the first INFO key present in the INFO field of the VCF file
and the ID fields are missing (represented by dots).
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— Option 2:
If the INFO field is not populated, filtering will be automatically enabled on
the ID column.

Consider the example below, in which the INFO field is missing and
represented with a dot:

##fileformat=VCFv4.1l

##FORMAT=<ID=GT, Number=1, Type=String, Description="Genoty

pe">
#CHROM POS ID
REF ALT QUAL FILTER INFO FORMAT Sample
chrl 124535436
COosSM00001 TG AA .
chrl 141128903

COSM00006 TTG CTT

If the VCEF file above with two variants is used in order to make a VariantDB
in Ion Reporter™ Software, you will be able to filter on the ID field, since the
INFO field of the VCF file is not populated.

See also the sections on "MyVariants" for marking and tracking of variant
annotation beyond the VariantDB annotation presets in workflows.

This section provides more detail about select annotation sources.
P-value scores

The P-value represents the probability that the variant call is incorrect. The range is
from 0.00001 to 0.99999, with numbers approaching 1 being the least confident (that
the call is incorrect), and numbers close to zero being the most confident (that the call
is incorrect).

P-values closer to 0.0 represent more confidence that the variant call is correct. P-
values closer to 1.0 represent less confidence that the variant call is correct.

The p-value reported by Ton Reporter = Software is a logarithmic transformation of the
Phred quality score value made by the VariantCaller. For example, a VariantCaller
quality score of 20 is associated with a p-value of 0.01. A VariantCaller quality score of
30 is associated with a p-value is 0.001.

Pfam annotations

Ton Reporter  Software has two pfam versions: version 26 and version 30. Refer to the
following site for more information on PFAM:

http://pfam.xfam.org/

Pfam consist of parts A and B. Ion Reporter  Software uses Pfam-A. "A is curated and
contains well-characterized protein domain families with high quality alignments,
which are maintained by using manually checked seed alignments and HMMs to find
and align all members", according to this site:

Pfam: a comprehensive database of protein domain families based on seed
alignments

See also the following link for information about Pfam:
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The Pfam protein families database:: R.D. Finn, J. Mistry, J. Tate, P. Coggill, A. Heger,
J.E. Pollington, O.L. Gavin, P. Gunesekaran, G. Ceric, K. Forslund, L. Holm, E.L.
Sonnhammer, S.R. Eddy, A. Bateman. Nucleic Acids Research (2010) Database Issue
38:D211-222

The next sections describe interpretation guidelines for annotation scores in the SIFT,
Grantham, and PolyPhen columns.

Note: Pfam annotations for all domains of the gene's protein are added for any
variant.

IMPORTANT! The interpretations listed here are the recommendations of the
respective external sites.

This section provides details about the annotation scores used in Ion Reporter' "
Software and how these scores are calculated.

SIFT versions
e SIFT version --5.1.1

* Protein database -- UniprotTrEMBL, downloaded on July 11, 2011. Updated on
March 14, 2014.

* BLAST version -- 2.2.25. Updated to 2.2.26.
* BLIMPS version -- 3.9

Polyphen-2

¢ Version -- PolyPhen-2 v2.1.0r367, using the stand-alone default installation
instructions and usage

e BLAST version -- 2.2.25

¢ Protein database -- Uniref100, downloaded on August 12, 2011 from
ftp://ftp.uniprot.org/pub/databases/uniprot/current_release/uniref/uniref100/unir
ef100.fasta.gz

Chromosome M has its own genome that is different in 4 codons from the other
chromosomes.

Ton Reporter  Software uses the Homo sapiens mitochondrion, complete genome
NCBI Reference Sequence: NC_012920.1.

The new rCRS chrM assembly has 16569 bases. The previous version had 16571 bases.

The 2 coding tables, one for standard chromosomes and one for chromosome M, are
listed below. These tables are from the following NCBI site:

http://www.ncbi.nlm.nih.gov/Taxonomy/Utils/wprintgc.cgi#SG2
The Standard Code (transl_table=1) for chromosomes 1-22, X and Y (NUCLEAR)

By default all transl_table in GenBank flatfiles are equal to id 1, and this is not shown.
When transl_table is not equal to id 1, it is shown as a qualifier on the CDS feature.

TTT F Phe TCT S Ser TAT Y Tyr TGT C Cys
TTC F Phe TCC S Ser TAC Y Tyr TGC C Cys
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TTA L Leu
TTG L Leu i

CTT L Leu
CTC L Leu
CTA L Leu
CTG L Leu i

ATT I Ile
ATC I Ile
ATA I Ile
ATG M Met 1

GTT V Val
GTC V Val
GTA V Val
GTG V Val

TCA S Ser
TCG S Ser

CCT P Pro
CCC P Pro
CCA P Pro
CCG P Pro

ACT T Thr
ACC T Thr
ACA T Thr
ACG T Thr

GCT A Ala
GCC A Ala
GCA A Ala
GCG A Ala

Import new or custom annotation sources

TAA * Ter
TAG * Ter

CAT H His
CAC H His
CAA Q Gln
CAG Q Gln

AAT N Asn
AAC N Asn
AAA K Lys
AAG K Lys

GAT D Asp
GAC D Asp
GAA E Glu
GAG E Glu

Annotation sources

TGA * Ter
TGG W Trp

CGT R Arg
CGC R Arg
CGA R Arg
CGG R Arg

AGT S Ser
AGC S Ser
AGA R Arg
AGG R Arg

GGT G Gly
GGC G Gly
GGA G Gly
CEE © Cly

The Vertebrate Mitochondrial Code (transl_table=2) for chromosome M.

TTT F Phe TCT S Ser TAT Y Tyr TGT C Cys
TTC F Phe TCC S Ser TAC Y Tyr TGC C Cys
TTA L Leu TCA S Ser TAA * Ter TGA W Trp
TTG L Leu TCG S Ser TAG * Ter TGG W Trp
CTT L Leu CCT P Pro CAT H His CGT R Arg
CTC L Leu CCC P Pro CAC H His CGC R Arg
CTA L Leu CCA P Pro CAA Q Gln CGA R Arg
CTG L Leu CCG P Pro CAG Q Gln CGG R Arg
ATT I Ile i ACT T Thr AAT N Asn AGT S Ser
ATC I Ile i ACC T Thr AAC N Asn AGC S Ser
ATA M Met 1 ACA T Thr AAA K Lys AGA * Ter
ATG M Met 1 ACG T Thr AAG K Lys AGG * Ter
GTT V Val GCT A Ala GAT D Asp GGT G Gly
GTC V Val GCC A Ala GAC D Asp GGC G Gly
GTA V Val GCA A Ala GAA E Glu GGA G Gly
GTG V Val i GCG A Ala GAG E Glu GGG G Gly
The differences from the Standard Code are the following:
Code 2 Standard
AGA Ter * Arg R
AGG Ter * Arg R
AUA Met M Ile |
UGA Trp W Ter *

Note: In these tables, an asterisk represents a STOP codon.
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Background information
The UCSC website has this note about chrM:
“Note on chrM:

Since the release of the UCSC hg19 assembly, the Homo sapiens mitochondrion
sequence (represented as "chrM" in the Genome Browser) has been replaced in
GenBank with the record NC_012920. We have notreplaced the original sequence,
NC_001807, in the hg19 Genome Browser. We plan to use the Revised Cambridge
Reference Sequence (rCRS) in the next human assembly release.”

The IGSR: The International Genome Sample Resource has this entry:
Which reference assembly do you use?

The reference assembly the 1000 genomes project has mapped sequence data that has
changed over the course of the project.

For the pilot phase we mapped data to NCBI36. A copy of our reference fasta file can
be found on the ftp site.

For the phasel and phase 3 analysis we mapped to GRCh37. Our fasta file which can
be found here called human_glk_v37 .fasta.gz, it contains the autosomes, X, Y and MT
but no haplotype sequence or EBV.

Other links related to chrM:

Original sequence, NC_001807:
http://www.ncbi.nlm.nih.gov/nuccore/NC_001807.4?report=genbank
The updated Mitochondrial sequence, NC_012920 can be found here:
http://www.ncbi.nlm.nih.gov/nuccore/NC_012920

The annotation set configuration pages allow you to specify Polyphen and Sift in an
annotation set with RefSeq 63 and Ensembl® 74. Functional Scores v4 target RefSeq 63
and Ensembl® 74. Functional scores v3 target RefSeq 53 and Ensembl® 65.

This help page describes the variant categories that defined by trio workflows. During
these workflows, each variant called in the proband sample is assigned all categories
that apply. A variant might be assigned one, none, or many categories.

During your review of analysis results, the Genetic Category Type filter applies to
these categories.
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HasDeNovoNonRefAllele

An allele of a proband variant is de novo if it does not appear in the genotype of either
of the proband's parents at this variant position.

A proband variant is assigned the category HasDeNovoNonRefAllele if all of the
following are true:
¢ The variant has an allele that:
— Isnot the same as the reference allele.
— Does not appear in the father's genotype.
— Does not appear in the mother's genotype.

* The coverage of the father's genotype at this variant position is at least
denovo_nonref_allele_min_father_coverage.

* The coverage of the mother's genotype at this variant position is at least
denovo_nonref_allele_min_mother_coverage.

Note: The coverage parameters help avoid false-positive calls that might arise simply
because the sequencing coverage is inadequate to call an accurate genotype. Without
coverage information, the absence of a variant call for a parent is only absence of
evidence, and we cannot exactly determine that the proband's allele is de novo. To
establish evidence of absence, we require that the parents be covered well enough that
variants are called if actually present. Therefore we require that the position in both
parents meets a coverage threshold.

HasDeNovoRefAllele
A proband variant is assigned the category HasDeNovoRefAllele if all of the
following are true:

e The variant has an allele that:
— Is the same as the reference allele.

— Does not appear in the father's genotype.
— Does not appear in the mother's genotype.

* The coverage of the father's genotype at this variant position is at least
denovo_ref_allele_min_father_coverage.

* The coverage of the mother's genotype at this variant position is at least
denovo_ref_allele_min_mother_coverage.

See also HasDeNovoNonRefAllele.

IsNewlyHomozygousNonRef

A proband variant is newly homozygous if it is homozygous but genotypes of both of
the parents are heterozygous.

A proband variant is assigned the category IsNewlyHomozygousNonRef if all of the
following are true:

¢ The variant is homozygous.

* The variant's allele is not the same as the reference.

¢ The father's genotype is heterozygous at this variant position.

* The mother's genotype is heterozygous at this variant position.
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¢ The variant's functional annotations include at least one specified by
newly_homozygous_nonref_functional_types.

¢ The frequency of the allele in the population is at most
newly_homozygous_nonref max_population_allele_frequency.<

This situation can indicate a recessive disease or condition, in which the parents carry
the same deleterious mutation but are unaffected because they are heterozygous. The
trio analysis later examines the variant's functional annotations to help determine if
the variant is deleterious.

IsNewlyHomozygousRef

A proband variant is newly homozygous if it is homozygous but genotypes of both of
the parents are heterozygous.

A proband variant is assigned the category IsNewlyHomozygousRef if all of the
following are true:

¢ The variant is homozygous.

* The variant's allele is the same as the reference.

* The father's genotype is heterozygous at this variant position.

¢ The mother's genotype is heterozygous at this variant position.

¢ The frequency of the allele in the population is at most
newly_homozygous_nonref_max_population_allele_frequency.

IsNewlyHeterozygousNonRef

A proband variant is heterozygous non-ref if it is heterozygous and neither allele is
the reference allele. The variant is newly heterozygous non-ref if the genotypes of both
parents contain the reference allele.

A proband variant is assigned the category IsNewlyHeterozygousNonRef if all of the
following are true:

* The variant is heterozygous.

* Neither of the variant's alleles is the same as the reference.

¢ The father's genotype contains the reference allele at this variant position.

* The mother's genotype contains the reference allele at this variant position.

¢ The variant's functional annotations include at least one specified by
newly_homozygous_nonref_functional_types.

¢ The frequency in the population of at least one of its alleles is at most
newly_homozygous_nonref_max_population_allele_frequency.

This situation can indicate a recessive trait or condition, in which the parents carry the
same deleterious mutations but are unaffected because they are heterozygous-ref.

Note: The parameters newly_homozygous_nonref_functional_types and
newly_homozygous_nonref_max_population_allele_frequency are used in both the
IsNewlyHomozygousNonRef and IsNewlyHeterozygousNonRef categories.

338 lon Reporter™ Software 5.6 Help



Annotation sources
Import new or custom annotation sources

InCompoundHeterozygote

A compound heterozygote is a pair of putatively deleterious variants on the same
gene.

A proband variant is assigned the category InCompoundHeterozygote if both of the
following are true:

* The variant's functional annotations include at least one of the types in
compound_heterozygote_functional_types.

* The variant is in the same gene as another such variant.
The variants can be either homozygous or heterozygous. The trio analysis later

determines whether a variant is putatively deleterious by examining the existing
functional annotations associated with the variant.

InTransPhaseCompoundHeterozygote

A trans-phase compound heterozygote is a compound heterozygote in which one
variant has a non-reference allele on the paternal homolog, and the other variant has a
non-reference allele on the maternal homolog.

A trans-phase heterozygote is a pair of deleterious proband variants in a gene where:

* One of the two variants has a non-reference allele that is present in the father's
genotype, and whose other allele is present in the mother's genotype, and

¢ The other variant has a non-reference allele that is present in the mother's
genotype, and whose other allele is present in the father's genotype.

To determine the InTransPhaseCompoundHeterozygote category, for each gene, the
trio analysis creates two lists of proband variants, fromFather and fromMother.
Both of the following apply to each variant in the fromFather list:

¢ Its functional annotations include at least one in
compound_heterozygote_functional_types.

¢ It has a non-reference allele that is present in the father's genotype, and whose
other allele is present in the mother's genotype at this variant's position.
Similarly, both of the following apply to each variant in the fromMother list:

e Its functional annotations include at least one in
compound_heterozygote_functional_types.

* It has a non-reference allele that is present in the mother's genotype, and whose
other allele is present in the father's genotype at this variant's position.

Any variant in the fromFather list paired with any variant in the fromMother list forms a
trans-phase heterozygote pair, and any trans-phase heterozygous pair of variants has
one variant in the fromFather list and the other in the fromMother list.

A proband variant is assigned the category InTransPhaseCompoundHeterozygote if
either of the following are true:

¢ The variant appears in the fromFather list and there is at least one other variant in
the fromMother list, or

* The variant appears in the fromMother list and there is at least one other variant in
the fromFather list.
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HasMaleMaternalX

A proband variant is assigned the category HasMaleMaternalX if all of the following
are true:

The proband is male.

The variant is on the X chromosome.

The variant is hemizygous (non-reference).

The father's genotype at this variant's position is hemizygous reference.
The mother's genotype at this variant's position is heterozygous.

The mother's genotype includes the proband variant's allele.

The variant's functional annotations include at least one type in
maternal_x_functional_types.

The frequency of the proband's allele is less than
maternal_x_max_population_allele_frequency.

The following explain why these conditions apply to this category:

This category detects possible causative variants inherited from the mother on the
single X-chromosome of a male proband (conditions 1 and 2 above).

The father is not affected, so when a variant is causative, the father, with only one
X-chromosome, cannot also have that variant at this position (condition 4).

If the variant is de novo, it is assigned the categoryHasDeNovoNofRefAllele. For
the category HasMaleMaternalX, a variant allele is inherited from the unaffected
mother (conditions 5 and 6).

The variant is detrimental (condition 7).

HasUnknownX

A proband variant is assigned the category HasUnknownX if all of the following are
true:

The proband is male.

The variant is on the X chromosome.

The variant is hemizygous (non-reference).

The father's genotype at this variant's position is hemizygous reference.
The mother's genotype does not include the proband variant's allele.

The variant's functional annotations include at least one in
unknown_x_functional_types.

The frequency of the proband's minor allele is less than
unknown_x_max_population_allele_frequency.

InconsistentWithFather

A proband variant is assigned the category InconsistentWithFather if all of the
following are true:

Neither of the variant's alleles appear in the father's genotype at this variant
position.

The variant has coverage at least consistencyMinCoverage.

The father's genotype has coverage at least consistencyMinCoverage at this
variant position.
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InconsistentWithMother
A proband variant is assigned the category InconsistentWithMother if all of the
following are true:

* Neither of the variant's alleles appear in the mother's genotype at this variant
position.

* The variant has coverage at least consistencyMinCoverage.

¢ The mother's genotype has coverage at least consistencyMinCoverage at this
variant position.

InconsistentWithParents

A proband variant is consistent with its parents if one of its alleles is present in the
father's genotype at this variant position and its other allele is present in the mother's
genotype at this variant position.

A proband variant is assigned the category InconsistentWithParents if all of the
following are true:
¢ The variant has coverage at least consistencyMinCoverage.

* The father's genotype has coverage at least consistencyMinCoverage at this
variant position.

¢ The mother's genotype has coverage at least consistencyMinCoverage at this
variant position.

¢ The variant is not consistent with it parents.

Gene Category Type and Variant Effect filter types can be applied to the same
variants

The Gene Category Type (GCT) has a functional type parameter similar to “Variant
Effect” which you can set when creating a custom trio workflow. Both this functional
type selection and Variant Effect will be applied if used together in a filter chain. For
example, if a variant has a GCT functional type of indel, it may have a Variant Effect
type of frameshift or non-frameshift. The functional annotation types differ for these
two filter types.
The GCT functional filter types are as follows:

* snp

e indel

* synonymous

®* missense

stoploss
¢ stopgain
* splicejunction
* utr
The Variant Effect filter types are as follows:
e unknown
* synonymous
* missense

e nonframeshiftinsertion
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e nonframeshiftDeletion

¢ nonframeshiftBlockSubstitution
® nonsense

* stoploss

e frameshiftBlockSubstitution

Genetic Category Type and MAF filter

If a variant is not a minor allele, MAF filter will not be effective, because MAF filter
only applies if the variant is a minor allele. Users may have a threshold setting for
MAF filter which will not be effective if variant is not a minor allele.

Grantham score The Grantham score attempts to predict the distance between two amino acids, in an
evolutionary sense. A lower Grantham score reflects less evolutionary distance. A
higher Grantham score reflects a greater evolutionary distance. Higher Grantham
scores are considered more deleterious:

¢ The more distant two amino acids are, the less likely the amino acids are to be
substituted with one another.

* The more distant two amino acids are, the more damaging is their substitution.
The distance scores published by Grantham range from 5 to 215. A substitution of
isoleucine for leucine, or of leucine for isoleucine, has a score of 5 (and is predicted to
be tolerated). A substitution cysteine for tryptophan, or of tryptophan for cysteine,
has a score of 215. Any variation involving cysteine has a high or very high Grantham
score (and is predicted to be deleterious).

For more information on Grantham scores, see the following sites:
* Abstract for Amino acid difference formula to help explain protein evolution.

* Article for Grantham R.
"Amino acid difference formula to help explain protein evolution", Science.
1974 Sep 6;185(4154):862-4.
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This table shows the genomic code patterns used in the Analyze Role Review Samples

Note: HGVS c. notations for intronic, upstream, and downstream variants in genes
are shown in the Functional tab on the Variant Review screen. HGVS c. notations are
not shown for intergenic variants.

CHR POS REF ALT GT Genomi |Coding | Protein
C
Homozy |3 1245354 | G A 1/1 chr1:12 |c. p.Ala51
gous 34 4535434 | 1531G> |[1Thr
SNP G>A A
Heteroz | 4 9054510 |A T 0/1 chr2:90 |c. p.Lys54
ygous 3 545103A | 1638A>T | 6Asn
SNP >T;[=]
Insertio |4 Insertio |G GAAT 0/1 chr7:61 |c. NA
n n of 310513_ [ 1663 _16
bases 6131051 | 64insAA
“AAT” 4insAAT | T
between i[=]
the
position
s
6131051
3 and
6131051
34
Deletion |17 Deletion | AGGT A 0/1 chr7:61 |c. NA
of bases 917157_ |737_739
“GGT” in 6191715 | delGGT
position 9delGGT
s i[=]
6191715
7,
6191715
8,61917
159
MNV Y Replaci |CC TT 0/1 chr7:50 |c. p.Pro79
ng 367679 1235 236 | Leu
bases 5036768 | delCCin
“CC”in 0delCCi |sTT
position nsTT;[=]
s
5036767
9 and
5036768
0 with
bases
T
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Homozy |22 5083385 | A . 0/0 chr11:5 |c.= p.Tyr505
gous 3 0833853 Tyr
referenc A
e call
No call |5 3833580 |G . A. chr16:3 |NA NA
1 8335801
G>?

The Human Genome Variation Society site is http://www.hgvs.org/mutnomen.

* hgl19: This human reference is based on the GRCh37.p5 version of the human
genome assembly. The GRCh37.p5 version is described at this web site: https://
www.ncbi.nlm.nih.gov/grc/human/data?asm=GRCh37.p5.

* GRCh38: This human reference is based on the GRCh38.p2 version of the
human genome assembly. The GRCh38.p2 version is described at this web site:
https://www.ncbi.nlm.nih.gov/grc/human/data?asm=GRCh38.p2.

Ambiguity codes for three positions on Chromosome 3

Three positions on chromosome 3 are marked with

lNl

in the UCSC version of the genome. These positions have IUPAC ambiguity codes in

our version:

IUPAC Ambiguity code in lon

Hard masked character in

Position reference ucscC hg19
60830534 M N
60830763 R N
60830764 R N

Hard masked PAR regions in chromosome Y

The chromosome Y sequence has the pseudoautosomal regions (PAR) hard masked.
This practice is consistent with the 1000 Genome Consortium's decision to hard mask
these regions in chromosome Y in order to prevent mis-mapping of reads and issues
in variant calling on the gender chromosomes.

The masked Y pseudoautosomal regions are chrY:10001-2649520 and chrY:
59034050-59363566. (A related file can be downloaded from ftp://ftp.ensembl.org/
pub/release-56/fasta/homo_sapiens/dna/
Homo_sapiens.GRCh37.56.dna.chromosome.Y.fa.gz.)

The following background information is from the UCSC site http://genome.ucsc.edu/
cgi-bin/hgGateway?org=human&db=hg19

"The Y chromosome in this assembly contains two pseudoautosomal regions (PARs)
that were taken from the corresponding regions in the X chromosome and are exact

duplicates:

chrY:10001-2649520 and chrY:59034050-59363566?
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chrX:60001-2699520 and chrX:154931044-155260560"

Chromosome M

We use the Cambridge Reference Sequence (rCRS) for chromosome M with the
GenBank accession number NC_012920. Ton Reporter  software uses the UCSC
curated Refseq genes which currently do not contain chrM genes. In order to view
gene annotation on chrM, use the ENSEMBL gene model which does have chrM

genes.

More information is available on the web: http://genome.ucsc.edu/cgi-bin/

hgGateway?org=human&db=hg19.

PhyloP filter range used in Ion Reporter Software corresponds to the values given in

the following UCSC Table Browser website:

http://genome.ucsc.edu/cgi-bin/hgTables?command=start

The following table shows the Table Browser settings and button used to retrieve the

phyloP values:
Setting Value
clade Mammal
genome Human
assembly Feb. 2009 (GRCh37/hg19)
group All Tables
database hg19
table phyloP4éwayPlacental
region genome
output format data points
file type returned plain text

button

summary/statistics

The minimum and maximum ranges among all chromosomes that the Table Browser
returned, with the rounded values used in the Ion Reporterw Software phyloP filter,

are shown below:

UCSC Table Browser

lon Reporter™ Software
phyloP filter

Min -13.796

-14

Max 2.941

3
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Phylop score

PolyPhen-2 score

346

PhyloP scores measure evolutionary conservation at individual alignment sites. The
scores are interpreted as follows compared to the evolution expected under neutral
drift:

* Positive scores -- Measure conservation, which is slower evolution than expected,
at sites that are predicted to be conserved.

* Negative scores -- Measure acceleration, which is faster evolution than expected,
at sites that are predicted to be fast-evolving.

According to the UCSC site below, phyloP scores are useful to evaluate signatures of
selection at particular nucleotides or classes of nucleotides (e.g., third codon positions,
or first positions of miRNA target sites).

The absolute values of phyloP scores represent -log p-values under a null hypothesis
of neutral evolution.

The following range of scores is used in the Ion Reporter  Software phyloP filter (for
how this range is determined, see PhyloP in the Annotation versions and calculations
section):

e Min---14
e Max--3

For more information on phyloP, see the following site. Also click the phyloP link on
the left navigation panel in the website.

http://compgen.bscb.cornell.edu/phast/background.php

To find the latest UCSC Genome Browser database search for "UCSC Genome
Browser update" in PubMed

The PolyPhen-2 score predicts the possible impact of an amino acid substitution on
the structure and function of a human protein. This score represents the probability
that a substitution is damaging. Ton Reporter  Software reports the pph2-prob
PolyPhen-2 score.

The PolyPhen-2 score ranges from 0.0 (tolerated) to 1.0 (deleterious). Variants with
scores of 0.0 are predicted to be benign. Values closer to 1.0 are more confidently
predicted to be deleterious. The score can be interpreted as follows:

* 0.0 to 0.15 -- Variants with scores in this range are predicted to be benign.

* 0.15to 1.0 -- Variants with scores in this range are possibly damaging.

* (.85 to 1.0 -- Variants with scores in this range are more confidently predicted to
be damaging.

PolyPhen-2 and SIFT scores use the same range, 0.0 to 1.0, but with opposite
meanings. A variant with a PolyPhen-2 score of 0.0 is predicted to be benign. A
variant with a SIFT score of 1.0 is predicted to be benign.
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A SIFT score predicts whether an amino acid substitution affects protein function.

The SIFT score ranges from 0.0 (deleterious) to 1.0 (tolerated). The score can be
interpreted as follows:

* 0.0 to 0.05 -- Variants with scores in this range are considered deleterious.
Variants with scores closer to 0.0 are more confidently predicted to be deleterious.

* (.05 to 1.0-- Variants with scores in this range are predicted to be tolerated
(benign). Variants with scores very close to 1.0 are more confidently predicted to
be tolerated.

Note: PolyPhen-2 and SIFT scores use the same range, 0.0 to 1.0, but with opposite
meanings. A variant with a PolyPhen score of 0.0 is predicted to be benign. A variant
with a SIFT score of 1.0 is predicted to be benign.

Delete custom annotation sources

Custom annotation sets created by users are displayed in Workflow Presets screen.
An administrator can view and delete custom annotation sources created by users.

1. In the Workflows tab, click Presets.

2. Click Annotation Sets » Annotation Source.

A table that lists the custom annotation sources opens. It shows the following
information about the annotation: name, version, source version, reference,
created by, created on, and source type.

3. Click the custom annotation source that you want to delete in the Workflow
Presets list, then click Settings (-I:I-) » Delete.

Note: If an annotation source is used in a workflow, it cannot be deleted.

The annotation source is removed from the Workflow Presets list.
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Preferred transcripts in default workflows

The default workflows that are provided in Ion Reporter™ Software include an
annotations set with a preferred transcript set, the RefGene canonical transcripts. The
default annotation set that includes the default RefSeq canonical transcripts is named
AlL

Default workflows that use the All annotation set report only transcripts that are
included in the RefGene canonical transcripts. By default, the following RefGene
canonical transcripts are included in the All annotation set:

e RefGene
¢ Functional
e Canonical

e Transcript Scores
All other transcripts are filtered out and not reported.

To instead have additional transcripts reported in your analyses, see “Create
annotation set without preferred transcript sets” on page 348.

Create annotation 1. In the Workflows tab, click Presets.
set without
preferred
transcript sets

2. Click Create Preset » Annotation Set.

a. In the Reference drop-down menu, select Gene Model as the type of
annotation source.
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b. In the Choose Existing tab, click Use for either the RefSeq Gene Model or
the Ensembl® Gene Model.

Note: Only one gene model can be added to each annotation set.

3. Enter a descriptive name for the custom annotation set.
4. (Optional) Enter a description for the custom annotation set.

5. Click Save.
The new annotation source is listed in the Workflow Presets screen.

Oncomine Variant Annotator plugin

Ion Reporter™ Software 5.6 for Oncomine™ Assays contains the Oncomine™ Variant
Annotator Plugin 2.3. The plugin enables rapid identification of driver gain-of-
function or loss-of-function variants in any cancer research sample. The plugin
integrates data from more than 5,300 tumor-normal exomes across 48 types of cancer.
See the Oncomine™ Variant Annotator Plugin Annotation Criteria Product Information
Sheet (Pub. No. MANO0014652) on the Thermo Fisher Scientific website for more
information.

Note: Do not use the plugin for other panels.

Change amino acid code

Ton Reporter  Software gives you the option to annotate amino acid changes with the
single-letter IUPAC amino acid codes, or the three-letter codes, based on your
preference. By default, the three-letter code is used. To use the one-letter IUPAC code,
you can change a parameter when you edit a workflow. Then, for example,
Val600Glu would be used in the annotation and displayed in the analysis results as
V600E.

1. In the Workflows tab, select the workflow of interest, then click Edit.

2. Click Parameters in the workflow bar.
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3. In the Annotation section, under Use IUPAC Single Letter Code for Amino
Acid, select the option that you want to use for amino acid changes:

Option Description
True Select to use the single-letter IUPAC code
False Select to use the three-letter amino acid code

4. Click Next.

5. Review your selected options for the edited workflow, then click Confirm.
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This appendix applies to analyses that are based on the following workflows and
panels:

* Workflow: AmpliSeq RNA Lung Fusion single sample
e Panel: Ion AmpliSeq™” RNA Fusion Lung Cancer Research Panel
* Workflow: Ampliseq Colon Lung v2 with RNA Lung Fusion single sample

* Panels: Ion AmpliSeq™ Colon and Lung Cancer Research Panel v2 and Ion
AmpliSeq™ RNA Fusion Lung Cancer Research Panel

¢ Panels: Custom fusion panels designed by Ion Torrent White Glove team and Ion
AmpliSeq™ Designer.

¢ Oncomine Fusion panels

Import fusion panels from lon AmpliSeq  Designer

You can import custom and fixed fusion panels from Ion AmpliSeq" Designer into
Ion Reporter Software.

1. Inlon Reporter™ Software, go to Workflows » Create.

2. Click DNA and Fusions and click Next.
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3. On the Reference page, use the AmpliSeq Import button to import your custom
or fixed fusion panels and related files from Ion AmpliSeq™ Designer.

4. Enter your username and password and click List My AmpliSeq Panels button
to access your custom fusion panels.
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5. For fixed panels you do not need to enter your username and password, simply
select the fixed panel of your choice.
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Fusion algorithm parameters include:

Parameter
Name

Ul Group

Allowed Values

Default Value

Description

Sensitivity

Main

Low/Medium/Hi
gh

(Fixed values
only one of the
three can be
applied)

Medium

For High value,
the algorithm
requires 60%
overlap between
reads and
reference
sequence with
at-least 50%
exact matches
in the overlap.

For Medium
value, the
algorithm
requires 70%
overlap between
reads and
reference
sequence with
at-least 66.66%
exact matches
in the overlap.

For Low value,
the algorithm
requires 80%
overlap between
reads and
reference
sequence with
at-least 75%
exact matches
in the overlap.

Minimum Read
Counts for
Fusions

Main

>=0

Integers only

20

Threshold on
minimum
number of valid
reads aligned to
specific fusion
isoform
sequence in
order to call the
isoform as
Present,
provided if the
normalized read
count is also
greater than the
threshold.
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Parameter
Name

Ul Group

Allowed Values

Default Value

Description

Example : If
count of a target
is >20, the
target is called
Present.

Minimum Read
Counts for Non-
Targeted
Fusions

Advanced

>=0

Integers only

250

Threshold on
minimum
number of valid
reads aligned to
a non-targeted
fusion sequence
in order to call
the fusion as
Present.

Example : If the
Count of a non-
targeted isoform
is >250, it is
reported as
Present-non-
targeted.

Minimum Read
Counts for
Controls

Advanced

>=0

Integers only

15

Threshold on
minimum
number of valid
reads aligned to
specific
expression
control
sequence
required to call
it as Present.

Example : If the
read count of a
expression
control is >15, it
is called
Present.

Minimum
Normalized
Read Counts for
Fusions

Main

>=0

Float values.

Threshold on
minimum
normalized read
counts
threshold
required to call
a fusion isoform
as present.
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Parameter
Name

Ul Group

Allowed Values

Default Value

Description

Minimum Total
Valid mapped
reads

Main

>=0

Integers only

20000

Minimum
number of total
valid mapped
reads required
to qualify a
Sample as Valid
and to proceed
with the
analysis.

Minimum Total
Control reads

Advanced

>=0 Integers
only

1200

Minimum
number of
housekeeping
control reads
required to
compute
Imbalance
scores for 5p3p
Assays.

Make calls
based on
Imbalance
Score

Main

True/False

Boolean

True

If this flag is set
to true,
Imbalance
scores are used
to make Fusion
presence,
absence, or
Nocall calls.

Maximum
Imbalance for
Negatives

Advanced

Text field

String value in
specific format
as shown in the
default value.

Verify the user’s
input using a
Regular
expression.

ALK=0.001;RET=
0.03;R051=0.2

If the Imbalance
score of any
driver gene is
less than this
value, the
sample is called
Fusion Negative
for that gene.
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Fusions parameters
Pa:‘laar:lneeter Ul Group Allowed Values | Default Value Description
Minimum Advanced Text Field ALK=0.015;RET= | If the Imbalance
Imbalance for . . 0.55;R051=0.5 score of any
o String value in a . .
Positives 2. driver gene is
specific format reater than
as shown in the gr
this value, the
default value. .
sample is called
This verifies the Fusion Positive
user’s input for that gene.
using a Regular However, there
expression. .
is grey zone
between
maximum and
minimum values
where scores
are called
NOCALL. If they
are equal, there
is no grey zone.
Minimum Advanced Text Field ALK=5;RET=5;R |If the sum of
Isoform Counts . . 051=5 counts from all
String value in a .
for Imbalance = the isoforms of
specific format .
. that driver gene
as shown in the .
is greater than
default value. ;
this number,
This verifies the thresholds set
user's input by Maximum
using a Regular Imbalance for
expression. Negatives with
evidence from
/soforms and
Minimum
Imbalance for
Positives with
evidence from
/soforms are
used for the
Imbalance
scores.
Maximum Advanced Text Field ALK=0.001;RET= | If the Imbalance

Imbalance for
Negatives with
evidence from
Isoforms

String value in a
specific format

as shown in the
default value.

This verifies the
user's input
using a Regular
expression.

0.3;R0S1=0.15

score of any
driver gene is
less than this
value, the
sample is called
Fusion Negative
for that gene.
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Pa:‘laar:lneeter Ul Group Allowed Values | Default Value Description
Minimum Advanced Text Field ALK=0.01;RET=0 | If the Imbalance
Imbalance for . . .25:R051=0.5 score of any

o . String value in a . .
Positives with 2. driver gene is
. specific format
evidence from . greater than
as shown in the .
Isoforms this value, the
default value. .
sample is called
This verifies the Fusion Positive
user’s input for that gene.
using a Regular However, there
expression. .
is grey zone
between
Maximum and
minimum values
where scores
are called
NOCALL. If they
are equal, there
is no grey zone.
Estimate max Advanced >=0( % values) [0.5 Maximum

crosstalk

Float values

percentage of
spill-over reads
that could be
seen in any
sample due to
reasons like
Barcode
Crosstalk.
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Parameter
Name

Ul Group

Allowed Values

Default Value

Description

Analysis
configuration
file

Advanced

Path to a tab
separated file

A tab separated
file specific to
each panel that
enables users to
set individual
target specific
thresholds for
the following
properties, as
applicable for
that type:

e  Minimum
read count
e Minimum
normalized
read count

e Minimum
wild type
ratio

¢ Make calls

e Do not
report

e Max read
count
negative

Keep
Intermediate
files

Advanced

True/False
Boolean

False

Turn this flag on
to keep the
intermediate
files generated
when using the
Fusions
analysis.

Report non-
targeted fusions

Advanced

True/False
Boolean

True

If this flagged is
turned off, any
non-targeted
fusions detected
are not reported
in the output
VCF file.

Minimum Read
Counts for Gene
Expression
targets

Advanced

>=0 Integers
only

10

Threshold on
minimum
number of valid
reads aligned to
specific Gene
Expression
target in order
tocallitas
Present.

lon Reporter™ Software 5.6 Help

359




Fusion analyses
Fusions parameters

360

Pa;;r:‘eeter Ul Group Allowed Values | Default Value Description
Minimum Total | Main >=0 Integers Minimum
Valid mapped only number of total
reads Per Pool valid mapped
reads in each
pool (in the case
of multi-pool
RNA panels] in
order to qualify
that primer pool
as Valid.
Minimum Main >=1 Integers For multi-pool
number of Valid only RNA pools,
pools for specify
SampleQC minimum

number of pools
in a Sample that
have to pass QC
in order to
qualify that
Sample as Valid
and proceed
with the
Analysis.

Example : If a
panel has two
pools, use
value=2 to
specify that both
pools needs to
have sufficient
number of reads
in order to
qualify that
sample.

Similarly use
value=1to
proceed with the
analysis even if
one of the pools
failed.
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Parameter
Name

Ul Group

Allowed Values

Default Value

Description

Minimum mean
read length for
valid SampleQC

Advanced

Integers only

If the average
read length
computed from
all the reads in
the sample is
less than the
value specified,
that sample is
not qualified to
be Valid and
results are not
reported. This is
an additional
SampleQC
metric. Other
QC metrics are
minimum total
valid mapped
reads and
minimum
number of valid
pools. For
example, a
recommended
value is 50 bp.

Use pool
Specific
normalization

Advanced

True/False
Boolean

True

For multi-pool
RNA panels, use
this flag to
specify whether
read counts are
to be
normalized to
total reads in
each pool
separately or to
total reads in
the sample. This
also applies to
calculation of
wild type ratio
and normalized
count within
Gene metrics
for
RNAExonVariant
targets.
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Analysis configuration file for gene fusion analysis

Editable
parameters in the
analysis
configuration file

362

A new input Analysis configuration file is available that enables users to set
individual assay-specific thresholds for these six properties, as applicable for the type
of that individual assay:

Minimum read count

Minimum normalized read count

Minimum wild type ratio

Make calls
Do not report

Max read count negative

The analysis configuration file is a readable and editable tab-separated file which is
specific to a fusion panel. For a given panel, the file contains all the targets in the
panel as different rows and has 8 columns. The first two columns are the name and
type of the target in that row. The Name of the assay is the unique identifier and
provides mapping between the analysis configuration file and the reference files that
are used by the analysis. You can use the other columns to set the six different

properties at individual target level.

Parameter

Description

Min Read Count

This column allows users to set custom
minimum read count thresholds for
different target(s). If the value is specified
as "Use Global Value" for a target (the value
in the row) in this column, then the global
minimum read count threshold is used. (For
example: 20 reads or 40 reads for Fusions
as set using the minimum read count for
Fusions parameter.] If a user changes the
value for any target from "Use Global Value”
to an allowed integer value (for example:
50), then that value overrides the global
threshold. The new threshold (50 in this
example) is used to call that target as
Present/Absent. All other targets will still
use the global threshold. This column
overrides these global parameters at the
individual target level (minimum read count
for Fusions, minimum read count for
Controls, minimum read count for Gene
Expression, minimum read count for Non-
Targeted fusions). This property is not
applicable to 5p3pAssay type targets.
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Parameter

Description

Make Calls

Min WT Ratio

lon Reporter™ Software 5.6 Help

Min Normalized read count

This column allows users to set custom
minimum normalized read count
thresholds for different target(s). If the
value is specified as "Use Global Value” for
a target (the value in the row) in this
column, then the global minimum read
count threshold is used. (For example : 0.0
or 0.0015 reads for Fusions.] If a user
changes the value for any target from "Use
Global Value" to an allowed value (for
example : 0.1], then it overrides the global
threshold and the new threshold (0.1 in this
example] is used to call the target as
Present/Absent. This column can be used
to override the minimum normalized read
count global parameters at individual
target. This property is not applicable to
5p3pAssay type targets.

This column allows user to enable making
Present/Absent call for RNAExonVariants at
individual target level. This property is not
applicable to any other type. By default the
workflow parameters are set to not make
calls for all the RNAExonVariants. If the
value for any RNAExonVariant target (the
value in the row] is changed from "Use
Global value™ to “True”, the target will be
called Present/Absent based on the read
count and wild type ratio.

This column allows users to set custom
threshold for minimum wild type ratio for
RNAExonVariants at individual target level.
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Edit the gene
fusion analysis
configuration file

364

Parameter Description

Do Not Report By changing the value to "True” for any

Max Read Count Negative This column allows users to set NoCall

target, that target is not displayed in the
output files and reports.

range for any Fusion target. The value
specified in this column should be always
less than or equal to the value for minimum
read count as set by global parameter
threshold or custom threshold for that
target.

For example, if a global threshold for
minimum read count for Fusion is 40, and
the max read count negative is set to 20 for
atarget (T1)_, if the count of target T1 is
between 20 and 40, it will be called as
NoCall. If the count is <20 it is called as
Absent; if it is >40 it is called as Present.

This is not applicable to S5p3pAssay type
targets.

If the value for Max Read count Negative is
equal to the min read count for any target,
then the target is called Absent; if the read
count is less than that value, it is called as
Present.

For Oncomine " fusion workflows, a default analysis configuration file is provided.
You can modify this file to set custom thresholds.

1. Signin to Ion Reporter™ Software and click on the Workflows tab.

2. Search for, then select the Oncomine"™ fusion workflow that contains the
configuration file that you want to edit, then click Edit in the Details section.

3. Select a Research Application and Sample Group in the Edit Workflow screen,
then click Next.

4. Click Parameters in the workflow bar, then select Fusions, then click the
Advanced tab and scroll to the Analysis Configuration File section.

5. Click Download to download the analysis configuration file for the workflow.

6. Save the file to a local directory, then open the file and make edits to any of the
following properties:

Minimum read count

Minimum normalized read count
Minimum wild type ratio

Make calls
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* Do not report

* Max read count negative

See “Editable parameters in the analysis configuration file” on page 362 for more
details.

7. Save the file.

8. In the Analysis Configuration File section of the Parameters workflow bar, click
Upload.

9. Browse to the updated file and select the file, then click Upload in the dialog.

The updated configuration file is added to top of the drop-down list in the Analysis
Configuration File section.

Fusion sample type

When performing a fusion analysis, the sample type attribute must be set to RNA. See
“Import and manage samples” on page 34.

Gene fusion analysis results

Two new fields, Fusion Sample QC and Fusion Overall Call, are included in Ion
Reporter™ Software.

Analysis results are available in table form:
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Analysis results are also available as heat map images:

@ Analysis Visualization
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Use the following guidelines to interpret the fusion calls and other information that is
presented in the Analysis Results pages. In addition to fusion type assays, the
Analysis Results and Analysis Visualization present information on assays of other

types:

ASSAYS_5P_3P: These assays provide confirmation for the fusion calls, through
the values in the 3'/5' Imbalance column.

EXPR_CONTROL: Few expression control assays are built into the panel to
confirm the success of the sequencing run that the analysis is based on.
GENE_EXPRESSION: These assays provide confirmation for the Gene expression
amplicons that are built into the panel and their level of expression.
RNA_HOTSPOT: These assays provide confirmation for SNPs or INDELs at a
particular position (hot spot).

RNAExonVariant : This is a new type of assay added in Ion Reporter™ Software
5.4. These assays provide confirmation for the intra-genic events like Exon
Skipping deletions, alternate splice variants, expression of wild type transcripts
of the gene, and so on.

Note: In the table view, consider closing the Summary Panel on the right, to provide
more room for the table columns.
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Fusion Sample QC Metrics:

Total Mapped
Fusion Panel
Reads: gene
fusion Sample QC
metric

The Total Mapped Fusion Panel Reads is a QC metric that is reported for gene fusion
analyses.

This metric reports the sum of all reads that are valid and are assigned to any assay in
the panel. Unmapped reads and poorly aligned reads are excluded from this total.

We recommend that you set a total mapped reads for the fusion assay depending
upon the expected number of total reads per barcode which is based on the
sequencing platform, chip type and number of barcodes per run.

For example : For a sample sequenced using PGM 318 chip multiplexed using 8
barcodes, we expect more than 100000 reads per sample. Our recommended threshold
in this case is 20000 minimum total valid mapped reads.

A 20,000 minimum threshold is recommended to avoid the possibility of missing a
real fusion (a false negative). 20,000 mapped reads provide acceptably sensitive fusion
detection. At that coverage, fusions calls are reliable. However, a real fusion at low
abundance may be missed.

Below 20,000 mapped reads, the assay may lack sensitivity, and we recommend
repeating the experiment if possible (if sufficient original sample is available). In
addition, the 3'/5' Imbalance number is less reliable for very low mapped reads.

The assay is highly sensitive, and if a gene fusion isoform is detected, it is highly
likely to be truly present in the sequencing reads. If a fusion is detected in a sample
with a low number of total mapped reads, it is highly likely to be a true positive.
However, if a sample has a low number of mapped reads, a real fusion at low
abundance in the sample relative to the expression control genes may be missed. The
limit of detection is lower with larger numbers of mapped reads.

lon Reporter™ Software 5.6 Help 367



Fusion analyses
Fusion Sample QC Metrics:

Minimum Mean
Read length: gene
fusion Sample QC
metric

Minimum total
mapped reads per
pool

Minimum number
of Valid pools:
gene fusion
Sample QC metric

368

Mean Read Length is a QC metric available for the gene fusion analyses that was

added in Ion Reporter™ Software 5.4.

If the mean read length computed from all the reads in the sample is less than the
specified threshold, that sample does not pass the QC.

A 50bp minimum mean read length is recommended to avoid the possibility of
missing real fusions (false negatives) and reporting false positive fusions.

If the panel contains multiple primer pools, it is important to compute QC metrics per
each pool separately. Minimum number of total valid mapped reads per pool is an
additional QC metric for RNA Fusion panels with multiple primer pools. Total valid
mapped reads per pool is the count of all reads assigned to any target in each pool. If
any of the pools have total valid mapped reads less than the specified threshold, that
pool does not pass QC.

For multi-pool RNA pools, you can specify the minimum number of pools in a
Sample that are required to pass QC to qualify the Sample as Valid, then proceed with
the Analysis. If the number of valid pools in any sample is less than the specified
threshold, that Sample does not pass QC. Valid pools are determined by the total
valid mapped reads per pool.

Example: If a panel has two pools, use value=2 to specify that both pools need to
have a sufficient number of reads in order to qualify that sample. Similarly use
value=1 to proceed with the analysis even if one of the pools failed.
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Filters

For analyses from the AmpliSeq Colon Lung v2 with RNA Lung Fusion single sample
workflow, the first time the Analysis Results page Fusions tab is opened for an
analysis, it opens with no filter applied. This view shows targeted fusions that are not
found in your sample (and are reported as Absent in the Detection column), as well as
other variant types.

For a view that includes only Present fusion calls:

1. Click the Filter menu.

2. Select the Default Fusions View filter.

Note: The following will always be displayed as Filtered in Variants in the Type
column, whether the Default Fusions View filter is set to Present or Absent:
. EXPR_CONTROL

- ASSAYS_5P_3P
- RNA_HOTSPOT
- GENE_EXPRESSION

Expression controls

A limited number of expression control genes are built into the Ion AmpliSeq™ panel
for quality checking purposes. If multiple EXPR_CONTROL calls are reported as

Absent in the Detection column, check the Torrent Suite™ Software run report for the
sequencing run, as this result could indicate a low-quality run or failed amplification.
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FusionSampleOverallCall

Fusion calls

370

The FusionSampleOverallCall allows the user to confirm whether a sample is a No
Call, Positive, or Negative. Here is the logic applied:

Fusion Isoforms LGS e Final Call
Score
Positive Positive Positive
Positive No Call/Negative Positive
Negative Positive Positive
Negative Positive Positive
Negative No Call No Call
Negative Negative Negative

Fusion calls describe a translocation of genetic material. The Genes (Exons) column
reports the donor gene and the partner gene. The exon number for each gene is
reported in parentheses. For the donor gene (the first one in the pair), exon number
specifies the exon before the fusion. For the partner gene (the second one in the pair),
exon number specifies the exon after the fusion.

For example, in the second row, the Genes (Exons) column reports EML4(6) -
ALK(20):

* EMLA4(6) refers to exon number 6 on the EML4 gene (the donor gene in this
example). Exon number 6 in the donor gene indicates that the fusion starts after
exon 6.

e ALK(20) refers to exon number 20 in the ALK gene (the partner gene in this
example). Exon number 20 in the partner gene indicates that the fusion starts
before exon 20.

The Detection column reports whether the fusion meets the required threshold of
greater than 20 reads:

¢ Fail: Either no evidence for the fusion is found or fewer than 21 reads support the
fusion.

¢ Pass: Greater than 20 reads provide evidence for the fusion.

* Present-Non-Targeted: Greater than 250 reads provide evidence for a fusion that
is not explicitly included in the Ion AmpliSeq™ panel.

¢ No Call: Not enough evidence to determine if a fusion is present or not.
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Fusion calls

In some samples, non-targeted fusions may be reported, with the designation Present-
Non-Targeted in the Detection column. A non-targeted fusion is a fusion for which
the panel did not contain a specific primer pair, but it was picked up by a combination
of two of the primers used for two different targeted isoforms. The fusion was not
among the targeted isoforms and was not explicitly targeted by the panel. If there are
a small number of reads providing evidence for such fusions (for example, less than a
few hundred reads), these may not be important. If there is very strong evidence for
non-targeted fusions, they may be worth following up with more detailed
investigation. A literature search or a search of COSMIC or other databases may be
helpful in determining whether such fusions have ever previously been observed, and
may provide guidance in interpretation.

Occasionally, when a true positive fusion in a gene pair is detected, a second fusion in
the same gene pair may also be reported. Generally, a single fusion has occurred in
this pair of genes in this sample, and all the read evidence that covers any exon is
reported, which may occasionally be shown as a second fusion, usually describing a
different exon in one of the genes. This second fusion may be described as either a
targeted fusion (i.e., the panel has a specific assay designed to detect this fusion, so it
is designated Present in the Detection column) or a non-targeted fusion (detected, but
the panel has no specific assay pair designed for this fusion, so it is designated
Present-Non-targeted in the Detection column). Biologically, both of these calls are
likely from the same underlying fusion in the gene pair.

Other information reported for fusions:

* The Locus column reports the start and end positions of the fusion transcript.

* The Read Counts column reports the number of reads that provide evidence for
the fusion call. For ASSAYS_5P_3P, read counts are displayed in the order 5', 3".

e The COSMIC/NCBI column provides links at which the fusion is described in
these public web sites.

¢ The Variant ID column reports our internal short-hand for the fusion.

This module analyzes the reads from all the barcodes on a chip from one run and
determines if there are any reads in a particular barcode that could belong to any of
the barcodes.

For example, if barcode manufacturers provide us a QC threshold of 0.5%, i.e., there is
a chance that up-to 0.5% of the reads in any one barcode (say barcode?) could be
mislabeled as that barcode (barcode 7) where in reality those reads are from a
different barcode (say barcode 8). Usually for many applications this is not important.
But this is very important for applications for like Fusions which require high
sensitivity.

For example, if barcode 8 is positive for a fusion involving ROS1 gene with
read_count = 100000.

If barcode 7 also has ROS1 read_count = 30. (30 is less than 0.5% of 100000)

Current Fusions algorithm will call both barcode 7 and barcode 8 as positive, because
the read count in both these samples is >20 (our default threshold).

Barcode 7 is false positive and barcode 8 is true positive.

Barcode crosstalk is not the only source of the contamination, these types of reads
could also be seen due to sample-level contaminations as well.
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Partner genes in the lon AmpliSeq™ RNA Fusion panels

In order to identify these reads, this module needs to look at the reads from all
barcodes. The maximum estimated percentage of crosstalk is by default 0.5%, but
there is a parameter exposed in user interface that users can change.

This module generates as qcInfo file per barcode and summary file for the entire chip.
These files are generated before launching Fusions calling module on any one of the
barcodes and are passed to the Fusions module.

Partner genes in the lon AmpliSeq RNA Fusion panels

This panel contains the following four acceptor (driver) genes (in addition to many
donor genes):

RNAEXxonVariant

ALK
NTRK1
RET

ROS1
In analyses that are based on this panel, fusion calls report other genes targeted in
this panel that fused to these partner genes.

RNAExonVariant assays provide measurement of expression for Intragenic events
like Exon Deletions, Exon skipping events, Alternate Splice transcripts and Wild type
transcripts. For these assays, two additional metrics are reported (including read
count, normalized read count, RPM, and so on):

372

Ratio to Wild Type

— For all the RNAExonVariant assays that belong to a Gene with at-least one
RNAExonVariant type assay. It is designed to amplify the wild type
transcript of that gene and report this value.

— Ratio to Wild type of a RNAExonVariant Vi = (Read count of Vi) / (Mean read
count of all Wild Type RNAExonVariants for that gene)
Norm Count within Gene
For all the RNAExonVariant type assays, this normalized count is reported.

Norm count within Gene for RNAExonVariant Vi = (Read Count of Vi) / (Sum of
read counts of all RNAExonVariants of the same Gene).

Detection column for RNAExonVariant will have " N/A " as the value for all the
RNAExonVariants.
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Assays 5P_3P

5'and 3' assays provide confirmation for the fusion calls. This score is reported in the
3'/5' Imbalance column.

Four assays are built into the Ion AmpliSeq™ RNA fusion panels. Each assay
corresponds to one of the acceptor genes in the panel, and that corresponding
acceptor gene is reported in the Genes (Exons) column.

For example, the assay reported in the third column names ALK in the Genes (Exons)
column. The 3'/5' Imbalance score for this assay reflects the strength of the calls for all
fusions with the ALK driver gene (in rows 10 through 15 in this example).

(The Genes (Exons) column does not report exon numbers for assays rows.)
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Imbalance values
for assay calls
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The Imbalance value is a metric that we calculate to provide a measurement of the
strength of fusion calls that involve ALK, RET, or ROS1 driver genes.

We investigated several metrics and found Imbalance values to be a strong predictor
of true fusions calls. We continue to search for predictors for fusions that involve
NTRKT1 driver genes.

Imbalance values are reported in the 3'/5' Imbalance column. An assay's Imbalance
value applies to all fusion calls with the driver gene that is reported in the assay's
Genes (Exons) column.

An Imbalance value is calculated by subtracting the number of 5' reads from the
number of 3' reads, and dividing the result by the sum of all EXPR_CONTROL reads:

® (3'reads - 5'reads) / (sum of all EXPR_CONTROL reads)

Note: The column header "3'/5' Imbalance" in the Analysis Results pages implies
that the Imbalance value is a direct ratio of the 3' and 5' reads. The value is not a
direct ratio of 3' and 5' reads.

¢ Imbalance values are interpreted as follows:
— Higher Imbalance values (0.025 or greater) indicate a greater likelihood that
the fusion is present in your sample.

— Lower Imbalance values (either close to zero or negative) indicate a greater
likelihood that the fusion is not present in your sample.

Note: Imbalance values provide information that is supplementary to the
Detection calls of "Present” or "Absent". If a fusion call is "Absent", then we
recommended that you check the Imbalance value to see if there is supplemental
evidence of the presence of a fusion.
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Interpret 3'/5' Imbalance values in lon Reporter Software

The 3'/5' Imbalance values reporter in Ion Reporter™ Software generates analysis
results for Ion AmpliSeq™ gene fusions, such as the Ion AmpliSeq™ RNA Lung Fusion
workflow. The imbalance values reporter measures the difference in expression
between the 5' assay and the 3' assay of each driver gene. Samples that do not contain
a fusion are expected to have similar expression of the 5' assay compared to the 3'
assay of the driver gene. Samples that contain a fusion are often expected to have
elevated expression of the 3' assay compared to the 5' assay (see the following figure).
The 3'/5' Imbalance assay is therefore included for two alternate purposes:

The 3'/5' Imbalance values provide a measurement of the strength of fusion calls that
involve ALK, RET, or ROS1 driver genes, whether included or not included in the Ion
AmpliSeq™ RNA Fusion panel.

1. To confirm presence of a fusion from the ALK, RET, or ROS1 driver genes
included in the panel, or

2. If none of the fusions targeted by the panel is detected, to provide evidence of a
fusion other than those targeted by the panel but still including ALK, RET, or
ROS1 driver genes.

The following approaches interpret the 3'/5' Imbalance values for each gene are
reliable only under the conditions that are described in the following sections: Read
number impact on calculation sensitivity, Sensitivity, and High 5" expression. Most
samples that are tested for the 3'/5' Imbalance assay have been lung tumor tissue.
Threshold settings for other sample types can be sensitive to varying expression of
fusion gene and expression control genes.

Note: We currently do not have sufficient data to determine if the 3'/5' Imbalance
value is a predictor for the NTRK1 gene.

No Evidence of a . Strong Evidence of a
Gene . Uncertain .
Fusion Fusion
ALK <0.001 0.001-0.015 >=0.015
RET <0.03 0.03-0.55 >=0.55
ROS1 <0.2 0.2-0.5 20.5

For Oncomine Focus Panel, the following table lists the imbalance score thresholds:
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Imbalance value
calculation and
predictions
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No Evidence of a . Strong Evidence of a
Gene . Uncertain .
Fusion Fusion
ALK <0.001 0.001-0.0015 >=0.0015
RET <0.03 0.3-0.55 >=0.55
ROS1 <2.1 2.1-2.1 22.1

Note: The label 3'/5' Imbalance in the Analysis Results pages relays that the
imbalance value is a direct ratio of the 3' and 5' reads.

A 3'/5' Imbalance value is calculated by subtracting the number of 5' reads from the
number of 3' reads, and dividing the result by the sum of all EXPR_CONTROL reads:

(3' reads - 5' reads)/(sum of all EXPRE_CONTROL reads)

We find that imbalance values are a good predictor of the presence of a fusion:

¢ Innormal samples (without a fusion), imbalance values are very low (either close
to zero or negative).

* In samples that contain a fusion, imbalance values are higher, with gene-specific
thresholds shown in the above table.

In some cases, lower imbalance values are also good predictors of the presence of
fusions, as shown in the plots linked below.

Note: These guidelines apply to samples that meet the criteria described in the
sections: Minimum number of reads, Sensitivity, and High 5' expression. The values in
the plots below have been based on results obtained from 75 FFPE lung cancer
research samples previously tested with other technologies like FISH, IHC, and RT-
PCR.
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Example plot for ALK driver gene

The image linked here shows the correlation between low imbalance values and
samples that do not contain a fusion (in red). Samples that contain a fusion (in blue)
all contain higher imbalance values.
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Zoomed in view:

¢ A 3'/5' Imbalance value of 0.025 or greater indicates the likely presence of an ALK
fusion.

* Below 0.001, there is no evidence that an ALK fusion is present.

¢ The range of 3'/5' Imbalance values between 0.001 and 0.025 is an area of
uncertainty where there is some evidence that a fusion may be present. The
higher the imbalance values, the more evidence there is that a fusion is present.

Example plot for RET driver gene

The image linked here shows the correlation between low imbalance values and
samples that do not contain a fusion (in red). Samples that contain a fusion (in blue)
all contain higher imbalance values.
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Zoomed in view:

* A 3'/5' Imbalance value of 0.045 or greater indicates the likely presence of a RET
fusion.

e With a 3'/5' Imbalance value of 0.03, there is no evidence that a RET fusion is
present.

¢ The range of 3'/5' Imbalance values between 0.045 and 0.03 is an area of
uncertainty where there is some evidence that a fusion may be present. The
higher the imbalance values, the more evidence there is that a RET fusion is
present.
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Example plot for ROS1 driver gene

The image linked here shows the correlation between low imbalance values and
samples that do not contain a fusion (in red). Samples that do contain a fusion (in
blue) all contain higher imbalance values.

Zoomed in view:

e A 3'/5' Imbalance value of 0.5 or greater indicates the likely presence of a ROS1
fusion.

e With a 3'/5' Imbalance value of 0.2, there is no evidence that a ROS1 fusion is
present.

* The range of 3'/5' Imbalance values between 0.2 and 0.5 is an area of uncertainty

where there is some evidence that a fusion may be present. The higher the
imbalance value, the more evidence there is that a ROS1 fusion is present.
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e Atabove 150,000 mapped reads, the workflow is very sensitive.

* Between 20,000 and 150,000 mapped reads, the more reads, the more sensitive the
workflow is.

e With 20,000 or few mapped reads, we recommend that you rerun the sequencing
experiment, if possible. At around 20,000 or fewer reads, the potential for false
negatives (missing a real fusion) increases.

Sensitivity

The workflow is very sensitive for fusion detection and can possibly pick up noise if
there are problems with, for instance, the sample or library preparation.

Please check for High 5' expression and also check for the Minimum number of reads
before assuming that a fusion call of 'Present’ is confirmed.

High 5" expression

If the 5' read count is very high compared to the EXPR_CONTROL read count, the
3'/5' Imbalance value is not a reliable predictor. With high 5' read counts, the potential
for false negatives (missing a real fusion) increases.

The plot linked here shows a false negative in sample 32. The green line tracks the 5'
expression as 5' read counts divided by EXPR_CONTROL read counts. Note the spike
of high 5' expression at the false negative for sample 21.

We have not seen a high 5' expression to be associated with a false positive.
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How do | find the 3'/5' Imbalance value for a specific fusion?

Imbalance values are reported for ASSAY_5P_3P calls. The ASSAY_5P_3P's Imbalance
value applies to all fusions with the driver gene that appears in the ASSAY_5P_3P's
Genes (Exons) column:

Variant table Detection column and detection thresholds
information The Detection column reports Present for calls that are supported by read evidence.
The threshold for read evidence support varies by call type:
¢ Fusions: Greater than 20 supporting reads are required to report Present.
* Expression controls: Greater than 15 supporting reads are required to report
Present.
The Detection column reports the following values:

* Absent: Either no evidence for the call is found or fewer than the minimum
threshold number of reads support the call.

* Present: Greater than the minimum threshold number of reads provide evidence
for the call.

* Present-Novel: Greater than the minimum threshold number of reads provide
evidence for a fusion call that is not explicitly included in the Ion AmpliSeq™
panel.
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Variant ID column

The variant ID column reports our shorthand identifier for the fusion variant (or assay
or expression control). Each target in the Ion AmpliSeq™ panel has a unique variant

1D.
An identifier contains information that is available in other fields in the results table.
Information Description, example

Partner gene name ALK

Gene and exon number A13, for exon number 13 in the ALK gene

COSMIC ID, NCBI GenBank ID COSF1198, AB374361

Non-Targeted Appended to the Variant ID for fusion calls
that are not targeted by the lon AmpliSeq "
panel. Example: SLC34A2-
ROS1.S54R35.Non-Targeted

Examples of Variant IDs for fusion calls (these examples are from demo data):

e EMIL4-ALK.E6bA20.AB374362:
— EML4: Donor gene

- ALK: Partner gene
— E6: Exon number 6 in the ELM gene ("E" for "ELM")

— b: The second fusion (ordered by locus) with the same value in the Genes
(Exons) column

— A20: Exon number 20 in the ALK gene ("A" for "ALK")
— AB374362: GenBank ID

s SLC34A2-ROS1.54R35.: Non-Targeted
— SLC34A2: Donor gene

— ROSI: Partner gene

— S4: Exon number 4 in the SLC34A2 gene ("S" for "SLC34A2")
— R35: Exon number 35 in the ROS1 gene ("R" for "ROS1")

— Non-Targeted: Not included in the Ion AmpliSeq™ panel
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Descriptions of the variant table for fusion analyses

Column

Description

Checkbox

Enable checkboxes of variants, then use the
Selected Variants menu to hide those
variants or to order TagMan® assays or CE
primers for those variants.

Variant Detail icon

Opens the Variant Detail popup for the
variant (or assay or expression control).

My Variants flag Not used (the My Variants annotation
source does not apply to fusion analyses).

Locus The start and end points of the variant (or
assay or expression control].

Type Fusion call or other panel target.

Genes (Exons)

For fusion calls, reports the donor and
acceptor genes [(in that order, separated by
a hyphen). The exon number for each gene
is given in parentheses. For expression
controls and 5" and 3’ assays, the acceptor
gene is reported.

Read Counts

For fusion calls and expression controls,
reports the number of reads that support
the call. For 5" and 3’ assays, reports the
separate reads counts for the 5" assay and
the 3" assay (in that order, separated by a
commal).
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Column

Description

Detection

For fusion calls and expression controls,
uses Present to report that the expected
variant or control is found in your sample,
or reports Absent when the expected
variant or control is not found. Fusion
variants that are called in your sample but
not explicitly included in the lon AmpliSeq™
panel are reported as Present-Novel. See
also Detection column and detection
thresholds -- minimum read thresholds are
different for fusion calls and for expression
controls.

3'/5" Imbalance

For assay calls, reports a measurement of
the strength or quality of the related fusion
calls.

COSMIC/NCBI

For fusion calls, reports the associated
COSMIC ID or NCBI GenBank ID [if any).

Variant ID

Reports the short-hand identifier for the
variant (or assay or expression control].
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Interpret a fusion The analysis results provide several ways to confirm a fusion call, including
call Imbalance values, visualization, and Normalized Detection Fractions.

Imbalance values

Imbalance values are good predictors of fusion calls that involve ALK, RET, or ROS1
driver genes. We have not found Imbalance values to be predictors of fusion calls that
involve a NTRK1 driver gene.

Follow these steps to find the Imbalance value for a specific fusion call:

1. Find the fusion's driver gene (the second gene listed in the Genes (Exons)
column.

2. Find the ASSAYS_5P_3P entry that reports that driver gene in its Genes (Exons)
field.
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3. Use the Imbalance value for that ASSAYS_5P_3P entry to interpret the fusion
calls for all fusions whose driver gene matches the ASSAYS_5P_3P's Genes
(Exons) field.
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Visualize with IGV

Use IGV to evaluate both fusion calls and the expression controls.
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Visualize with heatmaps

Use heatmaps to see a one-page comparison of fusion calls across multiple analyses.

@ Analysis Visualization

Variants Table Variant Impact Gene Fusions CHV Heat Map
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Normalized Detection Fractions (NDF)

Normalized Detection Fractions provide the color-coding of calls in heatmaps.

-7.00 -3.50 0

Normalized Detection Fraction (NDF)

Normalized Detection Fractions are interpreted as follows:
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Higher values indicate a greater likelihood that the fusion call is correct and that
the fusion is present in your sample.

Lower values indicate a greater likelihood that the fusion is not present in your
sample.
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Visualize fusion results with IGV

An IGV visualization of a fusion call includes bars for the 3' gene and the 5' gene,
coverage for each of the bases, strand information, and each read with its start point
and end point.

Notes about the IGV visualization:

The grey line in the coverage track shows the coverage of each base.
Reads that are marked in red are on the positive strand.
Reads that are marked in blue are on the negative strand.

Zoom in to see individual bases.

These are the characteristics of an IGV visualization of a strong fusion call:

The 3' ends of reads all line up at the end of the 3' primer.
The 5' ends of reads all line up at the end of the 5' primer.
The reads cover the full length of the fusion.

Points to consider when using IGV to evaluate a fusion call:

What is the percent of overlap between the alignment and the 5' insert? How
good is the alignment in the overlapped region?

What is the percent of overlap between the alignment and the 3' insert? How
good is the alignment in the overlapped region?

Points to consider when using IGV to evaluate an expression control or assay call
(ASSAY_5P_3P or 3'/5' Imbalance):

What is the percent of overlap between the alignment and the insert?

e How good is the alignment in the overlapped region?
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1. In the Analysis Results page, click the Locus of a fusion variant.
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2. Windows users: save the file 1gv. jnlp. Then double click igv.jnlp to open

the IGV browser.

Visualize and compare fusion results of multiple analyses with heatmaps

With heatmap visualizations, you can see the presence or absence of fusions in your
samples, and you can compare the fusion calls across multiple analyses.

@ Analysis Visualization

Variants Table

-7.00

CCDCE-RET.CIR12.COSF12T1
COT4-NTRK1.CINTZ
COT4-ROE1.CERIZ.COGBFTZ0Z
CDT4-ROS1.CERY4.COSF1200
CEL-NTRK1.CTNT
CUXI-RET.C10RIZ

EML4-ALK E13A20 AB462411
Fldl 4-21 K F13A20 CNSFI0e>

Variant Impact

emo AnpliSeq Color

ocp dna

Gene Fusions

CHV Heat Map

-3.50

Mormalized Detection Fraction (MDF)

ju-
amo AmpliSeq RMA

ARUPround? run2iGo
RUPround? run2i60 |
ARUPround? nun2ao
RUPround? run2ian |
ARUPround? run2i6o
RUPround? run260 |

lonipress 013

INSERM lonXpress [

AmpliSeq RMAlung
AmpliSeq RMAlung

Follow these steps to visualize your results of multiple fusion analyses:

1. In the Analysis Overview page, enable the checkboxes of the analyses with the
results you want to visualize.
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2. In the Action menu on the right, click the Visualize option.
Note: The Visualize menu option is only available when you select more than
one analysis.

3. Inthe Analysis Visualization page, click the Gene Fusions tab.

Notes about heatmap visualizations:

¢ Interpret each cell according to the color scale above the chart. Cells with the
rightmost color are the strongest fusion calls.

-7.00 -3.50 ]
Normalized Detection Fraction (NDF)

e Normalized Detection Fraction (NDF) values are calculated as follows (for a
fusion F in sample S):

logl0 ((read count of F) / (total read count in S))

™

* The left side lists each of the fusion isoforms in the Ion AmpliSeq™ Panel.

* For fusions heat maps, NDF is used as the score for every fusion-sample pair to
generate the heat map. Thereafter hierarchical clustering is conducted for
clustering fusions and samples within the heat map.
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* By default, expression control and ASSAY_5P_3P calls are listed close to the
bottom of the chart.

Variants Table Variant Impact Gene Fusions CHNV Heat Map
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* You can change the order of the fusions (the list on the left side) through the Filter
Order menu on the right (under Chart Options).
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* Along the top, each sample is listed.

Variants Table Variant Impact Gene Fusions CNV Heat Map
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* You can change the order of the samples list (the list above the chart) through the
Sample Order menu on the right (under Chart Options).

The following ordering options are supported:
— Name: Alphabetically by sample name

— Similarity: By how similar the samples are in the fusion calls made
(presented from fewest fusions to most fusions)

— Similarity (reversed): By how similar the samples are in the fusion calls
made (presented from the most fusions to the fewest fusions)

— Analysis: Alphabetically by analysis name
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* Samples are also listed in the panel to the right.

* (lick the Selected Analyses link to see the list of analyses in the heatmap.
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* You can change the order of the color scheme used in the chart through the Color
Scale menu on the right (under Chart Options).

e  White or blank cells indicate no reads (in the default color scheme).

(Many cells in the example heatmap show no reads. Only an example block of no-
reads cells is outlined in this image. With red-green and red-blue color schemes,
red indicates a no-reads cell.)

* You can export a heatmap as an image or as a comma-separated text file.
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Export a heatmap

Use the Export Heatmap menu on the right (under Chart Options) to export a
heatmap.

Supported export formats are:
¢ PNG: Portable Network Graphics format
® SVG: Scalable Vector graphics format
* CSV: A comma-separated text file, readable by spreadsheet programs or as a text
file

Note: You can download CSV file in Chrome or Firefox; however, you may need to
manually change the file name and add a .csv extension on it. In testing, we found the
Safari browser could not download a CSV file.

Example of an analysis with no fusions called

This image shows an example of the Analysis Results table for a run in which no
fusions are called.
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Exon deletion thresholds for Oncomine Fusion panels

Note: When you sort on the Gene column, you may believe you are getting
inconsistent results. However, the sort is occurring on both of the genes involved in
the fusion. The lexicographically smaller gene is used for an ascending sort, while the
lexicographically larger gene is used for a descending sort.

Exon A lon Reporter Software
Oncomine Fusion Panel  Deletion Type sent Instrument/Chip P
Workflow
Assay Threshold
Oncomine ™ EGFRuvlll Fusion 120 lon PGM ™ System /lon  Oncomine
Comprehensive Fusion 318 ™ Chip Comprehensive w2.2 -
Panel Fusions
Oncomine
Comprehensive w2.2 -
DNA and Fusions
Oncomine ™ Focus MET exon  Fusion 120 lon PGM ™ System /lon  Oncomine Focus w2.2 -
Fusion Panel 14 318 ™ Chip Fusions
EGFRuvlII Fusion 120 Oncomine Focus w2.2 -
DNA and Fusions
Oncomine ™ Focus MET exon  Fusion 120 lon S5 ™ System / lon Oncomine Focus - 520 -
Fusion Panel for lon 520 14 520 ™ Chip w2.2 - Fusions
™ Chi
P EGFRuvlII Fusion 120 Oncomine Focus - 520 -
w2.2 - DNA and Fusions
Oncomine ™ MET exon  Fusion 1000 lon S5 ™ System / lon Oncomine
Comprehensive & Focus 14 540 ™ Chip Comprehensive v1 - 540
Fusion panel for lon 540 -w2.2 - DNA and
™ Chip Fusions
EGFRuvlII Fusion 1000 Oncomine
Comprehensive v2 - 540
-w2.2 - DNA and
Fusions - Single Sample
Oncomine ™ MET exon  RNAExonV 1000 lon S5 ™ System / lon Oncomine
Comprehensive v3 Panel 14 ariant 540 ™ Chip Comprehensive v3 -
w3.0 - DNA and Fusions
- Single Sample
EGFRuvlII RNAExonV 1000 Oncomine
ariant Comprehensive v3- w3.0
-Fusions - Single
Others (9  RNAExonV Present/Ab Sample
other ariant sent calls
genes have are not
similar made
assays)
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Web services API

Ion Reporter™ Software contains a powerful web services API that allows you to
automate pulling key pieces of information from the system.

Use the API

1

This section provides an example of how to leverage the API built into Ion Reporter™
Software.

Notes:

e These examples show use with the hosted Ion Reporter™ Software instance. If you
are running a local version on your own Ion Reporter™ Server System, then
replace the hosted URL

https://ionreporter.thermofisher.com/ir
with the URL root of your local instance.

¢ Example (invalid) authentication tokens are shown.

¢ If the JSON download process converts "@" symbols to "%40", do not change the
text. Just copy the files into your browser as is.

Get data upload path with authentication

The getDataUploadPathWith Auth code flow is used by Ion Reporter Uploader (IRU)
and returns the current data upload path, based on server.properties configuration.

URL: /api/vl/getDataUploadPathWithAuth
HTTP Method: POST
Request Form Parameters: auth. String. Mandatory. Valid API Token.

http://ionreporter.thermofisher.com/api/vl/
getDataUploadPathWithAuth

Request Headers Content Type: application/x-www-urlencoded
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Returns: Returns the current data upload path of the organisation given by the user's
API token.

/data/IR/data/IR _Org/data/IRU Uploads

Status Code Response Message

200 Successful response

400 Bad request

401 User is not authenticated
500 Error occurred

Curl Command:

curl -X POST -d
"auth=ND1iYmUOOWE4MzA3YmE2MWVmMMjhlZT1hOTEyMmES50DMONZzU3NjJQ40GM5N
zVjODU3Yjd1MWM4Mjk30GYzODE4Yw" --header "Content-Type:
application/x-www-form-urlencoded" -k https://<your server
name>/api/vl/getDataUploadPathWithAuth

Check if sample exists

The isSampleExist code flow is used by lon Reporter Uploader (IRU) when importing
a sample. It checks if the sample with the given name exists or not.

URL: /api/v1/isSampleExists
HTTP Method: POST

Request Form Parameters: sampleName. String. Mandatory. Valid sample Name.

http://ionreporter.thermofisher.com/api/vl/isSampleExists
Request Headers: Content Type: application/x-www-form-urlencoded;
Authorization: API Token.

Returns: Returns true or false depending on whether sample with given name already
exists in the organisation given the user's API token in headers.

Response Fields:

Status Code Response Message

200 Successful response

400 Bad request

401 User is not authenticated
500 Error occurred
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Curl command:

curl -X POST -k https://your server name/api/vl/isSampleExists
-H "Content-Type:application/x-www-form-urlencoded" -H
"Authorization:ND1iYmUOOWE4MzA3YME2MWVMMIhlZT1hOTEyMmES50DMONZzU3
NjQ40GM5NzVjODU3Y]d1MWM4AM k30GYZzODE4Yw" -d
"sampleName=Poo C03-740 DNA 009 think3 IRUCLI"

Get user details

The getUserDetails code flow is used by IRU and gets user details based on user-name
and password.

URL: /api/v1/getUserDetails

HTTP Method: POST

Request Form Parameters:

userName. String. Mandatory. Valid user name.

password String. Mandatory. Valid password.

http://ionreporter.thermofisher.com/api/vl/getUserDetails

Request Headers: Content Type: application/x-www-urlencoded

Returns: Returns user details.

{

"tokendate": "2013-12-08 15:39:37.0",

"firstname": "Ion",

"eulaAccepted": "true",

"userStatus": "ENABLED",

"orgname": "IR Org",

"exporttokendate": "2015-11-05 03:25:12.0",

"exporttoken":
"49bbed9a8307ba61ef28ee9a9122a98347576488c975¢c857b7e1c82978£381
8c",

"lastname": "User",

"token": "wVcoTeYGfKxItiaWo2lngsV/
r0jukG2pLKbZBkAFn1PbjKfPTXLbIhPb47YAu78"
}

Response Fields:

Status Code Response Message

200 Successful response
400 Bad request

401 User is not authenticated
500 Error occurred
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Get user details with authentication

Curl command:

curl -X POST -k https://your server/api/vl/getUserDetails -H
"Content-Type:application/x-www-form-urlencoded" -d
"userName=ion.reporter@lifetech

.com&password=IonPassl23"

Get user details with authentication

402

The getUserDetailsWithAuth code flow used by IRU and returns user details based on
API token.

URL: /api/v1/getUserDetailsWithAuth
HTTP Method: POST
Request Form Parameters: String. Mandatory. Valid user API token.

http://ionreporter.thermofisher.com/api/vl/
getUserDetailsWithAuth

Request Headers: Content Type: application/x-www-form-urlencoded

Returns: Returns the user details.

{

"tokendate": "2013-12-08 15:39:37.0",

"firstname": "Ion",

"eulaAccepted": "true",

"userStatus": "ENABLED",

"orgname": "IR Org",

"exporttokendate": "2015-11-05 03:25:12.0",

"exporttoken":
"49bbed9a8307ba61ef28ee9a9122a98347576488c975¢c857b7e1c82978£381
8c",

"lastname": "User",

"token": "wVcoTeYGfKxItiaWo2lngsV/
r0jukG2pLKbZBkAFn1PbjKfPTXLbIhPb4 7YAu78"
}

Response Fields:

Status Code Response Message

200 Successful response
400 Bad request

401 User is not authenticated
500 Error occurred

Curl command:
curl -X POST -k https://<your server name>/api/vl/

getUserDetailsWithAuth -H "Content-Type:application/x-www-form-
urlencoded" -d
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"auth=ND1iYmUOOWE4MzA3YmE2MWVMMjhlZT1hOTEyMmES5ODMONZzU3NSQ40GM5N
zV3jODU3Yjd1MWM4M) k30GYZODE4Yw"

Get available storage space

The getAvailableStorageSpace code flow returns the available storage space in bytes
of the organization associated with the API token in headers.

URL: /api/v1/getAvailableStorageSpace
HTTP Method: POST
Request: http://ionreporter.thermofisher.com/api/v1/getAvailableStorageSpace

Request Headers: Content Type: application/x-www-form-urlencoded;
Authorization: API token

Returns: Returns the available storage space in bytes of the organisation given the
user's API token in headers.

Response Fields:

Status Code Response Message

200 Successful response

400 Bad request

401 User is not authenticated
500 Error occurred

Curl command:

curl -X POST -k https://<your server name>/api/vl/
getAvailableStorageSpace -H "Content-Type:application/x-www-—
form-urlencoded" -H
"Authorization:ND1iYmUOOWE4AMzA3YME2MWVMMjhlZT1hOTEyMmESODMONZU3
NjQ40GM5NzVjODU3Yjd1MWM4M) k30GYZzODE4Yw"

Get available cancer types

The getAvailableCancerType code flow returns the list of all available cancer types
defined in attribute-controlled vocabulary.

URL: /api/v1/getAvailableCancerType
HTTP Method: POST
Request: http://ionreporter.thermofisher.com/api/v1/getAvailableCancerType

Request Headers: Content Type: application/x-www-form-urlencoded;
Authorization: API token
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Returns: Returns the available cancer types defined in attribute-controlled vocabulary.

["Bladder Cancer","Breast Cancer","Colorectal

Cancer", "Endometrial Cancer",

"Esophageal Cancer","Gastric Cancer","Gastrointestinal Stromal
Tumor", "Glioblastoma"

, "Head and Neck Cancer","Kidney Cancer","Liver

Cancer", "Melanoma", "Mesothelioma",

"Non-Small Cell Lung Cancer","Osteosarcoma","Ovarian

Cancer", "Pancreatic Cancer",

"Prostate Cancer","Skin Basal Cell Carcinoma","Small Cell Lung
Cancer",

"Soft Tissue Sarcoma","Testicular Cancer","Thyroid

Cancer", "Unknown"]

Response Fields:

Status Code Response Message

200 Successful response
400 Bad request

401 User is not authenticated
500 Error occurred

Curl command:

curl -X POST -k https://<your server name>/api/vl/
getAvailableCancerType —-H "Content-Type:application/x-www—form-
urlencoded" -H
"Authorization:ND1iYmUOOWE4MzA3YmE2MWVMMjhlZT1hOTEyMmES0DMONZU3
N3Q40GM5NzV5ODU3Yjd1MWM4Mk30GYZODE4Yw"

Get workflow names

404

The getWorkflowNamesWithApplicationTypeWithAuth code flow is used from
within IRU to get list of IRU-tagged workflows for the given version. If there are no
IRU-tagged workflows, all workflows for a specified version are returned.

URL: /api/vl/getWorkflowNamesWithApplicationTypeWithAuth
HTTP Method: POST

Request:
http://ionreporter.thermofisher.com/api/v1/getWorkflowNamesWithApplicationType
WithAuth

Request Headers: Content Type: application/x-www-form-urlencoded;
Authorization: API token: Version: IR52

Returns: Returns the list of Workflow details for the version specified in the header

[
{
"ApplicationType": "Amplicon Sequencing",
"Workflow": "RK GSTT1 GRCh38 APRO6",
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"irVersion": "52",
"tag isFactoryProvidedWorkflow": "false",
"irReference": "GRCh38"
}
]
Response Fields:
Status Code Response Message
200 Successful response
400 Bad request
401 User is not authenticated
500 Error occurred

Curl command:

curl -X POST -k https://<your server name>/api/vl/
getWorkflowNamesWithApplicationTypeWithAuth -H "Content-
Type:application/x-www—-form-urlencoded" -H
"Authorization:ND1iYmUOOWE4MzA3YmME2MWVMMIhlZT1hOTEyMmES0DMONzZU3
NjQ40GM5NzViODU3YJd1MWM4MI k30GYZODE4Yw" -H "Version:52"

Start an analysis

The startAnalysis code flow is used by IRU to start an analysis for the given setld.
URL: /api/v1/startAnalysis

HTTP Method: POST

Request Form Parameters:

setld. String. Mandatory. setld column value of the sample in the when the sample is
uploaded through IRU.

containerName. String. Mandatory. User specified unique name for the analysis that
will show up on Ion Reporter user interface.

http://ionreporter.thermofisher.com/api/vl/startAnalysis

Request Headers: Content Type: application/x-www-form-urlencoded;
Authorization: API token

Returns: Returns JSON with status and message.

{ "status":true, "message":"success"}
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Get .vcf files

406

Response Fields:

Status Code Response Message

200 Successful response

400 Bad request

401 User is not authenticated
500 Error occurred

Curl command:

curl -X POST -k https://<your server name>/api/vl/
startAnalysis -H
"Authorization:ND1iYmUOOWE4MzA3YmE2MWVMMjhlZT1hOTEyMmES0ODMONZzU3
NjQ40GM5NzVjODU3Yjd1MWM4AMk30GYZzODE4AYw" —d

"setId=4 f535ccde-5c6a-490d-
ald2-7b81352e6830 2016-6-17 1 13 24&containerName=New Analysis
Name"

The getvcf code flow gets the links to download .vcf files.

URL: /api/v1/getvct

HTTP Method: GET

Request Query Parameters:

format. String. Optional. Response type, current version supports only json

type. String. Optional. Valid values are "sample" or "analysis"

name. String. Conditional. If type parameter is "sample” then name is Mandatory
id. String. Optional. Id of an Analysis

start_date. String. Optional. Parameter to filter the results by date boundary. Date
format should be in yyyy-MM-dd

end_date. String. Optional. Parameter to filter the results by date boundary. Date
format should be in yyyy-MM-dd

duration. String. Optional. Parameter to filter the results by days/months.

"non

Valid value starts with "-" followed by numeric value and ends with "d" or "m"
exclude. String. Optional. Parameter to filter the response.
Valid values are "unfilteredvariants" or "filteredvariants"

Sample Request:
http://ionreporter.thermofisher.com/api/vl/getvcft?

format=json&name=xyzsampletest
&start date=2016-01-0l&end date=2016-02-01
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Request Headers: Content Type: application/x-www-form-urlencoded;
Authorization: API token

Returns: JSON object containing the download information.

Sample Response:

[
{

"data links": "http://ionreporter.thermofisher.com/api/vl/
download?
filePath=/data/IR/data/IR Org/ion.reporter@lifetech.com/
JohnSmithSample

/JohnSmithSample 20160429014705727/
JohnSmithSample c150 2016-04-29-14-16-534.zip",
"name": "JohnSmithSample c150 2016-04-29-14-16-534",
"id": "ff808181545d90790154613336be0008"

Response Fields:

Status Code Response Message

200 Successful response

400 Bad request

401 User is not authenticated
500 Error occurred

Curl command:

curl -v -k -X GET "https://<your server name>/api/vl/getvcf?
format=json&name=BRCA Plus RR jul29&start date=2016-07-25&end d
ate=2016-07-31" -H "Content-Type:application/x-www-form-
urlencoded" -H
"Authorization:ND1iYmUOOWE4MzA3YmME2MWVMMIhlZT1hOTEyMmESODMONzZU3
NjQ40GM5NzViODU3YFd1MWM4AMS k30GYZODE4Yw"

Check if analysis is running

The isAnalysisRunning code flow checks if the analysis is running.
URL: /api/v1/isAnalysisRunning

HTTP Method: POST

Request Form Parameters:

Content Type: application/x-www-urlencoded

Response Fields: userld. String. Mandatory. Userld

http://ionreporter.thermofisher.com/api/vl/isAnalysisRunning
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Request Headers: Content-Type: application/x-www-form-urlencoded;
Authorization: API Token

Returns: Returns JSON with status and message.

{ "status":true, "message":"success"}
Status Code Response Message

200 Successful response

400 Bad request

401 User is not authenticated
500 Error occurred

Curl command:

curl -X POST -k https://<your server name>/api/vl/
isAnalysisRunning -H "Content-Type:application/x-www-form-
urlencoded" -H
"Authorization:ND1iYmUOOWE4MzA3YmEZ2MWVMMjhlZT1hOTEyMmESODMONZzU3
N9jQ40GM5NzViODU3Yjd1MWM4AM)k30GYzODE4Yw" -d "userId=100"

Unshare analyses

The unshared Analyses code flow unshares analyses.
URL: /api/v1l/unshared Analyses
Method: POST

Request Form Parameters: userld. String. Mandatory. Userld

http://ionreporter.thermofisher.com/api/vl/unsharedAnalyses

Request Headers: Content Type: application/x-www-urlencoded; Authorization: API
token

Returns: Returns JSON with status and message

{ "status":true, "message":"success"}

Response Fields:

Status Code Response Message

200 Successful response

400 Bad request

401 User is not authenticated
500 Error occurred
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Curl command:

curl -X POST -k "https://<your server name>/api/vl/
unsharedAnalyses" -H "Content-Type:application/x-www-form-—
urlencoded" -H
"Authorization:ND1iYmUOOWE4MzA3YmE2MWVMMjhlZT1hOTEyMmESODMONZzU3
NjQ40GM5NzVIODU3Yjd1MWM4M)k30GYzODE4Yw" -d
"userId=f£8081815547ceb401554d62c0ec0493"

download

The download code flow gets the file, creates a zip file and downloads it.
URL: /api/vl/download

HTTP Method: GET

Request Query Parameters:

filePath. String. Mandatory. Valid filePath.

"

type. String. Optional. Valid values are "pdf" or
downloads it.)

. (by Default creates a zip file and

http://ionreporter.thermofisher.com/api/vl/download?type=pdfs&
filePath=/data/IR/data/IR Org/download/pdf/3bf2ffb3-
c55e-4da8-819e-f51a6957ad66/

IR42 AmpliSeq Colon Lung vZ2 with RNA Lung Fusion single
sample octl.pdf"

Request Headers: Content Type: application/x-www-form-urlencoded;
Authorization: API token
Returns: Downloads the given file.

Response Fields:

Status Code Response Message

200 Successful response

400 Bad request

401 User is not authenticated
500 Error occurred

Curl command:

curl -O -v -k -X GET "https://<your server name>/api/vl/
download?filePath=/data/IR/data/IR Org/data/IRU Uploads/
2016-7-26 23 8 42/v2/report.pdf" -H "Content-
Type:application/x-www—form-urlencoded" -H
"Authorization:ND1iYmUOOWE4MzA3YmE2MWVMMjhlZT1hOTEyMmES0DMONZU3
NjQ40GM5NzV5ODU3Yjd1MWM4M] k30GY ZODE4YwW"
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finalreport
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The finalreport code flow gets the analysis details and returns links to the Final
Report.

URL: /api/v1/finalreport

Method: GET

Request Query Parameters:

format. String. Optional. Response type, current version supports only json

type. String. Optional. Valid values are "sample" or "analysis"

name. String. Conditional. If type parameter is "sample" then name is Mandatory

id. String. Optional. Id of an Analysis by default. If type is sample, this corresponds to
the sample id

start_date. String. Optional. Parameter to filter the results by date boundary. Date
format should be in yyyy-MM-dd

end_date. String. Optional. Parameter to filter the results by date boundary. Date
format should be in yyyy-MM-dd

http://ionreporter.thermofisher.com/api/vl/finalreport?
fomat=jsoné&type=analysis

&name=IR42 AmpliSeq Colon Lung v2 with RNA Lung Fusion single
sample octl

&start date=2014-01-30&end date=2016-04-12

Request Headers: Content Type: application/x-www-form-urlencoded
Authorization: API Token

Returns: JSON object containing download information

[
{

llsummaryll : " ll,
"final report template": "Default Final Report Template",
"report pdf": "http://ionreporter.thermofisher.com/api/vl/

download?type=pdfé&
filePath=/data/IR/data/IR Org/download/pdf/
3bf2ffb3-c55e-4da8-819e-£f51a6957ad66/
IR42 AmpliSeq Colon Lung v2 with RNA Lung
Fusion single sample octl.pdf",
"created on": "2016-03-24T03:11:16.000-07:00",
"name": "IR42 AmpliSeq Colon Lung v2 with RNA Lung Fusion
single sample octl",
"id": "ff80818148c803530148cdb524020071",
"variants": [
{
"{\" _id\":[\"com.mongodb.BasicDBObject\",
{\"c\":1,\"p\":115252204}]1,\"GT\":\"0/0\"}": {
"comments": "",
"gene": "NRAS",
"annotations": "",
"locus": "chrl:115252204",
"classification": "UNCLASSIFIED",
"exon": "4",
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"sample": [

{

"Auto user PG1-10-140127 ColonLung v3 test 627 279 IonXpress 0

OB_le: {
"mutation": "",
"protein": ""
}
}
]
}
}
1,
"analysis": "http://ionreporter.thermofisher.com/api/vl/

analysis?id=
££80818148¢c803530148cdb524020071",
"ion reporter version": "4.2",
"created by": "Report User"

}

Response Fields:

Status Code Response Message

200 Successful response
400 Bad request

401 User is not authenticated
500 Error occurred

curl -v -k -X GET "https://<your server name>/api/vl/
finalreport?
format=json&name=BRCA Plus RR jul29&type=analysisé&start date=20
16-07-25&end date=2016-07-31" -H "Content-Type:application/x-
www—form-urlencoded" -H
"Authorization:ND1iYmUOOWE4MzA3YmEZ2MWVMMjhlZT1hOTEyMmESODMONZzU3
N3Q40GM5NzViODU3Yjd1MWM4AM k30GYZzODE4 Yw"

Get QC report

The qcreport code flow gets the QC Report.

URL: /api/v1/qcreport

HTTP Method: GET

Request Query Parameters:

format. String. Optional. Response type, current version supports only json
type. String. Optional. Valid values are "sample" or "analysis"

name. String. Conditional. If type parameter is "sample" then name is Mandatory

id. String. Optional. Id of an Analysis
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start_date. String. Optional. Parameter to filter the results by date boundary. Date
format should be in yyyy-MM-dd

end_date. String. Optional. Parameter to filter the results by date boundary. Date
format should be in yyyy-MM-dd

"

view. String. Optional. Valid values are "summary" or

http://ionreporter.thermofisher.com/api/vl/qcreport?
fomat=json&type=analysisé&

name=Demo AmpliSeq Exome

VCF _1460407585676&start date=2016-01-30&end date=2016-04-12

Request HeadersContent Type: application/[SON; Authorization: API token

Returns: JSON object containing download information

[
{
"stage": "VARIANT REVIEW",
"flagged": false,
"name": "Demo AmpliSeqg Exome VCEF 1460407585676",
"id": "£f80818153ed40a401540716785a081a",
"gc_metrics": {
"Demo AmpliSeq Exome VCFEF": {
"Number of Heterozygous SNVs": " 32451",
"CNV/Total": " 0.000",
"Number of Homozygous INDELs": " 1089",
"Ti/Tv Ratio (SNPs)": " 2.308",
"MAPD": "N/A",
"LongDels/Total": "™ 0.000",
"Number of Heterozygous INDELs": " 2113",
"Heterozygotes/Homozygotes": " 1.737",
"Indels/kb": " 0.001",
"Number of Heterozygous MNVs": " 0",
"Number of LongDels": " 0",
"Number of Homozygous MNVs": " 0",
"Indels/Total"™: "™ 0.059",
"SNPs/kb": " 0.017",
"Number of Homozygous SNvVs": " 18814",
"Number of CNVs": " 0",
"dbSNP concordance": " 0.934"
}
by
"started by": "Ion User",
"ion reporter version": "5.2",
"samples": {
"PROBAND": "Demo AmpliSeqg Exome VCE"
s
"qgc report pdf": "http://
ionreporter.thermofisher.com/api/vl/download?type=pdfs&
filePath=/data/IR/data/IR Org/download/pdf/
890e4268-46dc-442b-aded-aa87bb28f71a/
££80818153ed40a401540716785a081a QC.pdf",

"start date": "2016-04-11 13:49:53.0",

"status": "SUCCESSFUL",

"gc package": "http://ionreporter.thermofisher.com/api/vl/
download?

filePath=/data/IR/data/IR_Org/
ion.reporter@lifetech.com/
Demo AmpliSeq Exome VCF/
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Demo AmpliSeq Exome VCF 20160411134952720/
analysis downloads/QC Bundle/
gqc-report-
Demo AmpliSeq Exome VCF 1460407585676 2016-04-12 04-33.zip"
}
]

Response Fields:

Status Code Response Message

200 Successful response

400 Bad request

401 User is not authenticated
500 Error occurred

Curl command:

curl -v -k -X GET "https://<your server name>/api/vl/gcreport?
format=json&name=BRCA Plus RR jul29&type=analysis&start date=20
16-07-25&end date=2016-07-31" -H "Content-Type:application/x-
www—form-urlencoded" -H
"Authorization:ND1iYmUOOWE4MzA3YmE2MWVMMjhlZT1hOTEyMmESODMONZzU3
N3jQ40GM5NzViODU3Yjd1MWM4AM)k30GYZODE4Yw"

Get analysis details

The analysis code flow gets analysis information.

URL: /api/v1/analysis

HTTP Method: GET

Request Query Parameters:

format. String. Optional. Response type, current version supports only json

type. String. Optional. Valid values are "sample" or "analysis"

name. String. Conditional. If type parameter is "sample” then name is Mandatory
id. String. Optional. Id of an Analysis

start_date. String. Optional. Parameter to filter the results by date boundary. Use date
format: yyyy-MM-dd

end_date. String. Optional. Parameter to filter the results by date boundary. Use date
format: yyyy-MM-dd

duration. String. Optional. Parameter to filter the results by days/months.

non

Valid value starts with "-" followed by numeric value and ends with "d" or "m"
exclude. String. Optional. Parameter to filter the response.

Valid values are any single or comma-separated combination of values "reports,
unfilteredvariants, filteredvariants"
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"

view. String. Optional. Valid values are "summary" or

Sample Request:

http://ionreporter.thermofisher.com/api/vl/analysis?
format=json&name=xyzsampletest

&exclude=reports, filteredvariants,unfilteredvariantsé&start date
=2016-01-01 N
&end date=2016-02-01

Request Headers: Content Type: application/x-www-form-urlencoded;
Authorization: API token

Returns:

[
{
"reports": {
nqcn : {
"link": "http://ionreporter.thermofisher.com/api/vl/
download?type=pdfé&
filePath=/data/IR/data/IR Org/download/pdf/
30cf8ff3-fe3d-4cac-8f7d-ced5aa7d34el/
£f£80818153ed40a401540716785a081a QC.pdf"

}y

"final™: {}
s
"report published": "",
"workflow": "Annotate variants single sample",
"data links": {
"filtered variants": "http://

ionreporter.thermofisher.com/api/vl/download?
filePath=/data/IR/data/IR Org/
ion.reporter@lifetech.com/
Demo AmpliSeq Exome VCEF/

Demo AmpliSeq Exome VCF 20160411134952720/

Demo AmpliSeq Exome VCF 1460407585676.zip",
"unfiltered variants": "http://
ionreporter.thermofisher.com/api/vl/download?
filePath=/data/IR/data/IR_Org/
ion.reporter@lifetech.com/
Demo AmpliSeq Exome VCEF/

Demo AmpliSeq Exome VCF 20160411134952720/

Demo AmpliSeqg Exome VCF 1460407585676.zip"
Iy

"variants saved":

wn
14

"samples": {
"PROBAND": "Demo AmpliSeq Exome VCE"
}y
"shared with": [],
"stage": "Review Variants",
"flagged": false,
"name": "Demo AmpliSeq Exome VCF 1460407585676",
"id": "ff80818153ed40a401540716785a081a",
"ion reporter version": "5.2",
"started by": "Ion User",

"start date": "April 11, 2016",
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"status": "SUCCESSFUL"

Response Fields: JSON object containing the download information.

Example Curl command:

curl -v -k -X GET "http://ionreporter.thermofisher.com/api/vl/
analysis?format=json&name=xyzsampletest

&exclude=reports, filteredvariants,unfilteredvariants&start date
=2016-01-01

&end date=2016-02-01" -H "Content-Type:application/x-www-form-
urlencoded" -H
"Authorization:ND1iYmUOOWE4MzA3YmME2MWVMMihlZT1hOTEyMmESODMONZU3
NjQ4GM5NzVjODU3Yjd1MWM4AM I k30GYZzODE4Yw"

Status Code Reason

401 Header Authorization key is null or empty

400 start_date is after end_date in query
params

400 Wrong format of start_date or end_date

400 If type is "sample” and query param name
is null or empty

500 Exception on exporting analysis

200 success

Get whole genome view png

Gets the whole genome view png for analysis.
URL: /api/vl/genomeView

HTTP Method: GET

Request Query Parameters:

id. String. Optional. Id of an Analysis, If name parameter is empty then id is
Mandatory

name. String. Optional. Name of an Analysis, If id parameter is empty then name is
Mandatory.

¢ If both id and name is given as input then genome-view png will be displayed for
Id, and name won't be considered.

* Whole Genome View image will be displayed as part of the response along with
analysis and sample name as the header.

¢ If no png file available in /outputs folder then response is 200 with following
message: "Genome View PNG not found." [with analysis name and sample name]
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Version. String. Conditional. Application version on which analysis lunched. For
analysis with older application versions we have to provide "Version=<IR version>" as
parameter, along with name.

Sample Request:

https://ionreporter.thermofisher.com/api/vl/genomeView?
1d=ff8081815ba8eac4015ba8ead9ce005d

Request Headers: Content Type: application/x-www-form-urlencoded
Authorization: API token

Returns: PNG image file for whole genome view of analysis.

Example Curl command:

curl -v -k -X GET "https://
uat.lonreporter.thermofisher.com/api/vl/genomeView?
name=GVRTestSample2&Version=IR54"-H "Content-
Type:application/x-www—form-urlencoded" -H
"Authorization:YmZkM2YxYJjEzMDBmMZTI4MDgwMmM5YjIzMGY1MjEyZDMyMGI 3
ZTUSMMQyZGY4ZmIXZWISM2ViYzIxZWNhOWU3NQ"

Status Codes:

Status Code Reason
200 Successful response
400 Bad request
401 User is not authenticated
404 Not found
500 Error occurred
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Download analysis information

This example uses curl commands to download information about a specific analysis.
The output of the first curl command gives us URLs to use in later curl requests.

This curl command requests analysis information for an analysis named
IR50_Rc10_Ane_BC18_DeganCases_1014_np:

curl --request GET -k -H
"Authorization:ZTRhNWYyNjkzZjhlYjMxMTdmM2FkZGM1 ZmOxYmRkNzU2ZTIx
ODk50GRJ ZWM5ZDY2MjMzMTBi0GIwZWESNmMNING" "https://
baseline.itw/api/vl/analysis?
format=json&name=IR50 Rcl0 Ane BC18 DeganCases 1014 np"

The output is in JSON format:

[

"reports": {
"gc": |
"link": "https://baseline.itw/api/vl/download?
filepath=/data/IR/data/IR Org/download/pdf/98ccb759-010£f-4c92-
acba-2da2d8aa9f4d/f£8081815067ca42015068£99193000d QC.pdf"
by

"final": {}
}y
"report published": "",
"workflow": "Low-pass whole-genome aneuploidy",
"data links": {
"filtered variants": "https://baseline.itw/api/vl/

download?filepath=/data/IR/data/IR Org/
ion.reporter@lifetech.com/Ane BC18 DeganCases/

Ane BC18 DeganCases 20151014174956618/

IR50 Rcl0 Ane BC18 DeganCases 1014 np  4f776c35-4a9f-4a0f-
a787-6ee28ebb8c7c.zip",

"unfiltered variants": "https://
baseline.itw/api/vl/download?filepath=/data/IR/data/IR Org/
ion.reporter@lifetech.com/Ane BC18 DeganCases/

Ane BC18 DeganCases 20151014174956618/
IR50 Rcl0 Ane BC18 DeganCases 1014 np.zip"
b,
"variants saved": "",
"samples": {
"PROBAND": "Ane BC18 DeganCases"
}y
"shared with": [],
"stage": "Send for Report Generation",
"flagged": false,
"name": "IR50 Rcl0 Ane BC18 DeganCases 1014 np",
"id": "f££f8081815067ca42015068£991930004",
"ion reporter version": "5.0",
"started by": "Ion User",
"start date": "October 14, 2015",
"status": "SUCCESSEFUL"
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This output contains links to three downloads about this analysis (backslashes have
been removed):

* qc: "https://baseline.itw/api/vl/download?
filepath=/data/IR/data/IR_Org/download/pdf/98ccb759-010f-4c92-
acba-2da2d8aa9f4d/ff8081815067ca42015068f99193000d_QC.pdf"

e unfiltered_variants:" https://baseline.itw/api/v1l/download?
filepath=/data/IR/data/IR_Org/ion.reporter@lifetech.com/Ane_BC18_DeganCase
s/Ane_BC18_DeganCases_20151014174956618/IR50_Rc10_Ane_BC18_DeganCase
s_1014_np.zip"

e filtered_variants: "https://baseline.itw/api/v1l/download?
filepath=/data/IR/data/IR_Org/ion.reporter@lifetech.com/Ane_BC18_DeganCase
s/Ane_BC18_DeganCases_20151014174956618/IR50_Rc10_Ane_BC18_DeganCase
s_1014_np___ 4f776c35-4a9f-4a0f-a787-6ee28ebb8c7c.zip"

Take one of these links, remove the backslashes ('\'), and send this URL as the second
curl command. Redirect the output to a file. For example, this command downloads
the zipped filtered variants file:

curl --request GET -k -H
"Authorization:ZTRhNWYyNjkzZ3hlYjMxMTdmM2FkZGM1 ZmOxYmRkNzU2ZTIx
ODkK50GRJ ZWM5ZDY2MjMzMTB1OGIWZWESNmMNINg" -O "https://
baseline.itw/api/vl/download?filepath=/data/IR/data/IR Org/
ion.reporter@lifetech.com/Ane BC18 DeganCases/

Ane BC18 DeganCases 20151014174956618/

IR50 Rc10 Ane BC18 DeganCases 1014 np 4£776c35-4a9f-4a0f-
a787-6ee28ebb8c7c.zip"

Download all analyses with one call

To retrieve all analyses in JSON format:

curl --request GET -k -H
"Authorization:0DkxY2IxYThhZWNjNDU3M]jlmNjdlZDBkYWEwWYzdmZTQzODFm
73 k3NjExXNDAOODVMYj YwMjA4YZzQ5MGEWNDEZzZg" https://
swanseaone.itw/api/vl/analysis?format=json

View=summary

To get a list of all analyses a user has access to without the links to the actual analyses,
enter:

view=summary

Example:

webservices 42/rest/api/analysis?format=json&view=summary

This approach saves time over the original calling API.
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Download QC and Final reports

To retrieve one QC report in JSON format, enter:

curl --request GET -k -H
"Authorization:ZDMxNDUwWZGYyNjM4NGR1ZjYONJjAyNTclYTE1ZjU2MzFkNjVm
YzQxY3jJhOTQWNTYyYWM30TImZDY2YTUSNGQWNA" -0 "https://<your
server name>/api/vl/download?filepath=/data/IR/data/IR Org/
ion.reporter@lifetech.com/new CFTR/new CFTR 20151106002127527/
new CFTR 1446798039543 .zip"

The output in JSON format will resemble this:

[

"reports": {
"qC"Z {

"link": "https://<your server name>/api/vl/
download?filepath=/data/IR/data/IR Org/download/pdf/
335alf5e-19f1-4ff4-b80c-af620fldfelf/
££80818150dbc2430150dbe2d9650072 QC.pdf"

}y

"final": {}
by
"report published": "",
"workflow": "AmpliSeq CFTR single sample",
"data links": {
"filtered variants": "https://<your server name>

/api/vl/download?filepath=/data/IR/data/IR Org/
ion.reporter@lifetech.com/new CFTR/new CFTR 20151106002127527/
new CFTR 1446798039543.zip",

"unfiltered variants": "https://<your server name>
/api/vl/download?filepath=/data/IR/data/IR _Org/
ion.reporter@lifetech.com/new CFTR/new CFTR 20151106002127527/
new CFTR 1446798039543.zip"

}y
"variants saved": "",
"samples": {

"PROBAND": "new CFTR"
}y
"shared with": [],
"stage": "Review Variants",
"flagged": false,
"name": "new CFTR 1446798039543",
"id": "££f80818150dbc2430150dbe2d9650072",
"ion reporter version": "5.0",
"started by": "Ion User",
"start date": "November 06, 2015",
"status": "SUCCESSFUL"

To retrieve all the QC reports in JSON format, enter:

curl --request GET -k -H
"Authorization:0DkxY2IxXxYThhZWNjNDU3M]1mNjdlZDBkYWEWYzdmZTQzODFm
73k3NjExXNDAOODVMYj YwMjA4YZzQ5MGEWNDEZzZg" https://
swanseaone.itw/api/vl/gcreport?format=json
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To retrieve one Final report in JSON format, enter:

curl --request GET -k -H
"Authorization:YTJJNGVMYWYyNDCcXNTgyMmU3NzMxZmY 00WV]Y2ZhYTAQOZDM2
YTk10TQ4ZjUxZDImMzFkZjFiM2UwNzZhNj1iMg" "https://
teemo.itw/api/vl/finalreport?
format=json&name=testDNAFusion c255 1421470231458"

To retrieve all Final reports in JSON format, enter:

curl --request GET -k -H
"Authorization:0DkxY2IxYThhZWNjNDU3M]j1lmNjdlZDBkYWEwWYzdmZTQzODFm
73 k3NJExXNDAQOODVMYjYwMjA4YzQ5MGEWNDEZzZg" https://
swanseaone.itw/api/vl/finalreport?format=json

Query by Sample Name API

420

You can now query by sample name using this API:

/api/vl/analysis?format=json&name=[samplename] &type=sample

This returns a list of analysis names performed on the sample, ordered by start date.
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A short description for the plugin can be included after the plugin class declaration as
shown in the line 4 in the code sample. If you do not include a short description, you
will receive a warning message.

The version attribute is mandatory in the plugin script. Define the version in the
plugin as given in line 5 in the code example.

The Python class that inherits from the IonPlugin base class should call the main as
shown in the sample code in lines 9 and 10.

MylonPlugin.py

1 #!/usr/bin/env python
2 from ion.plugin import *
3 class MyIonPlugin (IonPlugin):

4 ''"'This is a sample plugin'''

5 version = '5.4.0.1"

9 def launch (self) :

7 print "This is a python-based plugin
8

9 if name == " main_ ":
10 PluginCLT ()

The above mentioned class is considered as a wrapper class to the plugin script. This
above class is used for the IR plugin framework to validate. We would recommend
developer to maintain this format and write another class called
MylonPlugin_plugin.py which contains all the main processing. Calling
<plugin_name>_plugin.py from <plugin_name>.py is recommended way of
structuring.
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Example <plugin_name>.py which acts as a wrapper class and which in-turn calls
<plugin_name>_plugin.py:

At the time of plugin run, Plugin is provided with the startplugin.json and
barcodes.json in its running directory which allows the plugin to access these json
files as if they are available in their current working directory.

In the code above, lines 18 and 19 show the way how to access these files.
More information on these json files are provided in the sections below.

Naming convention for the plugin zip

¢ IR plugin framework has some validations against how the zip file should be
named.

* After compressing the plugin contents into the zip, the zip name should be given
as <plugin_name>_<version>.zip.

* For example: From the above code snippet, the plugin zip file name should look
like MylonPlugin_5.4.0.1.zip.
How to create plugin zip:

1. Create a folder with pluginname_version.

2. Keep the files/folders in it.

3. o Below are the files that every plugin should contain for IR to validate it.
— Instance_ir.html

— This html file is used by plugin framework to show the plugin
configuration page in the plugins tab at the analysis launch time.

— This html file should contain the parameters that should be configured
at the time of launching the plugin.
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User can modify/configure parameters during workflow
creation/analysis launch. When user clicks on the configure icon then it
shows instance_irhtml which get the default parameters from database
and user can modify those. Please refer the instance_ir.html in
ampliSeqRNA plugin for more info.

e Parameters.json

e Myl

Plugin framework expects the file called parameters.json in the plugin
zZip.

At the time of installation, plugin framework will save the default
values required for the plugin in the database. These default values for
those keys to be given in parameters.json.

At run time, IR will display plugin's instance_ir.html to configure
plugin parameters at the analysis launch time. Once configured, plugin
framework will provide these values for the plugin usage under key
called "pluginconfig" in startplugin json. Startplugin json will be
provided under the plugin results directory. Results directory can be
accessed through the environment variable called
"RUNINFO_RESULTS_DIR".

Parameters.json file should contain all the keys and default values for all
these keys. These keys in this file should match the parameters to be
configured using instance_ir.html.

Parameters.json file should be specific to plugin. ampliSeqRNA plugin
parameters.json is different from RNAseq plugin parameters.json.

Please refer the default paramaters.json for more information.

onPlugin.py

This file name should be the same name (MylonPlugin.py) as zip file
name (MylonPlugin_5.4.0.1.zip) with no version in it.

This python class should implement IonPlugin base class provided by
the plugin framework.

This IonPlugin base class expects the plugin to have mandatory
attribute version, have a method called PluginCLI() method inside
__main__ and also to have method definition for launch(self).

¢ Sample contents in ampliSeqRNA plugin:

Select the folder and create the zip by right click.
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Plugin APIs

Plugin APIs are used to fetch/update the plugin parameters. These api's are part of
instance_ir.html so please refer instance_ir.html for more info.

Following are the APIs available:

¢ To get the reference genome:
— URL: /plugin-api/v1/referencegenome

To fetch the already saved parameters:
— URL: '/plugin-api/v1/results?pluginld='+ <<PLUGINID>>+ '&workflowId="+
<<WORKFLOWID>>
To fetch the target region's based on reference genome:
- /plugin-api/v1/targetRegions?genome= <<REFERENCE-GENOME>>
To fetch the target region's based on reference genome and target region:
— URL: /plugin-api/v1/targetRegions?genome=<<REF-GENOME>>
&targetRegion= <<TARGET-REGION_NAME>>

Validation:

Once the plugin is finalized, it needs to be compressed into the .zip file. The zip file
name should be same name given to the file <plugin_name>.py. IR would validate this
zip to check to see if this plugin has valid version attribute and if this plugin has
implemented IonPlugin class.

Below are the validation performed during the plugin installation:
1. Plugin zip should have the at least one python file.
Valid python file should import the ion.plugin package.

Valid python file should have class name.
Valid python file should have version attribute.

Gk LN

pluginname_version is used to check the uniqueness. So newly installed plugin
should not have the plugin name and version, which is already installed.

6. Plugin zip should have parameters.json inside it with default values otherwise
plugin will not generate the proper result.
HTML's for Visualization:
Once the plugin analysis is launched and successful, for the developer to view the
plugin results using IR visualization:

¢ Plugin should generate <plugin_name>.html and <any_name>_block.html
(optional) files in the plugin output folder. path:
<analysis_root_dir>/outputs/TsPluginActor-00/<Plugin_name>/

e If the _block.html is generated then IR software would show the results in a block
like frame as a mini view.

* The frame will have a button called "View Summary" which contains the link to
open <plugin_name>.html file in a new tab.

Plugin Results

For the plugin developer to view the results in the backend, the results will be
available at the following path: <analysis_root_dir>/outputs/TsPluginActor-00/
<Plugin_name>/
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Download logs

For the plugin developer to view the plugin logs in the backend, the logs will be
available at the following path: <analysis_root_dir> /log/TsPluginActor-00/
<Plugin_name>/

If the <plugin_name>.log file is generated then user will be able to download logs. IR
software would show the "Download Log" in a block header.

Scratch directory:

* For the plugin developer to save any intermediate generated files from that
plugin for re-use in subsequent plugin runs, these could be saved in
pluginScratch directory.

¢ Developer should be able to access the environment variable called
TSP_PLUGIN_SCRATCH and can create a folder under this scratch directory
with your plugin name <plugin_name> to save the results.

Sample and Environment details

At run time, developer is provided with two json files startplugin.json and
barcodes.json in the plugin results directory.

Developer can access these json files in the MylonPlugin.py script in Barcodes json:

* Barcodes json contains the sample information that has been selected at the
analysis launch time.

* Barcodes json is mainly used to read the bam_file_path, target_regions_file_path,
genome_reference_name, genome_reference_file_path and barcode_name.

e Below is the example barcodes json generated by plugin framework:

{
"bcl" . {
"genome urlpath" : "",
"nucleotide type" : "",
"control sequence type" : "",
"barcode name" : "bcl",
"Sample_ld" . " ",
"barcode type" : "",
"barcode annotation" : "",
"sample" : "SampleCustom",
"reference fullpath" : "/data/IR/data/.reference/hgl9/
hgl9.fasta",
"target region filepath" : "",
"reference" : "hgl9",
"filtered" : "",
"barcode sequence" : "",
"hotspot filepath" : "",
"barcode index" : "",
"bam file" : "1 1 TonXpress 009 rawlib.bam",
"barcode adapter" : "",
"barcode description" : "",
"bam filepath" : "/data/IR/data/IR Org/data/IRU Uploads/
20170306 02 12 48/vl/new ocp rna/l 1 IonXpress 009 rawlib.bam",
"aligned" : "",
"control type" : "",
"read count" : ""
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¢ If the sample being used in analysis was uploaded through IRU plugin, then the
barcodes json might contain more information like the "read_count",

non

"barcode_adapter", "nucleotide_type", "barcode_sequence" etc.
* Below is the sample barcodes json if the sample is uploaded through IRU plugin:

{
"IonXpress 005" : {
"read count" : 1836237,
"sse filepath" : "",
"reference" : "hgl9",
"genome urlpath" : "",
"barcode adapter" : "GAT",
"sample" : "Dw2-4hr",
"sample id" : "",
"barcode type" : "",
"hotspot filepath" : "",
"barcode description" : "",
"control type" : "",
"target region filepath" : "",
"control sequence type" : "",
"bam filepath" : "/data/IR/data/IR Org/data/IRU Uploads/
2017-3-20_ 11 10 49/v1/Dw2-4hr RNA vl/IonXpress 005 rawlib.bam",
"filtered" : false,
"barcode index" : 5,
"bam file" : "IonXpress 005 rawlib.bam",
"aligned" : true,
"barcode name" : "IonXpress 005",
"barcode annotation" : "",
"nucleotide type" : "RNA",
"barcode sequence" : "CAGAAGGAAC",
"reference fullpath" : "/data/IR/data/.reference/hgl9/
hgl9.fasta"
}
}

Startplugin json

At the analysis launch time, in UI, user could configure his/her own plugin according
to their requirements. These configured parameters will be provided in the
startplugin.json under the key called "pluginconfig".

For example: If the user has selected the reference as hg19 in plugin Ul
(instance_ir.html using plugin api's to get the values from IR DB. See below plugin
api's section for more info.), then these values would be provided to the plugin in
startplugin json as below:

"pluginconfig" : {
"reference" : "/data/IR/data/.reference/hgl9/hgl9.fasta"
}

So plugin developer could read the above path as to access the reference file that has
been selected in Ul

Startplugin json does contains some IR and plugin meta information like, plugin_dir
(plugin zip contents), results_dir (where plugin output should be written).
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If the sample being used in IR was uploaded using IRU plugin in TS, then the
startplugin json will contain extra meta data like chipType, library, barcodeName,
system_type and so on. Given example startplugin json as below if the sample has
been uploaded using IRU plugin:

{

"expmeta" : {
"sample" : "HBR",
"runid" : "QRIBT",
"run name" : "R 2016 08 05 13 17 55 user S5-00111-181-
LifeLab DW 08052016 B",
"run flows" : 500

"output file name stem" :
"R 2016 08 05 13 17 55 user S5-00111-181-
Lifelab DW 08052016 B Auto user S5-00111-181-
LifelLab DW 08052016 B 30836",

"run_date" : "2016-08-05T20:19:392",
"chiptype" : "530",
"flowOrder" : "TACGTACGTCTGAGCATCGATCGATGTACAGC",
"barcodeId" : "IonXpress",
"analysis date" : "2016-08-05",
"chipBarcode" : "DBCD02486",
"project" : "Lifelab",
"instrument" : "S5-00111",
"results name" : "Auto user S5-00111-181-
LifeLab DW 08052016 B 30836",
"notesll . mwn
}o
"pluginconfig" : {
"reference" : "/data/IR/data/.reference/hgl9/hgl9.fasta",
"genome" : "hgl9"
b
"runinfo" : {
"testfrag key" : "ATCG",
"url root" : "",
"chipType" : "530",
"library" : "hgl9",
"sigproc dir" ne
"pluginresult" : 881041,
" api_url" . mn 7
"barcodeId" : "IonXpress",
"results dir" : "/data/IR/data/IR Org/

ion.reporter@lifetech.com/Dw2-4hr RNA v1/
Dw2-4hr RNA vl 20170321131007199/outputs/TsPluglnActor 00/
RNASegAnalysis™,

"platform" : "s5",

"pk" : 61178,

"alignment dir" : "",

"api key" : "",

"basecaller dir" : "",

"net location" : "",

"username" "",

"library key" : "TCAG",

"systemType" : "S5",

"plugin name" : "RNASegAnalysis",

"tmap version" "

"report root dir" : "/data/IR/data/IR Org/
ion.reporter@lifetech.com/Dw2-4hr RNA v1/
Dw2-4hr RNA v1 20170321131007199",

"chipDescription" : "530",
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"plugin dir" : "/share/apps/IR/ionreporter54/apps/IR Org/
RNASegAnalysis",

"raw data dir" : "",

"analysis dir" : "/data/IR/data/IR Org/

ion.reporter@lifetech.com/Dw2-4hr RNA v1/
Dw2-4hr RNA v1 20170321131007199"
by
"plan" : {
"planName" : "LifeLab DW 08052016 B",
"username" "",
"sequencekitname" : "Ion S5 Sequencing Kit",
"librarykitname" : "Ion AmpliSeqg RNA Library Kit",
"sampleGrouping" : null,
"sseBedFile" : "",
"barcodeId" : "IonXpress",
"controlSequencekitname" : "",
"regionfile" : "",
"runMode" : "single",
"bedfile" : "",
"templatingKitName" : "Ion Chef S530 Vv1",
"samplePrepKitName" : "",
"runType" : "AMPS RNA",
"runTypeDescription" : "AmpliSeqg RNA",
"reverse primer" ",
"threePrimeAdapter" : "ATCACCGACTGCCCATAGAGAGGCTGAGAC",
"sampleTubeLabel" : ""
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Related documentation

This appendix provides links to current application notes, white papers, user guides,
and other documentation that is related to Ion Reporter™ Software and available at the
Thermo Fisher Scientific website.

Advanced algorithm documentation

Ion Reporter  Software contains many advanced algorithms that have been optimized
specifically for Ton Torrent semiconductor Sequencing technology. Below are
application notes and white papers that provide more background and are available
at the Thermo Fisher Scientific website.

Variant filtering and prioritization using the Ion AmpliSeq™ Exome trio workflow in lon
Reporter” Software, available at http://tools.thermofisher.com/content/sfs/
brochures/Ion-AmpliSeq-Exome-Application-Note.pdf

Metagenomics 16S Algorithm Overview, available at http://tools.thermofisher.com/
content/sfs/brochures/
ion-reporter-16s-metagenomics-algorithms-whitepaper.pdf.

Application Note: CNV detection by Ion semiconductor sequencing, available at http://
tools.thermofisher.com/content/sfs/brochures/CNV-Detection-by-Ion.pdf.

Application Note: Detection of aneuploidy in a single cell using the Ion ReproSeq PGS
Kit, available at https://tools.thermofisher.com/CONTENT/SFS/BROCHURES/
ANEUPLOIDY-APP-NOTE.PDF.

Oncomine Assay user guides

The following user guides for Oncomine assays are available at the Thermo Fisher
Scientific website.
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Oncomine Comprehensive Assay version 3 User Guide (Pub. No. MAN0015885),
available at http://tools.thermofisher.com/content/sfs/manuals/
MANO0015885_OncomineComprehensiveAssay_v3_UG.pdf.

Oncomine Focus Assay Part 11I: Variant Analysis User Guide (Pub. No. MAN0015821),
available at http://tools.thermofisher.com/content/sfs/manuals/
MANO0015874_Oncomine_cfDNA_Assay_Part_IIL.pdf .

Oncomine cfDNA Lung Assays, Part III: Variant Analysis User Guide (Pub. No.
MANO0015874), available at https://tools.thermofisher.com/content/sfs/manuals/
MANO0015874_Oncomine_cfDNA_Assay_Part_IIL.pdf.

Oncomine BRCA Research Assay User Guide (Pub. No. MAN0014634), available at
http://tools.thermofisher.com/content/sfs/manuals/
MANO0014634_OncomineBRCA_UG.pdf.
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Documentation and support

Customer and technical support

Visit thermofisher.com/support for the latest in services and support, including:
e Worldwide contact telephone numbers
¢ Product support, including;
— Product FAQs
— Software, patches, and updates
— Training for many applications and instruments
¢ Order and web support
* Product documentation, including:
— User guides, manuals, and protocols
— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers,
contact the manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life
Technologies' website at www.thermofisher.com/us/en/home/global/
terms-and-conditions.html. If you have any questions, please contact Life
Technologies at www.thermofisher.com/support.
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